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INTRODUCTION 
Rumen8 allows farmers and consultants to manage dairy and beef cattle diets, improving animal 
nutrition and production while reducing costs and enteric methane emissions. It is a software 
application for Microsoft Windows computers that was originally created while the developers 
worked with dairy research herds at the Department of Agriculture and Food, Western Australia in 
the early 2000’s. Rumen8 is based on multiple published feeding standards and peer-reviewed 
journal articles and is updated regularly. 
 
Rumen8 is a comprehensive ruminant nutrition tool with an emphasis on ease-of-use that sets it 
apart from others. This makes it ideal for creating and checking cattle diets on-farm from both a 
nutritional and economic perspective. It is based on metabolisable energy (ME), metabolisable 
protein (MP) and neutral detergent fibre (NDF), but also reports a range of other diet parameters. 
In addition, Rumen8 comes with a strong educational element, containing many detailed 
explanations of the nutritional concepts required to feed cattle successfully and profitably.   
 
Rumen8 performs well in a wide range of production systems. It is used in pasture-based and stall-
fed systems all over the world.  Note, it does not apply to semi-arid extensive beef production 
systems.  Rumen8 is available for free and is used by thousands of users in over 100 countries, 
including farmers, consultants, and in universities. 
 
Rumen8 is owned and registered as a trademark by Rumen8 Nutrition Pty. Ltd., a Western 
Australian based company with Directors Martin Staines and Richard Morris. 
 
Document version 2023.11 

WHAT DOES RUMEN8 DO? 
Rumen8 allows the user to design a diet from up to 15 feeds or mixes and ensure an animal’s 
dietary needs are met. Multiple diets can be stored and compared and if feed prices income from 
milk or the animal's sale are entered, the difference between feed price and return is calculated. 
Rumen8 uses robust nutrition models that we have found accurate enough over many years using 
it on farms and Research Stations. Although more sophisticated models of cattle nutrition exist, 
these require a higher level of user knowledge, they depend on less readily available and more 
expensive feed analyses and require more time to become experienced with. We have found that 
Rumen8 provides a good balance between ease and speed of use and performance that is fitting 
for the pasture-dominated diets common in Australia. 
 

Learning how to use Rumen8 safely 

While Rumen8 is relatively easy to use, it still requires a good knowledge of animal nutrition to 
maximise the health and profitability of your herd. To begin with, we recommend using Rumen8 
alongside your nutritionist so they can guide changes to diets while keeping them safe and cost 
effective.   
 
To learn how to use Rumen8 and increase your knowledge of cattle nutrition, a six part training 
course is provided on the Rumen8 website under Training in the menu.  



Rumen8 User Guide 

8 / 247 

 
This can be downloaded for free and worked through at your own pace. It also includes example 
diets and case studies. While tailored for conditions on East African farms, the principles remain 
the same wherever your business is located. 
 

Rumen8 is based on published feed standards 

The equations that allow Rumen8 to predict energy and protein supply from the diet and demand 
by the animal are all from published feeding standards. When creating diets for dairy animals 
these are primarily the British publications 'Energy and Protein Requirements of Ruminants' and 
'Feed into Milk: A New Applied Feeding System for Dairy Cows'. When in beef mode, the feeding 
standard used by Rumen8 is the Australian publication 'Nutrient Requirements of Domesticated 
Ruminants'. The full reference for these publications can be found at the end of this document, 
along with others that are used for estimating mineral demand, daily intake and methane 
production for example. 
 
The primary feeding standards used by Rumen8 

     

WHAT RUMEN8 DOESN'T DO 
Like most nutrition programs, Rumen8 works on a linear response to feeding. This means it 
assumes the same response to a kilogram of concentrate whether it is the first kilogram, or the 
tenth kilogram fed to the animal. Due to this Rumen8 can be misleading when asking questions 
such as ‘What happens if I feed another kilogram of concentrate' as it presents the average 
response for the first diet, and then the average response for the second diet that includes the 
additional feed. Rumen8 cannot be used to predict the response to just the last kilogram of 
additional concentrate. Generally, we would suggest that for dairy cows, marginal responses much 
more than 1 litre of milk per kg of concentrates should be treated with scepticism. 

A WARNING BEFORE YOU START 
Like any nutrition application, Rumen8 depends on a model of an animal that is used to estimate 
energy and protein demand to meet maintenance and production. No model is completely 
accurate, and it is possible to create a balanced diet in Rumen8 that will reduce an animal's 
performance or even adversely affect their health. For this reason, we recommend Rumen8 is 
used with your nutritionist, and depending on your level of knowledge, between their visits to 
adjust diets. 
The feed libraries provided with Rumen8 have links to other resources on the internet such as the 
Feedipedia website. These are provided so the user has additional information, but they are not 
under the control of the developers of Rumen8. This means they can change over time, and we 
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cannot guarantee their accuracy or relevance to your business and locally available feeds. Like any 
resource on the internet, please evaluate them carefully to determine their reliability and how 
useful to you they are. 

END-USER LICENSE AGREEMENT (EULA) OF RUMEN8 
This End-User License Agreement ("EULA") is a legal agreement between you and Rumen8 
Nutrition Pty Ltd. 
This EULA agreement governs your acquisition and use of our Rumen8 software ("Software") 
directly from Rumen8 Nutrition Pty Ltd or indirectly through a Rumen8 Nutrition Pty Ltd 
authorised reseller or distributor (a "Reseller"). 
Please read this EULA agreement carefully before completing the installation process and using 
the Rumen8 software. It provides a license to use the Rumen8 software and contains warranty 
information and liability disclaimers. 
If you use the demonstration version of the Rumen8 software, this EULA agreement will also 
govern that trial. By clicking "accept" or installing and/or using the Rumen8 software, you are 
confirming your acceptance of the Software and agreeing to become bound by the terms of this 
EULA agreement. 
If you are entering into this EULA agreement on behalf of a company or other legal entity, you 
represent that you have the authority to bind such entity and its affiliates to these terms and 
conditions. If you do not have such authority or if you do not agree with the terms and conditions 
of this EULA agreement, do not install or use the Software, and you must not accept this EULA 
agreement. 
This EULA agreement shall apply only to the Software supplied by Rumen8 Nutrition Pty Ltd 
herewith regardless of whether other software is referred to or described herein. The terms also 
apply to any Rumen8 Nutrition Pty Ltd updates, supplements, internet-based services, and 
support services for the Software, unless other terms accompany those items on delivery. If so, 
those terms apply. 
 
License Grant 
Rumen8 Nutrition Pty Ltd hereby grants you a personal, non-transferable, non-exclusive licence to 
use the Rumen8 software on your devices in accordance with the terms of this EULA agreement. 
You are permitted to load the Rumen8 software (for example a PC, laptop, mobile or tablet) under 
your control. You are responsible for ensuring your device meets the minimum requirements of 
the Rumen8 software. 
You are not permitted to: 

• Edit, alter, modify, adapt, translate or otherwise change the whole or any part of the 
Software nor permit the whole or any part of the Software to be combined with or become 
incorporated in any other software, nor decompile, disassemble or reverse engineer the 
Software or attempt to do any such things 

• Reproduce, copy, distribute, resell or otherwise use the Software for any commercial 
purpose 

• Allow any third party to use the Software on behalf of or for the benefit of any third party 

• Use the Software in any way which breaches any applicable local, national or international 
law 

• Use the Software for any purpose that Rumen8 Nutrition Pty Ltd considers is a breach of 
this EULA agreement 

 
Liability 
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Licensor shall not be liable to licensee for any lost profits, lost revenues or opportunities, 
downtime, or any consequential damages or costs, resulting from any claim or cause of action 
based on breach of warranty, breach of contract, negligence, or any other legal theory, even if 
Licensor knew or should have known of the possibility thereof. In no event shall Licensor's 
aggregate liability exceed the amounts actually paid by Licensor in the 12-month period 
immediately preceding the event giving rise to the claim. 
 
Intellectual Property and Ownership 
Rumen8 Nutrition Pty Ltd shall at all times retain ownership of the Software as originally 
downloaded by you and all subsequent downloads of the Software by you. The Software (and the 
copyright, and other intellectual property rights of whatever nature in the Software, including any 
modifications made thereto) are and shall remain the property of Rumen8 Nutrition Pty Ltd. 
Rumen8 Nutrition Pty Ltd reserves the right to grant licences to use the Software to third parties. 
 
Termination 
This EULA agreement is effective from the date you first use the Software and shall continue until 
terminated. You may terminate it at any time upon written notice to Rumen8 Nutrition Pty Ltd. 
It will also terminate immediately if you fail to comply with any term of this EULA agreement. 
Upon such termination, the licenses granted by this EULA agreement will immediately terminate 
and you agree to stop all access and use of the Software. The provisions that by their nature 
continue and survive will survive any termination of this EULA agreement. 
 
Governing Law 
This EULA agreement, and any dispute arising out of or in connection with this EULA agreement, 
shall be governed by and construed in accordance with the laws of Western Australia. 
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GETTING STARTED 
Rumen8 is a Windows application so requires a desktop or laptop computer running Microsoft 
Windows to be used. Currently it cannot be installed on iPhones, iPads, Android phones/tablets or 
Apple Macintosh computers. 

SYSTEM REQUIREMENTS 
Rumen8 requires the version 8.1 or 10 of the Microsoft Windows operating system to run. It is 
recommended you have run Windows Update and installed all the updates provided by Microsoft. 
If your computer can run Windows adequately, it will be enough to run Rumen8. The minimum 
screen resolution required to run Rumen8 comfortably is 1280 x 800 pixels. 
Rumen8 requires the Microsoft NET Framework version 4.8 or higher to be installed. If your 
computer has been fully updated this will be installed automatically. 

REPORT REQUIREMENTS 
To create Rumen8 reports you must also install the SAP Crystal Reports Runtime Engine for the 
.NET framework. The installers for this software are available from the SAP website or the Rumen8 
website download page. If you are running a 32-bit (x86) version of Microsoft Windows download 
and install the 32-bit version of the run-time software and if your copy of Windows is 64-bit (x64) 
use the 64-bit run-time installer. 
 
Rumen8 website: https://www.rumen8.com.au/download/index.html 
 
SAP website: http://www.crystalreports.com/crystal-reports-visual-studio/ 
 
The SAP website will require your email address and country to access their downloadable files 
section. The files you want are the ‘SAP Crystal Reports Runtime (32Bit)’ or ‘SAP Crystal Reports 
Runtime (64Bit)’ depending on the version of Windows you have. 
If you are unsure whether your version of Windows is 32 or 64-bit start Rumen8, load a few 
ingredients and then open the Report Designer from the File menu. Click on the ‘Create’ button 
and a warning will appear telling you the SAP run-time has not been installed. It will show you 
whether your version of Windows is 32 or 64-bit. Click on the links provided to download the 
correct run-time and then install it. Now the Report Preview window should appear when you 
create a report. 

GETTING HELP 
From within Rumen8 you can press the F1 key to access this User Guide. Alternatively, the User 
Guide is available as a PDF document from the Windows start menu applications list in the 
Rumen8 group. 
A list of abbreviations used in this document and within Rumen8 can be found at the end of this 
document. 
Video tutorials are provided on the Rumen8 website which cover the main parts of Rumen8 and 
how to use it. 
Finally, for technical support and reporting bugs please contact the developers via email at 
support@rumen8.com.au. 
When reporting problems please provide a description of what you were doing when the issue 
occurred. Screen shots showing an error message are extremely useful. It is also helpful to know 

https://www.rumen8.com.au/download/index.html
http://www.crystalreports.com/crystal-reports-visual-studio/
mailto:support@rumen8.com.au
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what version of Microsoft Windows you are using. 
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INSTALLATION 
The Rumen8 set up file can be downloaded from the Downloads page of the Rumen8 website at 
http://www.rumen8.com.au 
Once the executable file has been saved to your Downloads folder (the default Windows 
download destination) double click on the file in Windows File Explorer to commence the 
installation process. 
Some virus scanners may prevent the download of executable files such as the Rumen8 installer. If 
this happens the download will appear to complete but the installer will not be present in the 
Downloads folder. To install Rumne8 you may need to pause your virus scanner and then 
complete the installation. This is often an option by right-clicking on the virus software's icon in 
the System Tray at the bottom right of the windows. Do not forget to re-enable it after Rumen8 is 
installed. 
If that is not an option, you can download the Rumen8 installer inside a password protected Zip 
archive from the Downloads page. Once this .zip file has downloaded, open the Downloads folder 
in File Manager, double click on it and then enter the password which is password. The zip file will 
open with the Rumen8 installer inside it. You can double click on the installer to install Rumen8. 
 

The Windows 10 Downloads folder with the ‘Install Rumen8’ application ready to be run. 

  
 
  

http://www.rumen8.com.au/
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Windows will open a User Account Control window and ask for confirmation that you want to 
allow this app to make changes to your device? Click yes to continue and the Rumen8 Setup 
Wizard will appear. 
 

The Rumen8 installer setup wizard. 

 
 

Click on the ‘Continue’ button to continue to the license agreement window. 
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The Rumen8 installer license agreement window. 

 
 

Read the End-User License Agreement and if you agree with them click on the ‘Accept’ button. 
The license agreement is also available in the previous chapter of this document. Next you move 
to the ‘Important Instructions’ window. This covers the limitations of nutrition software like 
Rumen8 and suggests it should be used alongside your nutritionist to ensure no cattle health or 
production issues arise from its use. 
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The Rumen8 installer ‘Important Instructions’ window. 

 
 

Once you are aware of the limitations of nutrition software and you agree click the ‘Continue’ 
button to choose the installation folder. 
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The installation folder window. 

 
 

Use the ‘Browse’ button to change the installation folder if required. The default folder will be 
suitable for almost everyone.  
Click on the ‘Install’ button to confirm installation. You may get a window open asking you to 
confirm the creation of the installation folder. Just click on ‘Yes’ to continue. 
 
If Rumen8 is already installed on your computer, you will instead get a message informing you a 
previous installation has been found. This will ask you to confirm you want to copy over it. This will 
not cause any problems and will not overwrite any of your Rumen8 settings or feeds so click on 
'Yes' to complete the installation. 
 

A previous installation of Rumen8 has been found. 
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The installation is complete. 

 
 
Installation of Rumen8 is complete, click on the ‘Finish’ button to exit the installer and run 
Rumen8 for the first time. The installer also creates a Rumen8 icon on the Desktop so you can 
start it from there or in the Applications list of the Windows Start menu. 
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STARTING RUMEN8 FOR THE FIRST TIME 
Rumen8 will add an icon to the Desktop, and you can start it from there. 
 
It can also be opened from the Start Menu of Windows 10 in the ‘All programs’ list. The Windows 
10 start menu is shown below and the red arrow is pointing to the Rumen8 icon within the 
Rumen8 4 group in the alphabetical list of applications installed on the computer. Options to Pin 
the Rumen8 icon to the Taskbar, Start menu or Send a shortcut to the Desktop can be accessed by 
right clicking on the Rumen8 icon. 
 
Starting Rumen8 under Window 10. 
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If you are using Windows 11, click on the Start button at the left of the dock, and then the 'All 
apps' button at the top right of the start menu. Scroll down through the alphabetic list of all the 
applications installed on the computer until you find the Rumen8 4 folder. Click on that to show 
the Rumen8 application, documentation, updater and uninstaller. 
 
Starting Rumen8 under Windows 11. 

 
 

When Rumen8 starts for the first time it will ask you where to create a Rumen8 folder.  
 



Rumen8 User Guide 

22 / 247 

Choose the location of the Rumen8 folder. 

 
 

Your Documents folder is the recommended location as this is easy to access and is more likely to 
get backed up. If you are happy with the default location, click the ‘Yes’ button, but if you would 
like another location for the Rumen8 folder click ‘No’. This will take you to a folder browser where 
you may specify the location yourself. 
Rumen8 will then create a folder called ‘Rumen8’ at the chosen location and within it another 
folder called ‘Libraries’. Into this folder will be copied a feed library, preferences and milk prices 
file used by the application for this user. If multiple users use the computer, each user will have 
their own copy of the Rumen8 library files so they can individually tailor Rumen8 for their own 
requirements. 
If a folder called ‘Rumen8’ already exists in the location you have chosen, it will be used and no 
files will be deleted. If a ‘Libraries’ folder already exists within the Rumen8 folder, it will also be 
used. If you already have the library files from a previous installation in the Libraries folder they 
will be left untouched and not replaced with the default files supplied with Rumen8. In this way 
you can remove and reinstall Rumen8 via the Windows Settings and your feed library and settings 
will remain. 
If you wish to revert to the supplied original version of any of the library files just delete or rename 
them and then start Rumen8. It will offer to copy a new file as a replacement. 
The Rumen8 folder is the recommended location for your saved diet files. 
Once the Rumen8 and Libraries folder have been created the main Rumen8 window will open 
ready for use. 

UPGRADING FROM RUMEN8 3 
Rumen8 version 4 can be installed alongside an existing copy of Rumen8 version 3. Both versions 
can then be used and retain their individual feed libraries, preference settings and prices. 
When starting Rumen8 4 for the first time it is recommended you choose the same location for 
the Rumen8 folder as used by Rumen8 3. This is usually the user's Documents folder.  
 
The first time Rumen8 4 starts it will see the existing Rumen8 3 library files and offer to import 
them for use in Rumen8 4. This will allow the use of the existing feeds, preferences and prices in 
Rumen8 4. 
 
When starting Rumen8 4 for the first time, it offers to import Rumen8 3 feed, preferences and 
prices libraries from Rumen8. 
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If you do not import your Rumen8 3 libraries when starting Rumen8 4 for the first time it is not too 
late. It can be done manually for each one by going to the Feed Editor, Advanced Preferences and 
Prices tab and using the 'Import' button to import the Rumen8 3 library as a new Rumen8 4 
library. The Rumen8 3 library files are usually located in the C:\Users\<user 
name>\Documents\Rumen8\Libraries\ folder and are called FeedLibrary.db3, Preferences.db3 
and MilkPrices.db3. 
 
If you import some or all of the Rumen8 3 libraries they will become the currently selected library 
and called 'Rumen8 3'. For example, if on first start-up of Rumen8 4 you decided to import the 
Feed Library used by Rumen8 3 go into the Feed Editor and you will see the current library is 
called Rumen8 3 in the drop-down list called 'Feed library in use'. 
 
The feed library from Rumen8 version 3 is selected after importing it when starting Rumen8 4 for 
the first time. 
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If you click on the drop-down menu, you will see there is another feed library available called 
'Default'. This is the feed library supplied with Rumen8 4. It is the same as the feed library supplied 
with Rumen8 3 except it has the ADF feed values added for each feed and links to the Feedipedia 
website added for many of the feeds. 
You may wish to rename the feed libraries if you want to continue using your imported Rumen8 3 
library as the usual feed library. For example, select the Default library in the drop-down list and 
then use the 'Rename' button to rename it to something like 'Default Rumen8 4 library'. Then you 
can select the Rumen8 3 library and rename it to 'Default'. When you use a library not called 
default a reminder 'FL' flag appears at the bottom of the tab section of Rumen8's main window 
and mousing over it will reveal a tool tip window that shows you the name of the current library. 
The Preferences and Prices libraries work in a similar way, so if you decided to import those when 
starting Rumen8 4 for the first time you will also have a 'Rumen8 3' library selected in the drop-
down list in the Advanced Preferences and on the Prices tab. They can be renamed in the same 
way if you want the Rumen8 3 settings and prices to be your defaults. 
If you have multiple sets of libraries, you can import them all and then rename them so they have 
meaningful names in the library selection drop-down lists. 

INCREASING THE SIZE OF THE RUMEN8 WINDOWS 
On a high resolution screen the Rumen8 window may appear too small to comfortably read. This 
is often the case on laptops with high DPI 4K (3840x2160 pixels) screens. To increase the relative 
size of everything on the screen you can adjust the Scaling percentage in the Windows Settings. 
 
1. Quit from Rumen8. 
2. Open the Windows Settings via the Start button in Windows 10 task bar at the bottom of the 

screen. Click on the Start button and when the Start menu appears click on the cog icon to 
open the Settings window. 

3. Click on the System group of settings. 
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4. Click on the Display sub heading in the menu to the left of the window. 
5. Scroll down through the settings until you see the 'Scale and layout' setting. 
6. Adjust the Scaling factor up until the Rumen8 window is a suitable size, typically to 125% or 

150%. This will also increase the size of text and icons every where else within Windows. 
7. Start Rumen8 to see if it is now large enough to use comfortably. If not, increase the scaling 

factor. 
 
The Scale and layout setting in Windows Settings is shown in the red rectangle. 
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REGISTERING RUMEN8 
When Rumen8 is run for the first time it will start in trial mode. This allows you to use all the 
functions of the application, but you are restricted to diets with only four ingredients. To get full 
access to all the diet ingredients please register, which is free. We ask you to register so we have 
an estimate of the number of people using the application. This information is used for future 
funding applications for further development. By not registering or if you share your registration 
name and number you may reduce the chance of future improvements to Rumen8. 
 
To register send an email to support@rumen8.com.au specifying your 
First name: 
Last name: 
Email: 
Country: 
Industry: Beef or dairy. 
Role in industry: 
Your information and email will only be used to contact you for registration purposes and very 
infrequently for matters concerning Rumen8 in the future. It will not be passed on to any other 
person or group. You should receive a registration email within 24 hours containing a registration 
code that is linked to your name. 
 

If you go to the Registration option under the Help menu you can enter your name and 
registration number exactly as specified in the email from Rumen8 support. The best way to be 
sure you have entered them exactly is by using copy (control-c) and paste (control-v) to copy them 
from the email and then paste them into Rumen8. Click the ‘Register’ button and then click 'Okay' 
and you will return to the main window with all the feed ingredients available. 
 
Entering registration details. 

 

REMOVING YOUR RUMEN8 REGISTRATION 
If you plan to give your computer to someone else, before uninstalling Rumen8 go to the 
Registration option under the Help menu and click the ‘Deregister’ button. Your name and 
registration code will be removed from the computer and Rumen8 will revert to trial mode. 
 
Remove your registration details before replacing your computer. 

mailto:support@rumen8.com.au
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USING RUMEN8 WITH DAIRY CATTLE 
Rumen8 can be used to create diets for beef or dairy cattle. To begin working on a diet for dairy 
cows select 'Dairy' from the File menu if it is not already ticked. Rumen8 will change to dairy 
mode. 
 
Dairy mode is selected in the File menu. 

 
 
 
The equations that allow Rumen8 to predict energy and protein supply from the diet and demand 
by the animal are all from published feeding standards. When creating diets for dairy animals 
Rumen8 uses equations from primarily the British publications 'Energy and Protein Requirements 
of Ruminants' and 'Feed into Milk: A New Applied Feeding System for Dairy Cows' from 1993 and 
2004 respectively. The full reference for these publications can be found at the end of this 
document, along with others that are used for estimating mineral demand, feed intake and 
methane production for example. 
 
The primary feeding standards used by Rumen8 in dairy mode 
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QUICK START GUIDE FOR DAIRY 
Rumen8 can be used in Compact or Standard mode. If this is the first time you have installed 
Rumen8, it will start in Compact mode which reduces the application down to the essentials. 
Standard mode provides access to all the functions Rumen8 provides. Compact mode is 
recommended for learning how to use Rumen8, and for many users, will be sufficient. 
Switching between modes can be done in the File menu. 
 
Use the File menu to switch between Standard and Compact modes. 

 
 

If you are unsure what something within Rumen8 is, hover your mouse over it and for most 
objects a tool tip will appear providing a more detailed explanation. 

 
  



Rumen8 User Guide 

30 / 247 

 

 

USING RUMEN8 IN COMPACT MODE 
The main Rumen8 window when in compact mode is shown below. The Diet Ingredients section 
(1) is where you specify the animal diet. The tabbed section (2) is where you can provide the cow 
details, evaluate the current diet, adjust feed costs and milk payments. The summary section at 
the bottom left (3) reports feed costs, milk income and margin. 
 
The sections of the main Rumen8 window in compact mode. Diet ingredients (1), detail tabs (2) 
and income and cost summary (3). 

 
 

The right of the ‘Dairy/Diet’ tab shows how well our diet meets the cow's requirements. It doesn’t 
show anything yet as we have not added any ingredients to the diet. 
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DESCRIBE A COW 
Click on the ‘Dairy/Diet’ tab to show the cow description. Type a number in the entry box or use 
the up/down arrows to change the parameters of the cow you wish to feed, or the average cow 
that represents your herd or sub-herd. You can adjust live weight, growth rate, milk yield and 
components, stage of lactation and pregnancy status on the left side of the Dairy/Diet tab. You 
may also adjust the activity level of the cow with the distance walked slider and choose if you have 
a flat, undulating or steeply hilly farm. Leave the dry matter intake (DMI) estimation method set to 
conventional for the time being. 
 

To quickly overwrite a value in the entry box, double-click on it. The current value will be 
selected and then type in the new value to replace it. 

 
The Dairy/Diet tab. 
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ENTER A DIET 
Ten ingredients can be added to a diet using the drop-down lists on the left of the window. Click 
on ingredient 1 and select ‘Barley grain’ as the first feed in the diet. To quickly jump down the list 
quickly type the first letter of the ingredient you wish to find. 
 

Selecting a feed in the first diet component menu. 

 
 
Select ‘Lupins grain’ for ingredient 2 and ‘Ryegrass ann. – Dry – Spr – Low quality’ in ingredient 3 
(Dryland annual ryegrass of low quality). The diet should now look like the figure below. 
 

Three ingredients in the diet. 

 
 

Now let’s feed our cow. Enter the amount of each ingredient fed to the cow using the ‘DM’ entry 
box to the right of their name. Enter 6 kilograms of barley grain, 1 kilograms of lupins grain and 10 
kilograms of ryegrass. The window should now look like the figure below. Notice that while you 
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have entered the amount fed as kilograms of dry matter Rumen8 automatically shows you the 
amount as fed (including water) in the column to the right. You can adjust the amount with either 
dry or as fed quantities. 
 

Feeding our cow. 
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EVALUATE A DIET 
The ‘Diet’ tab shows six of the parameters you need to consider when formulating a diet for dairy 
cows. For this example, we will consider the first three. With the current diet, we can see there is 
insufficient metabolisable energy (ME 84%) and protein (MP 95%) for the cow we described 
earlier. However, while the cows’ dry matter intake progress bar is green, it is only 81% of her 
potential so this means she can physically eat more food if it is presented to her. 
Increase the amount of barley grain to 8.4 kg, decrease the lupins to 0.5 kg and increase the 
ryegrass to 11.0 kg. Now you will see both ME and MP are at 100% of the cow requirement and 
intake potential is still below 100% so she can eat this amount of feed. Your screen should look 
like the figure below. 
 

A diet balanced for energy and protein. 

 
 

This brings us to an important point that is true of all nutrition models. The application tells us we 
have a diet that meets the ME, MP and intake requirements of our cow, but a nutritionist is 
unlikely to recommend this diet. The starch content is high (27%) leading to a risk of acidosis (note 
the warnings in red alongside the starch at the bottom of the tab). This is before we consider the 
cost of this diet. 
 

Rumen8 is a tool that will assist someone with nutritional knowledge to better and more 
cost effectively feed their cows, but in the hands of someone without that knowledge it can 
create diets that appear balanced but may decrease cow performance or adversely affect 
their health.  
We recommend Rumen8 is used with your nutritionist. Depending on your level of 
knowledge it can be used to adjust diets between visits by them. 

 

This diet is now balanced for energy and protein and the cow should be able to physically eat the 
feed when it is presented to her. This demonstrates the start of the process when designing a diet 
for your cows, and you can now further refine the diet by looking at other important parameters 
such as starch and NDF content. 
The remaining tab allows you to change milk payment and the cost of the feeds in the current 
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diet. With feed costs and milk price Rumen8 can show you diet costs and margins to better 
compare alternatives. 
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DIET MARGIN 
Click on the Cost/Price tab. On this tab the top section allows you to enter the feed costs for each 
ingredient of the diet. In the bottom section you can enter the price you are paid for your milk. 
Enter the prices for the barley grain and lupin grain on an as fed basis as $300 and $350 
respectively. Enter the cost of the ryegrass as $100 per tonne of dry matter so your values should 
be the same as in the figure below. 
 

Feed costs and milk payment price can be entered on the second tab called Cost/Price. 

 
 

At the bottom of the tab you can see the milk price is already entered based on a price for each 
kilogram of fat and protein, and a discount for volume. Changing the ‘Payment by’ button to 
‘Yield’ allows you to enter a milk price per litre. 
Once Rumen8 has a cost for the feeds and a milk price it can calculate a margin in the bottom left 
Summary section. In this example the cow is eating $4.17 of feed each day and producing $10.03 
worth of milk giving a margin of $5.86. This provides a simple way to compare the financial 
performance of different diets even when they influence milk production. 
  



Rumen8 User Guide 

37 / 247 

 

 

USING RUMEN8 IN STANDARD MODE 
The main Rumen8 window when in standard mode is shown below. If you are currently in 
Compact mode you can change to Standard mode via the FIle menu. 
The Diet Ingredients section (1) is where you specify the animal diet. The tabbed section (2) is 
where you can specify the cow details, evaluate the current diet, adjust feed costs and milk 
payments, compare alternative diets and keep notes. The costs and efficiency strip at the bottom 
(3) reports feed costs, milk income, feed efficiency and margins. 
 
The sections of the main Rumen8 window. Diet ingredients (1), detail tabs (2) and diet costs and 
efficiencies (3). 
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DESCRIBE A COW 
Click on the ‘Dairy’ tab to edit the cow details. Using the entry sliders or typing a number in the 
entry box describe the cow you wish to feed, or the average cow that represents your herd or sub-
herd. You can adjust live weight, growth rate, milk yield and components, stage of lactation and 
pregnancy status. You may also adjust the activity level of the cow with the distance walked slider 
and if you have a flat, undulating or steeply hilly farm. 
 

To quickly overwrite a value in the entry box, double-click on it. The current value will be 
selected and then type in the new value to replace it. 

 
The Dairy animal tab. 

 
 

Now click on the ‘Diet’ tab to the right of the ‘Dairy’ tab to view how well our diet will feed the 
cow. It does not show anything as we have not added any ingredients to the diet yet. 
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The Diet tab. 
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ENTER A DIET 
Fifteen ingredients can be added to a diet using the drop-down lists on the left of the window. 
Click on ingredient 1 and select ‘Barley grain’ as our first feed in the diet. To quickly jump down 
the list quickly type the first letter of the ingredient you wish to find. 
 
Selecting a feed in the first diet component menu. 

 
 
Select ‘Lupins grain’ for ingredient 2 and ‘Ryegrass ann. – Dry – Spr – Low quality’ in ingredient 3 
(Dryland annual ryegrass of low quality). The diet should now look like the figure below. 
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Three ingredients in the diet. 

 
 
Now let’s feed our cow. Enter the amount of each ingredient fed to the cow using the ‘DM’ entry 
box to the right of their name. Enter 6 kilograms of barley grain, 1 kilograms of lupins grain and 10 
kilograms of ryegrass. The window should now look like the figure below. Notice that while you 
have entered the amount fed as kilograms of dry matter Rumen8 automatically shows you the 
amount as fed in the column to the right and you can adjust the amounts with either quantity. 
 
Feeding our cow. 
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EVALUATE A DIET 
The ‘Diet’ tab shows nine of the parameters you need to consider when formulating a diet for 
dairy cows. For this example, we will consider the first three. With the current diet, we can see 
there is insufficient metabolisable energy (ME 84%) and protein (MP 95%) for the cow we 
described earlier. However, the cows’ dry matter intake is only 91% of her potential so this means 
she can physically eat more food if it is presented to her. 
Increase the amount of barley grain to 8.4 kg, decrease the lupins to 0.5 kg and increase the 
ryegrass to 11.0 kg. Now you will see both ME and MP are at 100% of the cow requirement and 
intake potential is still below 100% so she can eat this amount of feed. Your screen should look 
like the figure below. 
 

A diet balanced for energy and protein. 

 
 

This brings us to an important point that is true of all nutrition models. The application tells us we 
have a diet that meets the ME, MP and intake requirements of our cow, but a nutritionist is 
unlikely to recommend this diet. The starch content is high (27%) leading to a risk of acidosis (note 
the warnings in red alongside the starch at the bottom of the tab). This is before we consider the 
cost of this diet. 
 

Rumen8 is a tool that will assist someone with nutritional knowledge to better and more 
cost effectively feed their cows, but in the hands of someone without that knowledge it can 
create diets that appear balanced on paper but may decrease cow performance or adversely 
affect their health.  
We recommend Rumen8 is used with your nutritionist. Depending on your level of 
knowledge it can be used to adjust diets between visits by them. 

 

This diet is now balanced for energy and protein and the cow should be able to physically eat the 
feed when it is presented to her. This demonstrates the process when designing a diet for your 
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cows, and you can now further refine the diet by looking at other important parameters such as 
starch and NDF content. Additional information about the current diet is presented in the ‘Diet 
detail’ tab to the right. 

DIET MARGIN 
Click on the Feed cost tab. On this tab you enter the feed costs for each ingredient of the diet.  
Enter the prices for the barley grain and lupin grain on an as fed basis as $300 and $350 
respectively. Enter the cost of the ryegrass as $100 per tonne of dry matter so your values should 
be the same as in the figure below. You will see the Feed costs section in the bottom left of the 
window show several different ways to evaluate the cost of this diet. 
 

Feed costs can be entered on the tab called Feed cost. 

 
 

Now click on the tab called Price. Here you can enter how much you receive for your milk. You can 
see the milk price is already entered based on a price for each kilogram of fat and protein, and a 
discount for volume. Changing the ‘Payment by’ button to ‘Yield’ allows you to enter a milk price 
per litre. Make sure the fat price is $5.10, the protein price is $7.30 and the discount is $0.022 per 
litre for the first row of prices. You can enter up to 12 different prices for milk and easily switch 
between them. 
 



Rumen8 User Guide 

44 / 247 

Milk prices can be entered on the tab called Price. 

 
 
Once Rumen8 has a cost for the feeds and a milk price it can calculate a margin in the right of the 
bottom section of the window. In this example the cow is eating $4.17 of feed each day and 
producing $10.03 worth of milk giving a margin of $5.86. This provides a simple way to compare 
the financial performance of different diets even when they influence milk production. 
 
The remaining tabs have various functions that make creating diets faster and easier. Use the 
‘Compare’ tab to save and compare up to six related diets before choosing the best one. The ‘Split 
herd’ tab is used to create combined diets for herds made up of different calving groups of cows. 
The ‘Notes’ tab allows you to keep a description of the diet for reference in the future. How to use 
these functions is discussed in the ‘Using Rumen8’ section of this guide. 
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THE PROBLEM OF MEASURING PASTURE INTAKE 
It all sounds simple, choose the ingredients your cows are being fed, enter the quantities you 
provide and balance the diet. Easy, but what about grazed pasture? Accurately measuring how 
much grazed pasture a cow eats is expensive and time consuming so may not be done on farm. To 
solve this problem, we ‘back calculate’ how much pasture the cows are predicted to eat by 
subtraction of all the feed ingredients you do know. It is easier than it sounds. 

1. Enter the values that describe the average cow in your herd on the ‘Dairy’ tab. Include the 
current milk production and yield. Rumen8 will calculate the metabolisable energy needed 
for the cow and this is displayed on the ‘Diet’ and ‘Diet detail’ tabs. 

2. Add all the supplementary feed provided to the cows using the ingredients drop-down 
lists. This includes grain fed in the dairy and forages in the paddock. Everything except 
grazed pasture. 

3. Rumen8 now calculates the metabolisable energy provided by the supplements and the 
difference between this and the cow’s requirement must be supplied by grazed pasture. 
This is shown on the ‘Diet detail’ tab as the ‘Balance’ under the ‘Metabolisable energy’ 
section and the remaining percentage of the metabolisable energy bar on the ‘Diet’ tab. 

4. Select a suitable pasture for your farm and time of year as the next diet ingredient. 
Increase the quantity of this until the metabolisable energy provided by the diet is the 
same as the requirement of the cow. 

You now have the diet that reflects the current situation with an estimate of the amount of 
pasture each cow is eating. With this information you can explore alternative diets that include 
pasture assuming you maintain the amount of pasture on offer for the herd in the future. 

RUMEN8 WARNINGS 
Rumen8 will sometimes display a red exclamation mark to draw your attention to something that 
may be wrong with a diet or parameter value you have entered. For example, if the days pregnant 
and days in milk values result in the cow getting back in calf within 40 days after calving a red 
exclamation mark appears next to the entry boxes for these parameters suggesting you should 
double check the values. 
In the previous examples you can see a red exclamation mark alongside the ingredient barley 
grain. This means the quantity of barley in the diet exceeds the recommended maximum. If you 
hover your mouse over the exclamation mark a tool tip will appear giving you more details about 
the issue. 
 

! When you see a red exclamation mark mouse over it and the tool tip will tell you what is 

wrong. 
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MENU COMMANDS FOR DAIRY 
The menu is along the top of the main window and has five choices, File, Edit, Animal, View and 
Help. 

FILE MENU 
The File menu. 
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New 

Start a new diet. The current diet will be cleared, the animal will revert to the 
default values, diets stored in the Compare tab will be cleared, split herds 
cleared and any notes erased. If the current diet has not be saved you will be 
prompted to do this before the diet is cleared. 

Open 

Allows you to load a previously saved diet. A warning will appear if the milk 
price or dry matter intake parameters have changed since the diet was saved. 
These warnings can be disabled in the Preferences. You can also import diet 
files from version 2 of Rumen8 by selecting the file type ‘Rumen8 v2 files (*.csv) 
in the Open dialog box. 

Open Recent 

The sub-menu shows a list of the previous 5 diet files to be opened. To re-open 
one of these select it from the list. To remove all the previous diet files from the 
list select the Clear option at the bottom of the sub-menu. 

Save 
Save the current diet. This is only available if the diet has been previously 
named and saved using the ‘Save As’ menu. 

Save As 
Name and then save the current diet. If changes to the current diet have not 
been saved an * will appear next to the diet name in the title bar. 

Reload feeds 

This updates all the feed data from the feed library. This is useful if you have 
multiple instances of Rumen8 running and have made a change to a feed in one 
of them and wish to quickly update the others. 

Reports 
Opens the report designer that creates diet reports for printing or to be saved 
as a PDF document. 

Preferences 
Opens the Preferences allowing you to change Rumen8 settings. A more 
detailed explanation is given in the Preferences section. 

Standard Mode When ticked all of Rumen8’s functions are available. 

Compact Mode 
When ticked the Rumen8 window is reduced to the essentials required to 
balance a diet based on energy, protein, fibre and starch. 

Dairy When ticked Rumen8 is in dairy mode. Select to switch to dairy mode. 

Beef When ticked Rumen8 is in beef mode. Select to switch to beef mode. 

Exit Close Rumen8. You will be prompted to save an unsaved diet. 
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EDIT MENU 
The Edit menu. 
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Edit Feeds 

Opens the Feed Editor to change feeds and mixes and the ingredients 
available in the ingredient drop-down lists. A more detailed explanation is 
given in the Feed Editor section. 

Search Feeds 
Opens the Search window that allows the feed library to be searched for 
feeds containing text entered by the user. 

Copy Diet 
Copy the current diet to the clipboard for later pasting into Excel or Word 
for example. 

Copy All Diets Copy the current diet and the three stored diets to the clipboard. 

Clear Current Diet Removes all the ingredients from the diet. 

Create Mix From Diet 
Opens a window that allows a new mix to be created from the current diet 
feeds (not mixes).  See below for more information. 

Feed Library 
If multiple feed libraries have been created in the Feed Editor they can be 
selected by name using this sub-menu. 

Preferences Library 

If multiple Preferences libraries have been created in the Preferences they 
can be selected by name using this sub-menu. This option is not available in 
Compact mode. 

Prices Library 

If multiple Prices libraries have been created on the Price tab they can be 
selected by name using this sub-menu. This option is not available in 
Compact mode. 

All Libraries 

If a feed, preferences and prices library are given the same name they are 
referred to as a library set and will appear in this sub-menu. Selecting one of 
these library sets will change all three libraries at once. This option is not 
available in Compact mode. 
This is useful if you are using Rumen8 in different countries. For example, if 
you are based in Kenya but also consult in Uganda you can create feed, 
preferences and prices libraries specific to Kenya and give them all the same 
name, such as 'Kenya'. Also create three additional libraries specific to 
Uganda and make sure they are all called 'Uganda'. Now under the 'All 
Libraries' sub-menu you can select Kenya or Uganda and quickly switch 
between library sets. 
Library sets must contain all three library types and have exactly the same 
name before they will appear in the 'All Libraries' menu. 

 

Searching for a feed 

Open the Feed Search window via the Edit menu. At the top left you can enter all or part of a 
feed's name (1). Click the Search button (2) to search through the current feed library for feeds 
that contain the entered text in their name, species name or other names. The number of feeds 
found is displayed at the top right of the window (3) and the feeds below in the main part of the 
search window (4). 
By default only the selected feeds in the current feed library are displayed. To widen the search 

you can also include unselected feeds (5) and other feed libraries (6). 
 
The feed search window available from the Edit menu. 
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Creating a mix from the current diet 

The mix creation window allows a new mix to be created from the current diet feeds (not mixes). 
Each ingredient can be removed from the mix by unticking the box to the left of the feed name 
(1). Each feed displays the quantity in the new mix on a dry matter and as fed basis, and the 
percentage of the mix it makes up (2). 
To the right of the ingredient list you can select if the mix percentages are based on dry or as fed 
quantities and check the total mix dry matter content and number of ingredients (3). 
Below are the normal mix parameters like those in the Feed Editor mix tab (4). The mix must have 
a unique name among existing feeds and mixes. The heading ‘Name’ will turn red if this is not the 
case and you will be unable to click on the ‘Okay’ button to create the mix. 
Once you are happy with the mix definition, have given it a unique name and provided as many of 
the optional parameters as you wish, click on the ‘Okay’ button to save it to the current feed 
library. 
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The mix creation tool available from the Edit menu. 
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ANIMAL MENU 
The Animal menu. 

 
 

Save current animal as 
the default 

Save the current animal as the default that will be loaded each time 
Rumen8 starts. 

Reload default animal Replace the current animal with the default animal. 

Use standard animal 

Replace the current animal with a pre-defined generic cow in early, mid 
or late lactation for total lactation production of 2000 to 10000 litres. 
These definitions should only be used for general analyses. For on-farm 
use actual milk production and composition for the herd of interest 
should be used. 

Dry off the current 
animal 

Change the parameters for the current animal as if it had been dried off 
and was at the start of a 60-day dry period. 

Move cow into the 
transition herd 

Changes the parameters for the current animal to one that is 3 weeks 
prior to calving and has entered the transition or close-up period (i.e., 
last 3 weeks before calving). 
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VIEW MENU 
The View menu. 

 
 

Energy detail 
Displays the details of the metabolisable energy demand calculated for the 
animal. 

Protein detail 
Displays the details of the metabolisable protein supply and demand 
calculated for the animal. 

Minerals detail 
Displays the details of the calcium, phosphorus and magnesium demand and 
supply. 

Ingredient detail 
Displays the attributes of a of diet ingredient. The sub-menu allows you to 
choose from ingredient 1 to 15. 
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HELP MENU 
The Help menu. 

 
 

Help Opens a context sensitive version of this document. 

Introduction 
to Rumen8 

Starts an introductory tutorial that explains the basics of creating a diet in 
Rumen8. 

FAQ Opens the default browser and displays the FAQ page on the Rumen8 website. 

About 

Display information about Rumen8 such as the version number, website address 
and email for support. You can also access the Acknowledgements, End user 
license agreement and a list of references of publications used to create Rumen8. 

Registration Enter your registration number and name here to unlock all the diet ingredients. 

What’s new Lists all the changes to each version of Rumen8. 

Check for 
updates 

Check to see if a newer version of Rumen8 is available. This can only be done if 
your computer is connected to the Internet. 
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USING RUMEN8 FOR DAIRY 
This section will describe the main parts of the Rumen8 window and how you use them. 

DIET INGREDIENTS 
The left section of the main window is where you add ingredients to your diet and specify the 
quantity fed each day. In the figure below it is highlighted within a red rectangle. 
 
The diet ingredients section of the main window shown within the red rectangle. 

 
 

Clicking on the down arrowhead on the right side of the drop-down lists allows you to choose any 
of the feeds available from the feed library. 
 

If you want an ingredient further down the list type the first letter of its name on the 
keyboard to jump to the first ingredient starting with that letter. 

 
Once a feed has been selected the ‘DM’ and ‘As-fed’ entry boxes become active and you can 
either type the kilograms to be fed in directly or click on the up and down buttons to vary the 
existing amount. 
You can enter the value on a dry matter basis in the ‘DM’ column and the amount will be 
displayed on an as-fed basis in the ‘As-fed’ entry box. If you prefer to enter the amount as-fed the 
reverse works in the same manner. Internally Rumen8 always uses the value on a dry matter basis. 
Up to fifteen feeds or mixes can be added to a diet. To see the details of a selected ingredient, 
right-click on the ingredient number and the detail window will open. Alternatively hover the 
mouse over ingredient name and a tool tip will appear showing the feed or mix attributes. 
The total diet weight on a dry matter basis and as fed are displayed at the bottom of each of the 
columns. To the left the dry matter content of the diet is displayed. 
 



Rumen8 User Guide 

56 / 247 

The diet ingredient tool tip window displays the parameters for that fed or mix. 

 
 

The diet ingredient detail window displays all the parameters for an ingredient. The window can 
remain open while the diet is created and you can quickly switch between ingredients using the 
drop down menu displaying the feed names at the top (1) or the ingredient numbers at the 
bottom (4). The Other names button at the top right (2) opens a window where you can see the 
other names for a feed. One of the feed parameters is a comment that can be entered by the 
user. If this comment contains a internet web address it will appear blue (3). It can be clicked on to 
open the default browser and display the page at that address. In the example below the link will 
open the Feedipedia page for the feed providing more information that may be useful for the 
user. As the external links are beyond the control of RUmen8, ensure they are for a safe website 
address before clicking on them. 
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The diet ingredient detail window. 

 
 

As feeds are added or quantities are adjusted Rumen8 recalculates energy, protein and nutrient 
supply relative to demand showing how well your diet is meeting production requirements. 
 

To quickly remove an ingredient from the diet, hold down the Shift key on the keyboard and 
with the mouse right click on the ingredient number. 
To quickly set the amount of an ingredient to 0.00kg, hold down the Control key on the 
keyboard and with the mouse right click on the ingredient number. 
To clear all the ingredients from the diet, select ‘Clear current diet’ from the Edit menu. 
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Moving ingredients in the diet 

Ingredients can be dragged and dropped between the 15 feed locations to swap their positions. 
Amount fed is also swapped with the ingredients. To move ingredient 3 to position 8 left click and 
hold on the number 3 to the left of the ingredient name. The mouse pointer will change to show a 
small rectangle below the pointer. Still holding down the mouse button down move the pointer 
over the ingredient 8’s name or number and release. The ingredients and their amounts fed will 
now be swapped. You can only drop an ingredient over the ingredient name or number, anywhere 
else will display a no entry symbol. 
 
Step 1: Starting to drag Barley grain in position 1 to position 8. 
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Step 2: Drop the Barley grain over the ingredient position you want it to occupy by releasing the 
mouse click. 

 
 
Step 3: After the drag and drop the Barley grain and Ryegrass have swapped ingredient positions. 
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ANIMAL 
The Dairy animal tab is the first of the tabbed section of the main window and is used to describe 
the cow, or the cow that represents the herd average, for the diet that we are creating. 
 

The Dairy animal tab highlighted within the red rectangle. 

 
 

Using the sliders adjust live weight, growth rate, milk yield and components, days pregnant and 
days in milk. The value can be changed quickly by moving the slider left and right or adjusted 1 
unit at a time by clicking on the – and + symbols at either end. To quickly overwrite a value in the 
entry box double click on it. The current value will be selected and then type in the new value to 
replace it. 
Days pregnant and days in milk can also be set by specifying the date of conception or calving by 

clicking on the calendar icon  . 
For convenience, the milk yield is also expressed as fat: protein ratio and fat plus protein kilograms 
per day based on the input milk yield and components. The energy corrected values display the 
yield in kg corrected to the international standard 4.0% m/m fat and 3.3% m/m protein. 
Additional parameters let you adjust the activity level of your cows if you have a large or hilly farm. 
Note that a grazing cow will typically walk 4-5 km over a day in the paddock, in addition to the 
distance to and from the dairy for milking 

Maturity 

Select whether the animal is an unmated or mated heifer, or a cow from the drop-down list. 

Breed 

The cow breed is only used to estimate mineral demand. If the cow is not Holstein, Jersey or 
related, choose other. 



Rumen8 User Guide 

61 / 247 

Live weight 

Mean live weight (kg) of the herd at the time of interest. Cows that are weighed on farm are the 
best guide, but if cow live weight is unknown, use the following as a guide. 

'North American' Holstein cows are 600-650 kg live weight. 
Australian Friesian cows are 550-600 kg live weight. 
Cross-bred cows 450-500 kg live weight. 
Jersey cows 375-425 kg. 
First calvers are often 10% less than their mature counterparts. 

For culled cows that are sold ‘over the hooks’, dairy cows typically dress out at ~40-45% of live 
weight. For example, a 260-290 kg dressed weight equates to ~650 kg live weight. Note that cull 
cows are (or should be) older cows, so these will not be representative of the average live weight 
of the herd. 

Live weight change  

This is the estimate of the amount of live weight that is being lost or gained across the herd 
(kg/cow/day). Some typical figures are shown below. 
 

Possible estimates of live weight change during a lactation for a 600 kg cow. 

Days in 
milk 

0-30 30-60 60-90 
90 - 
120 

120 - 
150 

150 - 
180 

180 - 
210 

210 - 
240 

240 - 
270 

270 - 
300 

Dry 
period 

LWC 
kg/d 

-0.8 -0.6 -0.2 0 0 0.05 0.15 0.3 0.4 0.5 0.1 

 

Clicking on the calculate button  alongside the live weight change value will open a window that 
assists in estimating the rate of live weight change for your animal. For cows this is based on the 
days in milk with the option to increase the rate if the cow is required to gain BCS over the 
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lactation. 
 

The live weight change calculator for cows. 

 
 
To estimate live weight change for the current cow, adjust the days in milk value and you will see 
the estimate change below. Hover the mouse pointer over the text at the top of the window to 
see a graph of how a typical cow’s live weight change varies between calving assuming she returns 
to the same BCS in which she started the lactation. 
If the cow isn’t meeting the recommended BCS for this stage of lactation or you wish her to calve 
at a higher BCS than previously you may add additional live weight change over and above the 
base. Set the amount of additional BCS gain with the top slider and the time to achieve this with 
the bottom slider. This will increase the live weight change value by the appropriate amount. To 
see more detail on the energy requirements of BCS gain hover your mouse over the text above 
the unit gain slider. Once you are happy with the live weight change estimate click on the ‘Okay’ 
button to return it to the animal tab. 
For heifers the calculator estimates the required rate of gain to meet mating or calving target live 
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weights. 
 
The target growth rate calculator for mated heifers. 

 
 
Heifer growth rates are calculated so the herd reaches target live weight at mating or calving (55% 
and 94% herd mature weight respectively). Ensure the herd’s mature weight is representative of a 
typical animal that has completed 3 lactations. By entering the heifer’s birth date (or mean birth 
date for a group of heifers), a current weigh date and (mean) live weight you can see if the heifer 
(group) is on track. In the figure above the target weight is 47% of mature weight at 11.2 months 
and the herd is slightly above that at 49% so all is well. 
To determine the target growth rate from the weigh date to mating or calving enter the date of 
the event. In the example above to calve on the 24th of October 2024 the heifer herd must 
maintain a growth rate of 0.7 kg/day to reach 611 kg live weight (94% of the mature herd weight 
of 650 kg live weight). 
Once you are happy with the target live weight change value click on the ‘Okay’ button to return it 
to the animal tab. 

Days Pregnant 

Affects nutritional requirements, which becomes significant from day 140 onwards. Days pregnant 
should be the weighted average of the herd (see below example of Days in milk). The number of 
days since conception can be entered directly with the slider or click on the calendar icon to select 
the date of conception. 

Days in milk 

Days in milk is also required to estimate feed intake potential, as stage of lactation influences the 
amount of feed a cow can consume. Feed intake (kg DM/cow/day) is estimated as per NRC (2001).  
Peak dry matter intake generally occurs at 80-100 days post calving. Where cows have been 
exceptionally well prepared for calving and then well-fed post calving without any metabolic or 
health issues peak DMI may occur at 60-80 days in milk.  
Where cows have had restricted energy intake through this period peak DMI is more likely to 
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occur at 100-120 days in milk. 

Days in milk must be calculated as a weighted average for the herd. For example 

100 cows @ 100 DIM 10,000 cow days 

200 cows @ 280 DIM 56,000 cow days 

30 cows @ 350 DIM 10,500 cow days 

330 cows 76,500 cow days 

Weighted herd average = 76,500 cow days / 330 cows = ~230 DIM 
The number of days since calving can be entered directly with the slider or click on the calendar 
icon to select the (mean) calving date. 
Alternatively, separate diets can be calculated in Rumen8 for each calving group in the above 
example. 

Number of cows in the herd 

This is used only to calculate the herd margin (daily milk income minus daily feed costs in 
$/herd/day) and can be left set to 1 if you are more interested in daily milk income minus daily 
feed costs per cow/day. 

Milk yield 

(Litres or kilograms/cow/day) – if milking numbers are stable this should be the last 5-10 days 
average milk yield per cow. Milk yield should include all milk produced per cow, including milk that 
is being fed to calves and any milk not suitable for human consumption. 

Milk fat and protein 

Ensure you set the correct unit in the Rumen8 Preferences. In Australia this is almost always mv% 
(mass/volume, grams per litre), while in NZ it is mm% (mass/mass, grams per kilogram). Protein% 
as used in Rumen8 is true protein (in some countries milk protein is analysed as crude protein 
which is about 6% higher than true protein). Take the average of the latest 5 days of available 
factory figures. When estimating production for subgroups of cows within the milking herd the 
milk fat and protein percentages are likely to be significantly different to the herd average e.g.' 
early lactation cows in peak production vs late lactation cows. 
Below the entered milk yield and composition Rumen8 reports the Fat:Protein ratio (this can be 
changed to the Protein:Fat ratio in the Preferences) and the yield of fat, protein and fat + protein 
in kilograms per day. In addition, the yield as energy corrected milk is calculated standardised to 
4% fat and 3.3% protein content (m/m). 

Dry matter intake estimation method 

Here you can set how to estimate the maximum dry matter intake for the cow. The conventional 
method is recommended as this uses the NRC 2001 intake equation for lactating cows, the AFRC 
1993 intake equations for heifers and fixed intake values for dry and transition/close-up cows that 
can be adjusted in the Preferences. 
As an alternative, the NDF intake method can be selected.  This method estimates the cows 
predicted intake based on the amount of NDF eaten as a percentage of the cow’s live weight. The 
percentage of live weight for lactating cow, dry and transition/close-up cows and heifers can be 
changed in the Preferences. 
A third intake estimation method based on the Indian Council of Agricultural Research 2013 
publication is available for users not in Australia and New Zealand. This method for lactating cows 
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may be more suitable for diets similar to those used in India. 

Farm terrain 

This influences the amount of energy required for maintenance. Note that walking 1 ‘vertical 
meter’ requires the same energy as walking 10 ‘horizontal meters’. 

Distance walked 

This influences the amount of energy required for maintenance.  

• Cows grazing a large farm (300 Ha) with centrally located dairy will on average walk 4 km to 
and from the dairy plus distance walked while grazing ~5 km. Daily total 9 km. 

• Cows grazing a medium sized farm (150 Ha) with centrally located dairy will on average walk 3 
km to and from the dairy plus distance walked while grazing ~4 km. Daily total 7 km. 

• Cows grazing a smaller sized farm (75 Ha) with centrally located dairy will on average walk 2 
km to and from the dairy plus distance walked while grazing 3 km. Daily total 5 km/d. 

• Cows kept in feedlots will on average walk only a few hundred meters a day plus the distance 
to and from the dairy. Often no more than 1 km/d. 
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DIET 
The diet tab provides an overview of the current diet performance. 
 

The Diet tab highlighted within the red rectangle. 

 
 

The Diet tab has six horizontal bars representing the dry matter intake, metabolisable energy, 
metabolisable protein, calcium, phosphorus and magnesium in the diet. Below these are the 
neutral detergent fibre and starch percentage of the diet and the forage to concentrate ratio. 
Metabolisable energy, protein and minerals are expressed as a percentage of the cow’s 
requirement so a balanced diet should have these parameters around 100%. When the cow’s 
requirement is not being met the progress-bar will be red. When the diet meets the cow’s 
requirement the bar will be green. If there is an excess of ME, MP or minerals in the diet the 
corresponding bar will be yellow. 
The intake bar shows the percentage of the animal’s maximum intake the current diet represents. 
When the cow is eating close to potential the bar will be green. If the diet contains too much feed 
for the cow to eat the bar will turn yellow and if the cow is being underfed the bar will be red. 
How close to 100% the progress bars must be to turn green is adjusted in the Preferences. 
The starch and NDF sections show the percentage of the diet made up of these components. The 
final value shows the ratio of forage to concentrate in the diet (with the total being 100).  
If ‘Recommended Levels’ are set for NDF, starch and forage: concentrate a traffic light will appear 
and show whether the current value is under, within or above the recommended range. See the 
Preferences section for how to set ‘Recommended Levels’. Independent of the ‘Recommended 
Levels’ a warning may appear next to each of these parameters if the dietary level suggests the 
cow may be in danger of ruminal acidosis. 
For further information about each parameter, hover your mouse over the progress bar and a tool 
tip will appear showing the actual values. For example, the tool tip for the dry matter intake bar in 
the figure above displays ‘Supply 18.0 kg. Maximum intake 18.9 kg. Balance -0.9 kg’. 
In the bottom right of the tab a red exclamation mark will appear if a monitored diet parameter 
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not shown on this tab is outside the recommended level set in Preferences. See the section on 
Recommended Levels in the Preferences for how to set suitable ranges for important diet 
parameters. 
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DIET DETAIL 
The ‘Diet Detail’ tab is used in a similar way to the ‘Diet’ tab but contains much more information 
about the diet performance. 
 
The Diet Detail tab shown within the red rectangle. 

 
 

The diet detail tab is divided into several sections covering metabolisable energy, metabolisable 
protein, dry matter intake, fibre, rumen protein, starch, fat, enteric methane production, minerals 
and the dietary cation anion difference. In addition, the active set of Recommended Levels can be 
changed in the bottom left corner of the tab. See the Recommended levels section under the 
Preferences for Dairy chapter for more information. 
Alongside the values for starch a red exclamation mark is visible in the figure above. If you hover 
your mouse over it a tool tip will appear giving more information on why these parameter values 
may be an issue. 

Metabolisable energy  

This section shows the total ME supplied by the diet, demand from the cow and the consequent 
balance. Below is the energy density of the diet. 
The ‘traffic light’ to the right is red when ME from the diet is insufficient, green when it meets the 
cow’s demand and yellow when it exceeds the cow’s needs. Clicking on the title ‘Metabolisable 
Energy’ (or the menu option View, Energy detail) will bring up the detail window that provides 
more information about how ME demand is calculated. The detail window can remain open while 
the diet and cow is adjusted so the influence on components of the total ME demand can be seen. 
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The metabolisable energy detail window. 

 
 

Metabolisable protein  

This section shows the total MP supplied by the diet, demand by the cow and the subsequent 
balance. Below is the diet’s crude protein content. Crude protein content of the total diet is only 
provided for reference. The ‘traffic light’ to the right is red when MP from the diet is insufficient, 
green when it meets the cow’s requirement and yellow when it exceeds the cow’s needs. Clicking 
on the title ‘Metabolisable protein’ (or the menu option View, Protein detail) will bring up the MP 
supply and demand detail window that provides more information about how metabolisable 
protein supply and demand are calculated by Rumen8. The detail window can remain open while 
the diet and cow is adjusted so the influence on components of the total MP supply and demand 
can be investigated. 
As with the rest of the Rumen8 application, hovering the mouse over each parameter will provide 
additional explanatory information. If you hover over the text ‘MP system flowchart’ on the detail 
window a chart will appear that shows the path protein takes through the animal that 
corresponds to the values Rumen8 calculates when estimating MP supply. 
 

The metabolisable protein detail window. 
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Intake  

The ‘DM intake estimate’ section shows the percentage of maximum predicted intake the current 
intake represents for the three methods of calculating potential available on the animal tab. It is 
recommended you refer to the Conventional (%), as this is more reliable than determining intake 
potential by calculating NDF intake as a percentage of live weight for lactating cow diets that 
contain concentrates and medium and high-quality forages. 
The ‘traffic light’ is red when the diet constitutes less than the cow can eat, green when the cow is 
eating as much as she can, and yellow when the diet exceeds the cow’s ability to eat it. The 
current intake estimate method linked to the traffic light is shown in black text and the inactive 
method is shown in grey. The sensitivity of the traffic light and parameters used to adjust intake 
estimation can be adjusted in the Preferences. 
The third intake estimation method is based on the Indian Council of Agricultural Research 2013 
publication. It is not available for users not in Australia and New Zealand. This method for lactating 
cows may be more suitable for diets similar to those used in India. 
Dry matter intake as a percentage of live weight is also provided as an alternative method to 
evaluate the animal’s current intake potential. 

Fibre, rumen protein, starch and fat 

The four sections in the top right of the diet detail tab reports a range of diet parameters for the 
current diet. These cover things like NDF, starch and sugar through to rumen degradable protein 
and forage concentrate ratio. If you are unsure what one of the abbreviations means hover your 
mouse over the text and a tool tip will appear with a more detailed explanation. 
The ‘Excess protein’ section shows the effect of having too much protein in the diet. There is a 
metabolic cost to remove excess protein and this is expressed as forgone milk production or live 
weight growth. The calculation can be adjusted in the Preferences. 
If Recommended Levels have been set for some of these diet parameters a small traffic light 
appears next to the value and shows if it is below, within or above the recommended range. In 
addition, the NDF, starch and forage concentrate ratio may show a red exclamation mark if the 
current value may result in the animal being at high risk of ruminal acidosis. 

Methane 

The amount of methane produced by the animal from the intestines is shown as a total and as 
how much per unit of milk production (intensity). Methane (CH4) is a greenhouse gas emitted 
from livestock mainly through enteric fermentation and manure decomposition. Methane 
produced in the intestine (enteric) is a natural by-product of microbial fermentation of nutrients in 
the digestive tract of animals. 

Minerals 

The bottom right section of the diet detail tab displays supply and demand for the diet’s calcium, 
phosphorus and magnesium levels. A traffic light for each show if the current level is below (red), 
equal to (green) or above (yellow) the animal’s requirement. If all the feed ingredients have a 
DCAD value the dietary DCAD is calculated and compared with a recommended level depending 
on whether the cow is lactating, in the early dry period or the ‘transition/close-up period’ (last 3 
weeks before calving). 
Clicking on any of the titles ‘Calcium’, ‘Phosphorus’ or ‘Magnesium’ (or the menu option View, 
Minerals detail) will bring up the Minerals supply and demand detail window that provides more 
information about the animal demand and diet supply of each of the minerals. The detail window 
can remain open while the diet and cow is adjusted so the influence on mineral supply and 
demand can be investigated by adjusting cow or dietary parameters. 
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The minerals detail window. 

 
 

Discovering why a diet parameter is not displayed 

The feeds that are provided as part of the Rumen8 default feed library have complete information 
so there are no missing parameters. This may not be the case for feeds you create as some 
laboratory analyses may not cover all aspects of the feed. For example, a feed analysis may not 
provide ADF percent and this will prevent Rumen8 from calculating the ADF content of the diet as 
shown in the figure below (1). To find out which diet ingredient is missing the ADF information, 
hover your mouse pointer over the missing value and the tool tip will list the feeds without that 
value. 
 
Discovering which feed is preventing the diet ADF content being calculated (1). 

 

Recommended levels 

The section in the bottom left of the Diet detail tab shows which set of Recommended Levels has 
been selected, if any, and allows the user to change between sets. In the figure at the start of this 
section a set of Recommended Levels that applies to early lactating cows has been selected and 
the small traffic light adjacent to NDF (%DM) is linked to this. See the Preferences section for how 
to turn on and off and adjust the individual Recommended Levels. Rumen8 can also automatically 
switch between sets of Recommended levels based on the cow’s days in milk and days pregnant 
depending on whether the button is set to [A]utomatic or [M]anual. 
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MILK PRICE 
The price of milk is used to calculate milk income and margins of milk income over feed costs. 
Each milk price set contains a total of 24 milk prices, twelve entered as payment by volume and 
twelve entered as payment for components. 
Use the ‘Payment’ box to the right of the tab to select if you wish to enter you milk prices by 
volume or components. Click on the ‘Components’ button to use the 12 payment prices entered 
as payment for fat plus protein minus a volume discount, or the ‘Volume’ button to select the 12 
volume prices entered as cents per litre. 
 

The milk price tab with payment by volume selected shown within the red rectangle. 
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The milk price tab with payment by components selected shown within the red rectangle. 

 
 

If the payment is entered by volume, the equivalent value expressed as payment for components 
is shown alongside it, and if by components, the equivalent shows the price calculated by volume. 
The calculation of equivalent price uses the current milk components entered on the animal tab. 
Each of the 12 prices are entered in the entry box/s alongside the numbers 1 to 12. The current 
price is selected with the button to the left of the number. 
If you do use the 12 milk prices to represent months of the year, Rumen8 will not switch between 
them automatically as the date changes. 
 

Prices libraries 

Multiple libraries of milk prices can be defined and given a name in Rumen8 using the controls in 
the bottom-right side the tab. The current price library is named Default in the figure above. 
Switch between price libraries using the drop-down menu. Multiple price libraries are only 
available in Standard mode. 

Add Copy Create a copy of the current library. You will be prompted for the library name. 
Names must be unique. This option is not available in Compact mode. 

Rename Rename the current library. Names must be unique. This option is not available in 
Compact mode. 

Delete Delete the current library. You cannot delete the last library. This option is not 
available in Compact mode. 

Import Import as a new library from a Prices file that has previously been exported or 
created by Rumen8 version 3. This option is not available in Compact mode. 

Export Export the current prices as a library file. This option is not available in Compact 
mode. 
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FEED COST 
The feed cost tab allows you to quickly adjust feed prices and losses for feeds in the current diet 
without returning to the feed library. This is useful for comparing groups of feed sources at 
different prices without having to create a new feed for each. 
 

The feed costs tab shown within the blue rectangle. 

 
 

For each of the current diet ingredients you may change the cost on a dry or as-fed basis and the 
losses that occur before the cow eats it. The final cost is expressed on a dry matter basis, and then 
after losses for both dry and as-fed weights. The last two columns show the feed costs per MJ of 
metabolisable energy and per kilogram of crude protein. These parameters are useful for 
identifying the cheapest ingredients to fill an energy or protein deficit in the diet. 
The values are changed in the feed library so if you are investigating the influence of feed price 
changes don’t forget to put the actual feed cost back when you have finished. 
 

Losses are not applied to the amount of feed eaten by the animal but represent the amount 
of feed lost between when it was costed (usually at delivery or harvest) and when it is eaten. 
This means the losses only influence the feed cost, not the feed amounts. For example, if 
the barley grain $250/t DM delivered to the farm and losses are set to 2%, it means the loss 
occurs after the grain was delivered to the silo and before the cow eats it. The actual cost 
per kg of barley grain consumed is now $255 /t DM.  The cow still eats 9.0 kg/day of barley 
grain. The diet ingredient amounts are always the amount the animal eats, regardless of 
losses. 
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COMPARE 
The ‘Compare’ tab allows you to build a diet and then save it for comparison with other diets. 
Think of it as six slots where you can store a diet while you experiment with other feeds in the 
main window and then compare them before recalling the best one. 
 

The compare tab shown within the blue rectangle. 

 
 

There is room for six diets numbered 1 to 6 from left to right. To store the current diet, click the ‘S’ 
button (store) for one of the diet slots. The 15 ingredients that make up the diet will appear in the 
slot along with important parameters below. You can make changes to the current diet, store an 
additional five versions, decide which offers the best solution and then recall that one to the main 
window by clicking the ‘R’ button (recall) for that slot. Clicking the ‘C’ button (clear) will clear the 
slot. 
When a diet is recalled you have the option to also restore the animal parameters on the Dairy tab 
to the values when the diet was stored. 
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SPLIT HERD 
The Split herd tab allows you to create a combined diet based on specific diets for sub-groups 
within a larger herd. For example, you may be running a single milking herd of 200 cows consisting 
of 150 cows that calved in autumn and 50 cows that calved in spring. While it would be preferable 
to run the two groups separately so they could receive a diet tailored for their requirements, 
logistically that may not be possible. The Split herd tab allows you to calculate an ‘average’ diet for 
the herd. 

1. Create a diet for the 150 autumn calved cows and using the Compare tab store it in slot 1. 
2. Create a diet for the 50 spring calved cows and on the Compare tab store it in slot 2. 

Ensure when you create the diets for the sub-groups you set the number of cows in the herd 
correctly on the animal tab. 
 

The Compare tab with diets stored for spring and autumn calving sub-herds. 

 
 

3. Change to the Split herd tab. You will see a column for each of the three Compare storage 
slots. As we are only using two slots there is only a diet name and cow numbers for 
columns 1 and 2. 
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The Split herd tab showing the two diets from the Compare tab’s slot 1 and 2. 

 
 

4. To create an average diet weighted by cow numbers turn on the slots 1 and 2 by checking 
the include box under the Compare diet number as shown in the figure below. 

 
The combined diet is now listed showing amounts fed of each ingredient per cow and per herd 
on a dry matter and as fed basis. To see what the ‘average’ cow looks like hover the mouse 
pointer over the text ‘Note the average cow is only an approximation’ at the bottom of the 
tab. 
 
5. If the combined diet is acceptable it needs to be ‘copied back’ into the ingredients list 

along with the new animal definition. To do this click on the ‘Replace current diet and cow’ 
button and the bottom left of the tab. 

Now you can fine-tune this diet or print a report like any other Rumen8 diet. 
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The Split herd tab showing a combined diet about to be copied back into the main Rumen8 diet. 
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NOTES 
The notes tab allows you to write anything about the current diet you may wish to remember 
when looking at it later. This is often useful if you save diets by date and then refer to them in 
later years for guidance. The notes can also be used to communicate with your nutritionist if you 
save the diet file and email it to them for comment or adjustment. 
 

The notes tab shown within the red rectangle. 
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OPTIMISE (ADVANCED) 
The Optimise function within Rumen8 can be difficult to setup unless you have a good 
knowledge of Microsoft Windows and Excel. It requires Microsoft Excel and the Solver add-
in to be installed (versions 2010, 2013, 2016 or 2019 or Office365) and configured for use 
with Rumen8. See the Optimiser Installation section for step-by-step instructions. If you use 
the Optimiser regularly it is recommended to use a later version of Excel as the Solver add-
in optimises diets more successfully than earlier versions. 

 
The Optimise tab and button will only be available if it is enabled in the Rumen8 Preferences. 
Optimising allows you to fine tune a diet to minimise cost. The Optimiser will vary the amount fed 
of each ingredient to find the cheapest diet that meets the constraints you have chosen. Using the 
Optimiser requires all feeds have costs entered in the feed library or the feed costs tab. 
You should first add your feeds to the diet in the approximate quantities required. These amounts 
are used to 'seed' the optimiser and help it find a better diet. For the first run of the Optimiser 
enable the ME and MP constraints to ensure it is possible to calculate a diet from the feeds 
selected that meets the cow’s requirements. Once a feasible diet has been found progressively 
add additional constraints in decreasing order of importance starting with your preferred intake 
estimate until you have a diet that meets your needs, or the Optimiser cannot find a feasible 
solution. This step-by-step approach is far more likely to result in an optimised diet than simply 
turning on all the constraints immediately. This is because if a feasible diet cannot be found you 
know it was the last constraint that is the issue, and you can then either exclude that or relax 
constraints until a feasible diet can be found. 
 

Remember, the Optimiser simply treats the diet as a mathematical problem to solve and has 
no nutritional awareness. It can find a feasible diet that minimises cost and meets the 
constraints but that may harm your cows. Evaluate each feasible diet carefully based on your 
knowledge of the animal and the diet. If in doubt consult with a qualified nutritionist!  
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The Optimise tab shown within the red rectangle. 

 
 

You can add constraints to control the diet content of NDF, peNDF, NDF supplied by forage, crude 
protein, forage concentrate ratio, kilograms of concentrate, starch, sugar and fat. For each of 
these constraints you must specify the minimum and maximum levels that are acceptable using 
the left and right sliders. The actual values will be displayed to the left of the slider. The more 
constraints are activated, the more expensive the diet is likely to become.  Also, the narrower the 
range the less likely it is that a feasible diet can be found. To make the constraint active click the 
box to the left of the constraint name to put a tick in it. 
To the left of the constraint ranges are the current diet value for each parameter. If the constraint 
is active (ticked) and the diet value is outside the constraint range it will turn red. A parameter 
such as ME or MP may be close enough to the cow demand to have a green traffic light on the 
Diet detail tab and still be displayed in red on the Optimiser tab. This is due to a wider margin for 
the traffic lights (set in the preferences, default is 2%) and rounding differences between Rumen8 
and the spreadsheet calculations. 
The last four ingredient constraints refer to diet ingredients 1 to 15. Using these you can restrict 
the amount of each of four feeds in the diet. The drop-down list allows you to select the 
ingredient you wish to constrain, and the two entry boxes specify the range of kg DM fed that is 
acceptable. The ‘Current value’ button lets you to quickly fix an ingredient at the amount currently 
entered. This is useful when the amount of pasture available has been previously determined and 
needs to be fixed at a certain level. Then the remainder of the diet ingredients will be changed to 
optimise the diet. 
The light on the right of each of the ingredient constraint will turn green when that constraint is 
active. To be active it must be ticked, specify an ingredient number that has a feed or mix and 
have a valid range of DM fed. 
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The Optimiser has been unable to find a feasible diet. 

 
 

When a feasible diet cannot be found check the diet values to see how close the Optimiser was to 
the specified level. You can see in the figure above the ME and sugar constraints are highlighted 
red and are outside the desired range, preventing optimisation. The ME value can be ignored as it 
is only slightly greater than the cow demand, so the issue here is high sugar content in the diet. 
You can then either add additional feeds or relax a constraint until a feasible diet is found. 
The number shown in brackets at the end of the message from the Optimiser (under the 
‘Optimise’ button in the figure above) is the return code from the Solver add-in in Excel. You can 
find more information about these return codes in the Solver documentation provided with Excel. 
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Successful optimisation after relaxing the sugar constraint. 

 
 

The figure above shows a successful optimisation with a feasible diet found. 
The constraint ranges on the Optimiser tab can be quickly set to the recommended levels (set in 
preferences) by clicking on the ‘RL’ button which opens the ‘Apply recommended levels to the 
optimiser’ window. Up to 5 sets of recommended levels for a range of diet parameters can be set 
in the preferences providing quick feedback on the suitability of a diet on the Diet tabs. 
 

Apply previously set recommended levels to the optimiser. 

 
 

To set the optimiser constraint range to the same as the recommended range first select which 
set to use at the top of the window. In the figure above set one has values for early lactation cows 
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and three of the parameters are active and available to be used in the optimiser. Initially all the 
ranges are from the Optimiser tab so all the ranges under the ‘Current Optimiser’ column are in 
bold. To change ranges simply click on them. For example, to use the NDF% range from the 
recommended levels set one click on the ’28 to 30’ text and it will turn bold signifying it is now 
active. 
 

Diet parameter ranges from recommended level set one have been selected for NDF and sugar. 

 
 

Click ‘Okay’ to return to the Optimiser tab and the constraint ranges for NDF and sugar will be 
updated. 
  



Rumen8 User Guide 

85 / 247 

 

 

COSTS, INCOME, EFFICIENCIES, AND MARGINS 
The bottom of the Rumen8 window displays a range of parameters that allow you to evaluate the 
financial performance of the current diet. All feeds in the diet must have a feed cost entered and a 
milk price is also required. 
 

The costs, income, efficiency and margin measures shown within the red rectangle. 

 
 

These parameters are divided into four groups. From left to right they are feed costs, milk income, 
feed efficiencies and margins. The first two of the feed efficiency measures and the feed as a 
percent of income measure may also have a recommended level set in Preferences to quickly 
show if they are within the recommended range via a small traffic light. 
The current milk yield can also be adjusted in the bottom right of the window allowing the animal 
performance to be fine-tuned while the animal tab is not visible. But note our warning about 
marginal milk yield responses in the 'What Rumen8 doesn't do' section. 
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PREFERENCES FOR DAIRY 
The preferences allow you to change some Rumen8 settings to suit your business and location. 
Access to the Preferences window is via the Preferences option in the File menu of the main 
Rumen8 window. The settings you can adjust in Rumen8 are divided into General and Advanced. 
Additionally, you can adjust Recommended levels and the Standard cows on the rightmost tabs. 
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GENERAL PREFERENCES 
The general preferences tab contains setting most users will want to adjust. The settings shown in 
bold such as 'Milk yield units' and 'Currency' are common with the beef mode. This means 
changing the value while in dairy mode as shown in the figure below also changes it when creating 
a diet for a beef animal. Settings that do not have their title in bold are specific to dairy. 
 
The General preferences tab. 
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Milk yield units Milk yield can be entered and reported in litres or kilograms. 

Milk component 
units 

The fat, protein and lactose percentage of milk can be entered and reported 
in mass/volume (i.e., per litre) or mass/mass (i.e., per kg) units (mm% or 
mv%). 

Feed 
concentration 
units 

The units for concentration in feeds used by Rumen8 can be set to g/kg or 
percentage. 

Feed proportion 
units 

The units for parameters such as aN, bN or cN can entered and displayed as 
a proportion (0 to 1) or a percentage. 

Fat to protein ratio 
The ratio of fat and protein displayed on the animal tab can be shown as Fat: 
Protein or Protein: Fat. 

Tool tips detail 
This allows you to set the level of information provided by the tool tips. 
Standard displays a one-line explanation and Extended provides more 
detailed explanations with diagrams. 

Dry matter intake 
estimate 

The animal’s feed intake potential can be estimated using the ‘Standard’ or 
‘NDF as a percentage of live weight’ methods and is selected on the animal 
tab. For each method parameters can be modified to adjust the estimate. 
Animals are divided into 4 classes, lactating cows, dry cows, transition/close-
up cows (dry cows in the last 4 weeks before calving) and heifers.  
If an animal has the standard DMI method selected lactating cows will have 
their maximum intake calculated using the NRC (2001) intake equation, 
heifers use the AFRC (1993) intake equation and dry and transition/close-up 
cows use fixed DM intake amounts specified by the user. 
If the NDF DMI method is selected for a cow, for each of the cow classes 
above, a predicted NDF intake amount as a percentage of liveweight can be 
specified by the user. 

Currency – System 

Check to use the currency symbol set in Windows on your computer. 
Uncheck to manually set the currency symbol from the drop-down list. 
Choose ‘Custom’ at the end of the drop-down list to enter you own currency 
symbol. 

Currency – Do not 
display cents 

When checked all prices and costs will not show cents. 

Currency – Divisor 

For currencies with very large values select a divisor from the drop-down 
list. For example, If the currency divisor is set to 1000 all feed costs and milk 
prices should be entered into Rumen8 already divided by 1000. For example, 
100,000 Rp/t would be entered as 100 Rp. The currency divisor will be 
displayed on reports if it is greater than 1 and a flag appears on the main 
Rumen8 window below the tabbed section. 

Show the Diet tab 
The Diet tab can be turned off by un-ticking this box. Useful if you only use 
the Diet detail tab. 

Show the Split 
Herd tab 

The Split Herd tab can be turned off by un-ticking this box. Useful if you 
never use split calving herds 
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Load warning for 
milk price change 

When checked a warning will be given if a file is opened with a different milk 
price to the current. See below for more details. 

Load warning for 
intake estimate 
change 

When checked a warning will be given if a file is opened with a different 
intake estimation method to the current. See below for more details. 

Change Rumen8 
home directory after 
restart 

If you want to change where Rumen8 stores its files (usually 
~\Documents\Rumen8) then clicking the ‘Change home’ button will cause 
Rumen8 to ask you where to place the Rumen8 directory next time it is 
started. If this is a new directory the default feed library and Preferences 
files will be copied across. If you wish to retain your existing library files you 
should copy them into the new location using Windows Explorer. 

Restore all the 
Preferences to 
their defaults 

This will set all the preference settings back to their default values. 

Show Optimiser 
tab 

The Optimiser tab will be available in the main window if this box is ticked. 
This also makes available the Optimiser Preferences below it. See the 
Optimiser section of this document for more information on using the 
Optimiser as it requires Microsoft Excel and the Solver add-in along with 
careful setup. It will not work if you just enable it here! 

Excel visible during 
optimisation 

Tick this to see Excel load and optimise the diet. Usually left un-ticked. 

Excel saves diet 
after optimisation 

Tick this to make Excel save the Optimiser spreadsheet after optimising the 
diet. This is useful for debugging and is usually left un-ticked. 

 

Milk price changes result in a warning 

Rumen8 stores the current milk price in the save file (.rm8) when the diet is saved. When the 
Rumen8 file is opened Rumen8 checks to see if the milk price has changed and if so, warns the 
user. 
Rumen8 then looks for the saved milk price in three locations and if it finds it offers the user the 
option to switch to the previous milk price. In order of priority the 3 locations are: 
1. In the previous location (set number and price number). 
2. In the previous milk price set at a new price number. 
3. The current milk price set. 
If the previous milk price cannot be found in any of these locations the user is warned the milk 
price has changed but not offered the option to change it. 
Checking for milk price changes when opening a Rumen save file can be disabled in the General 
Preferences. 
 

Dry matter intake estimate changes result in a warning 

The method and parameters to estimate the animal’s dry matter intake are saved with the current 
diet in the save file (.rm8) and if they have changed when the file is reopened the user will be 
warned and given the option to revert to the value when the diet was saved. 
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For example, a lactating cow has the DMI estimation method set to NDF on the animal tab and in 
Preferences this is 1.2% of live weight. A diet is created, saved and the user moves on to other 
scenarios, during which the lactating cow value for NDF is changed to 1.3% of live weight in 
Preferences after talking to a colleague. A few months later when opening the save file it reloads 
the cow parameters, setting DMI method to NDF, and then prompts the user that the Preferences 
value for lactating cows NDF intake has changed from 1.2% when saved to the current 1.3% of live 
weight. The user can ignore this and continue with the 1.3% value or choose to set it back to 1.2%. 
If the Preferences are set back to 1.2% this will apply to all lactating cows with DMI set to NDF 
method. 
Whether Rumen8 warns the user about changes to DMI parameters in the Preferences can be 
turned off in the General Preferences. 
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ADVANCED PREFERENCES 
The advanced section of the Preferences contains those settings that are unlikely to need 
adjustment and may have a significant impact on the cow nutrition model if they are changed. 
Please change them only in consultation with an experienced nutritionist. 
 

The Advanced preferences tab. 
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Preferences 
library in use 

Select the Preferences library you would like to use from the drop-down 
menu. A preferences library contains the settings for both beef and dairy 
modes. This option is not available in Compact mode. 

Add Copy 
Create a copy of the current library. You will be prompted for the library 
name. Names must be unique. This option is not available in Compact mode. 

Rename 
Rename the current library. Names must be unique. This option is not 
available in Compact mode. 

Delete 
Delete the current library. You cannot delete the last library. This option is not 
available in Compact mode. 

Import 

Import as a new library from a Preferences file that has previously been 
exported or created by Rumen8 version 3. This option is not available in 
Compact mode. 

Export 
Export the current preferences as a library file. This option is not available in 
Compact mode. 

Acidosis (low 
rumen pH) 
warning 

Turning this on displays an estimate of rumen8 pH on the Diet Detail tab. The 
two pH levels control when warnings will appear for sub-clinical and acute 
acidosis. The rumen pH value is the daily average and assumes TMR feeding 
of grain so many other factors may result in actual rumen8 pH being lower 
than the prediction. See the tool tip on the Diet Detail tab for further 
information. 
This calculation is experimental so use it with caution. 

Net energy for 
live weight 
change 

The net energy liberated by live weight loss or required for live weight gain. 

Excess protein 
removal cost 

The range of values for the cost of removing excess protein by the cow. A 
range is provided as there are differing values quoted in the literature, which 
vary depending on the degree of N recycling via saliva. 

Fasting 
metabolism 
correction factor 

Rumen8 will increase the fasting metabolism energy requirement by 
multiplying it by this value. 

Fixed addition to 
ME requirement 

Rumen8 will add this value to the cow’s energy requirement. 

Animal time 
standing 

The number of hours per day the animal is standing. Leave at 14 hours unless 
you have access to a better estimate. 

Milk true protein 
content 

The percentage of crude protein in milk that is true protein. 

Animal position 
changes 

The number of times a cow gets up or down during the day. Leave at 10 
unless you have access to a better estimate. 

Milk lactose The lactose content (%) of the milk for your cows. 
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Gross energy in 1 
kg of dry matter 

Enter the gross energy contained in 1 kilogram of dry matter in mega joules. 
Used as part of the cow energy requirement calculation. Set by default to 
18.8 for a diet containing significant quantities of silage. May be set to 18.5 
for diets not containing silage. 

Weight of a litre 
of milk 

The weight of one litre of milk in kilograms. 

Protein demand 
model 

The feeding standard used to calculate metabolisable protein demand can be 
set to AFRC (1993) or Feed into Milk (2004). It is recommended you use the 
later Feed into Milk standard as it better estimates the animal demand. A MP 
requirement correction is not required when the model is set to FiM. For 
more information see below. 

MP demand 
correction 

The animal’s total protein requirement will be multiplied by this value. For 
more information see below. 

DCAD target 
levels 

The DCAD targets for early dry cows (dry off to entering the transition/close-
up herd), ‘transition/close-up cows’ (the transition/close-up period is last 4 
weeks before calving) and lactating cows. 

Traffic light and 
progress bar 
accuracy 

These parameters set the sensitivity of the ‘traffic lights’ for the cow’s energy, 
protein, intake and minerals on the Diet detail tab and the progress bars in 
the Diet tab. The lights will show green if the diet provides an amount of 
energy, protein, dry matter intake or mineral that is within this percentage of 
the cow demand. The exception is the DMI acceptable range, which is 
asymmetric, with the ‘green’ values below the maximum intake x10 the value 
entered. For the default 2% this gives a ‘green’ range of 80-102%. 

 

MP requirement correction 

Rumen8 originally used the AFRC (1993) feeding standard for calculating metabolisable protein 
(MP) demand.  Years after publication, it became clear that AFRC (1993) significantly 
underestimated the requirement for MP in dairy cows. This underestimation has since been 
corrected in the successor to AFRC (1993), known as Feed into Milk (Thomas, 2004). 
To overcome this deficiency of the AFRC (1993) standard, Rumen8 applied a so-called "MP 
demand correction factor" as a pragmatic approach to bring AFRC predictions of MP requirements 
in line with Feed into Milk (2004).  This was achieved by using a correction factor of 1.25.  With the 
introduction in Rumen8 version 3.3.0.0., we now use Feed into Milk (2004) as the default model to 
estimate MP requirements which means there is no need to us the correction factor.  For those 
users who wish to stick to the old AFRC model (not recommended) a value of 1.25 for the "MP 
correction factor" still applies.  
The Feed into Milk (2004) feeding standard results in significantly higher requirements for MP 
than predicted by the AminoCow model but significantly lower than predicted by the CPM-Dairy 
model, two other widely used feeding standards.  The Feed into Milk (2004) standard therefore 
results in a ‘middle of the road' estimate of MP requirements for dairy cows. 
Should experienced users of Rumen8 wish to increase MP requirements further to be in line with 
MP predictions made by CPM-Dairy, the "MP requirement correction" may be increased to a value 
of 1.1-1.15.  However, we caution that this will lead to a significant increase in cost of the diet and 
risks a high rate of nitrogen loss in urine and manure, thus increasing potential loss of nitrogen 
into the wider environment. 
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For growing young stock an MP correction factor will still be required to account for higher 
relative MP demand in young growing heifers. Based on 2015 review by Tedeschi et. al., Rumen8 
uses a polynomial function to calculate a correction factor based on the heifer's live weight. 
Examples are shown in the table below. 
 
Table 4. Correction factors used to determine heifer metabolisable protein demand. 

Live weight (kg) FiM Correction factor AFRC correction factor 

100 1.00 1.00 

200 1.18 1.36 

300 1.30 1.55 

400 1.30 1.62 

500 1.30 1.62 

 

References 
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Thomas C. (2004) Feed into milk: a new applied feeding system for dairy cows. Nottingham 
University Press, UK. 
Tedeschi L.O., Fox D.G., Fonseca M.A., Cavalcanti L.F.L. (2015) Models of protein and amino acid 
requirements for cattle. R. Bras. Zootec., 44(3):109-132. 
  



Rumen8 User Guide 

95 / 247 

 

 

RECOMMENDED LEVELS 
Rumen8 allows the user to set a recommended level range for several important diet parameters. 
These provide quick feedback on the suitability of the current level of a diet measure on the Diet 
and Diet detail tabs with a traffic light. Five sets of Recommended Levels can be defined and 
quickly switched between on the Diet detail tab. These could be used for early, mid, late lactation, 
dry and transition/close-up cow diets for example. 
 

The Recommended levels tab in Preferences showing example ranges for early lactation cows. 

 
 
Select the current Recommended Levels set by clicking on one of the buttons across the top of the 
tab. Describe the use of the set with a short description below. 
For each of the 14 diet measures you can set an acceptable range by moving the minimum and 
maximum sliders left or right. The actual values are displayed to the left of the slider. So, if you 
wish to target NDF levels of 28-30% in early lactation activate the NDF recommended level by 
clicking on the check-box to the left and then move the sliders until that range is displayed. Now a 
traffic light will appear on the Diet and Diet detail tabs that will show you if the diet NDF level is 
below (red), within (green) or above (yellow) your recommended NDF level. Repeat this process 
for each of the diet measures for you wish to display a Recommended Level traffic light. 
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Linking Recommended Levels sets to cow day of lactation 

Each recommended level set has an additional two auto parameters called ‘Day of lactation’ and 
‘Days pregnant’. These can be set to a range of days and turned on or off. For example, the early 
lactation set might have the day of lactation parameter set to days 1 to 60 as shown in the figure 
above. 
If the ‘Day of lactation’ parameter is checked and ‘Recommended Levels set switching’ is set to 
automatic, when the current cow is between 1 to 60 days in milk, the first set of Recommended 
Levels will be activated. When the cow is outside the range 1 to 60 days the Recommended Levels 
will be turned off. 
 
The Diet Detail tab with the Recommended Levels selection control highlighted in red.  

 
 

In the figure above the Active recommended level is set to set one and Rumen8 will switch 
between sets automatically as the button in the bottom right corner is displaying an ‘A’ for 
automatic. The mode can be toggled between automatic and manual by clicking on the button. It 
will display a ‘M’ when in manual mode. The user can also switch to manual mode by simply 
selecting one of the Recommended Levels sets directly by clicking on its round button. 
If no ‘Recommended Levels sets’ in the Preferences have the day of lactation or days pregnant 
parameter turned on (ticked) then the button will not appear in the active Recommended Levels 
section of the animal tab as automatic mode is not available. 
An example of automatic switching between Recommended Levels sets: 
 

1. Define recommended sets for early, mid and late lactation cows as well as dry and 
transition/close-up cows in Preferences.  

2. Set the day of lactation range when each of the sets should be active and ensure each is 
turned on. You might choose early 1-60, mid 61-150, late 151-500 and 0 days of lactation 
for dry and transition/close-up cows. To match the 0 days of lactation condition the milk 
yield must also be 0 as the cow must be dry. 
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3. Set the days pregnant range off for sets one to three (early, mid and late lactation) and on 
for dry and transition/close-up sets. You might choose days 222- 256 for the dry cows and 
transition cows 257-285 days. 

4. Close the Preferences are return to the Diet Detail tab. Click on the button in the bottom 
right of the Active Recommended Levels section until it shows (A)utomatic mode. 

5. Now as the animal's Day of lactation and Days pregnant parameters are changed the 
relevant recommended levels will automatically become active through the cow's lactation 
and dry period. 
 

Note, if none of the sets cover a particular day of lactation then the Recommended Levels set will 
be turned off. 
Recommended level sets can have overlapping day of lactation ranges. In this instance Rumen8 
switches to the set with the lowest number. For example, if set 2 is day of lactation 80 - 120 and 
set 3 is days 100 – 180, for an animal that is at day 110 of lactation set 2 will be selected. 
If both day or lactation and days pregnant ranges are active for a set, the current animal must 
match both to automatically switch the set. 
 

Suggested recommended levels 

Listed below are some suggested ranges for recommended levels for dairy farms in temperate or 
tropical regions. 
 
 These should be considered a starting point in a discussion with a local nutritionist about suitable 
recommendations for your animals and feeds. 
 
Examples of possible recommended levels for temperate dairy regions such as Australia. 

 Early 
lactation 

Mid 
lactation 

Late 
lactation 

Dry Transition 
or Close up 

Levels set 1 2 3 4 5 
Days in milk 1-100 101-200 201-end  of 

lactation 
dry 21 days before 

calving 

NDF (%DM) 32-34 33-36 33-36 36-38 36-38 
peNDF (%DM) 20-24 20-25 23-27 28-31 27-30 
NDF forage (%DM) 18-23 18-23 18-23   

NDF forage (%LW) 0.7-1 0.6 to 1 0.6 to 1 0.5-1 0.5-1 
Sugar (%DM) 6 to 8 6 to 8 5to 6 2 to 4 4 to 6 

Starch (%DM) 18-24** 20-22 18-21 15-18 18-22 
Fat (%DM) 4 to 5 4 to 5 4 to 5 3 to 4 4 to 5 
NFC (%DM) 35-40 33-37 32-35 25-26 25-27 
RDP (%CP) 65-70 68-72 70-74 74-80 64-70 
UDP (%CP) 30-35 26-30 22-27 20-24 24-28 
Forage % in F:C 50-70 50-70 50-70 80-90 70-80 
FE kg ECM/kg DMI 1.5-1.9 1.5-2.0 1.1-1.6   

FE g MS/ kg DMI 85-140 100-150 80-120   

Feed % Income 40-60 50-60 50-60   

** Safe starch levels vary inversely with speed of starch degradability. 
 
Examples of possible recommended levels for tropical dairy regions such as East Africa. 
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 Early 
lactation 

Mid 
lactation 

Late 
lactation 

Dry Transition 
or Close up 

Levels set 1 2 3 4 5 
Days in milk 1-100 101-200 201-end  of 

lactation 
dry 21 days before 

calving 

NDF (%DM) 35-45 40-50 45-55 50-60 45-55 
peNDF (%DM) 21-34 26-40 32-44 35-48 32-44 
NDF forage (%DM) 60-70 65-70 70-75 90-100 85-90 
NDF forage (%LW) 0.7-1 0.6-1 0.6-1 0.5-1 0.5-1 
Sugar (%DM) 3-8 2-8 2-6 2-4 2-5 
Starch (%DM) 10-24 10-22 10-20 0-15 10-20 
Fat (%DM) 2-5 2-5 2-5 2-5 2-5 
NFC (%DM) 30-35 27-32 25-30 15-20 20-25 

RDP (%CP) 65-70 68-72 70-74 75-80 75-80 
UDP (%CP) 30-35 28-32 26-30 20-25 20-25 
Forage % in F:C 40-70 45-70 50-80 80-100 75-85 
Feed % Income 40-60 50-60 50-60   
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STANDARD COWS 
Rumen8 allows the user to quickly change the current cow from the Animal menu. From here you 
can select a cow based on lactation yield (2000 – 10000 litres or kilograms) and stage of lactation 
(early, mid or late). The provided cow definitions are a guide, and they can be modified to better 
suit the animal sizes and performance in your region. 
 
The standard cow editor in the preferences. 

 
 

To adjust a standard cow definition, select the lactation yield at the top of the window and then 
each of the seven parameters for each stage of lactation can be edited. Lactation totals and 
averages are shown in the rightmost column and kilograms of fat + protein and energy corrected 
milk is shown below. 

Restore default values 

To reset the values for a standard cow of a specific lactation yield select the yield in the drop-
down menu at  the top of the window, and then click on the 'Reset' button to the right. All the 
values will be returned to their default values. 
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Standard cow default values 

Lactation 
Period 

Yield 
(l or kg) 

Live weight 
(kg) 

Live weight 
change (kg/d) 

Milk yield 
(l or kg/d) 

Milk fat 
(%) 

Milk protein 
(%) 

Days 
pregnant 

Days 
in milk 

Early 2000 450 -0.4 8.5 4.2 3.2 0 60 
Mid 2000 400 0 6.8 4.3 3.3 70 150 
Late 2000 450 0.39 4.5 4.4 3.4 160 240 
Early 3000 450 -0.4 12.8 4.1 3.2 0 60 
Mid 3000 400 0 10.3 4.2 3.3 70 150 
Late 3000 450 0.39 6.6 4.3 3.4 160 240 
Early 4000 500 -0.5 17 4.1 3.1 0 60 
Mid 4000 450 0 13.6 4.2 3.2 70 150 
Late 4000 500 0.49 8.9 4.3 3.3 160 240 
Early 5000 500 -0.6 20.9 4 3.1 0 60 
Mid 5000 450 0 17.1 4.1 3.2 70 150 
Late 5000 500 0.58 11.4 4.2 3.3 160 240 
Early 6000 550 -0.6 24 4 3 0 60 
Mid 6000 495 0 20 4.1 3.1 70 150 
Late 6000 550 0.58 15.2 4.2 3.2 160 240 
Early 7000 600 -0.6 28 3.9 3 0 60 
Mid 7000 540 0 23.3 4 3.1 70 150 
Late 7000 600 0.58 17.8 4.1 3.2 160 240 
Early 8000 600 -0.7 32 3.8 3 0 60 
Mid 8000 540 0 26.7 4 3 70 150 
Late 8000 600 0.67 20.3 4.1 3.1 160 240 
Early 9000 650 -0.7 36.1 3.8 2.9 0 60 
Mid 9000 585 0 30 3.9 3 70 150 
Late 9000 650 0.67 22.8 4 3.1 160 240 
Early 10000 700 -0.8 40.1 3.7 2.9 0 60 
Mid 10000 630 0 33.3 3.8 3 70 150 
Late 10000 700 0.77 25.3 4 3 160 240 
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USING RUMEN8 WITH BEEF CATTLE 
Rumen8 can be used to create diets for beef or dairy cattle. To begin working on a diet for beef 
animals select 'Beef' from the File menu if it is not already ticked. Rumen8 will change to beef 
mode. 
 
Beef mode is selected in the File menu. 

 
 
 
The equations that allow Rumen8 to predict energy and protein supply from the diet and demand 
by the animal are all from published feeding standards. When creating diets for beef animals these 
are primarily from the Australian CSIRO 2007 publication 'Nutrient Requirements of Domesticated 
Ruminants'. The full reference for this publication can be found at the end of this document, along 
with others that are used for estimating mineral demand, feed intake and methane production for 
example. 
Dairy breeds are included in beef mode to allow the user to create a beef x dairy cross. However, 
if only dairy breeds are used in beef mode Rumen8 will warn the user that they should use dairy 
mode as the performance predictions are likely to be more accurate. 
 
The primary feeding standard used by Rumen8 in beef mode 
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QUICK START GUIDE FOR BEEF 
Rumen8 can be used in Compact or Standard mode. If this is the first time you have installed 
Rumen8, it will start in Compact mode which reduces the window down to the essentials. 
Standard mode provides access to all the functions Rumen8 provides. Compact mode is 
recommended for learning how to use Rumen8, and for many users, will be sufficient. 
Switching between modes can be done in the File menu. 
 
Use the File menu to switch between Standard and Compact modes. 

 
 

If you are unsure what something within Rumen8 is, hover your mouse over it and for most 
objects a tool tip will appear providing a more detailed explanation. 
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USING RUMEN8 IN COMPACT MODE 
The main Rumen8 window when in compact mode is shown below. The Diet Ingredients section 
(1) is where you specify the animal diet. The tabbed section (2) is where you can provide the 
animal details, evaluate the current diet, adjust feed costs and sale income. The summary section 
at the bottom left (3) reports feed costs, income and margin. 
 
The sections of the main Rumen8 window in compact mode. Diet ingredients (1), detail tabs (2) 
and income and cost summary (3). 
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DESCRIBE A COW 
Click on the ‘Beef’ animal tab to show the animal description. Type a number in the entry box or 
use the up/down arrows to change the parameters of the animal you wish to feed, or the average 
animal that represents your herd or sub-herd. For this example, choose 'Steer' from the drop-
down menu in the top left of the tab. To the right of the tab you can select the breed of the steer. 
Set this to 'Angus' for this example as shown in the figure below. 
You can adjust live weight, growth rate, age, expected carcase dressing percentage and live weight 
at sale in the entry boxes below. You can ignore milk yield and components, days since calving and 
days in calf as they are not relevant for a steer. You may also adjust the activity level of the steer 
with the distance walked slider and choose if you have a flat, undulating or steeply hilly farm. 
Leave the dry matter intake (DMI) estimation method set to 'Young stock' for the time being. 
 

To quickly overwrite a value in the entry box, double-click on it. The current value will be 
selected and then type in the new value to replace it. 

 
The Beef animal tab. 
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ENTER A DIET 
Ten ingredients can be added to a diet using the drop-down lists on the left of the window. Click 
on ingredient 1 and select ‘Barley grain’ as the first feed in the diet. To quickly jump down the list 
quickly type the first letter of the ingredient you wish to find. 
 

Selecting a feed in the first diet component menu. 

 
 
Select ‘Barley straw’ for ingredient 2 and the diet should now look like the figure below. 
 

Two ingredients in the diet. 

 
 

Now let’s feed our steer. Enter the amount of each ingredient fed to the cow using the ‘DM’ entry 
box to the right of their name. Enter 5 kilograms of barley grain and 2 kilograms of barley straw. 
Click on the 'Diet' tab and the window should now look like the figure below. Notice that while you 
have entered the amount fed as kilograms of dry matter Rumen8 automatically shows you the 
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amount as fed (including water) in the column to the right. You can adjust the amount with either 
dry or as fed quantities. 
 

Feeding our cow. 
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EVALUATE A DIET 
The ‘Diet’ tab shows six of the parameters you need to consider when formulating a diet for beef 
animals. For this example, we will consider the first three. With the current diet, we can see there 
is insufficient metabolisable energy (ME 89%) and plenty of protein (MP 119%) for the steer we 
described earlier. However, the steers’ dry matter intake progress bar shows it is only 74% of its 
potential so this means it can physically eat more food if it is presented. 
Increase the amount of barley straw to 4.3 kg. Now you will see the ME is at 100% of the steers' 
requirement and intake potential is still below 100% so this amount of feed can be eaten. Your 
screen should look like the figure below. 
 

A diet balanced for energy and with excess protein. 

 
 

This brings us to a very important point that is true of all nutrition models. The application tells us 
we have a diet that meets the ME, MP and intake requirements of our steer, but a nutritionist is 
unlikely to recommend this diet. The starch content is quite high and we are wasting protein as it 
is being feed in excess of what the steer needs. This is before we consider the cost of this diet. 
 

Rumen8 is a tool that will assist someone with nutritional knowledge to better and more 
cost effectively feed their animals, but in the hands of someone without that knowledge it 
can create diets that appear balanced but may decrease cow performance or adversely 
affect their health.  
We recommend Rumen8 is used with your nutritionist. Depending on your level of 
knowledge it can be used to adjust diets between visits by them. 

 

This diet is now balanced for energy and the steer should be able to physically eat the feed when 
it is presented. This demonstrates the start of the process when designing a diet for your animals, 
and you can now further refine the diet by looking at other important parameters such as starch, 
fibre (NDF) and minerals. 
The remaining tab allows you to change sale income payment and the cost of the feeds in the 
current diet. With feed costs and sale prices Rumen8 can show you diet costs and margins to 
better compare alternatives. 
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DIET MARGIN 
Click on the Cost/Price tab. On this tab the top section allows you to enter the feed costs for each 
ingredient of the diet (1). In the bottom section you can enter the price you are expecting to be 
paid for the steer at sale (2). Enter the prices for the barley grain and straw on a dry matter basis 
as $200 and $110 respectively so your values should be the same as in the figure below. You will 
see the feed costs on an as fed basis are calculated based on the dry matter content of the feed. 
 

Feed costs and milk payment price can be entered on the second tab called Cost/Price. 

 
 

At the bottom of the tab you can enter the expected price per kilogram of live weight for the steer 
at sale (2). Leave the Payment by option to Liveweight, but if you changed it to ‘Carcase weight’  
you could enter a price based on the carcase weight based on the dressing percentage on the 
'Beef' animal tab. 
Once Rumen8 has a cost for the feeds and a live weight it can calculate a margin in the bottom left 
Summary section (3). In this example the steer is eating $1.47 of feed each day and gaining a 
potential $2.45 worth of live weight giving a margin of $0.98 per day. This provides a simple way 
to compare the financial performance of different diets even when they influence live weight gain. 
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USING RUMEN8 IN STANDARD MODE 
The main Rumen8 window when in standard mode is shown below. If you are currently in 
Compact mode you can change to Standard mode via the FIle menu. 
The Diet Ingredients section (1) is where you specify the animal diet. The tabbed section (2) is 
where you can specify the animal details, evaluate the current diet, adjust feed costs and 
expected sale income, compare alternative diets and keep notes. The costs and efficiency strip at 
the bottom (3) reports feed costs, income, feed efficiency and margin. 
 
The sections of the main Rumen8 window. Diet ingredients (1), detail tabs (2) and diet costs and 
efficiencies (3). 
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DESCRIBE A COW 
Click on the ‘Beef’ tab to edit the animal details. Using the entry sliders or typing a number in the 
entry box describe the animal you wish to feed, or the average animal that represents your herd 
or sub-herd. For this example choose 'Steer' from the drop-down menu in the top left of the tab. 
To the right of the tab you can select the breed of the steer. Set this to 'Angus' for this example as 
shown in the figure below. 
You can adjust live weight, growth rate, age, expected carcase dressing percentage and live weight 
at sale in the entry boxes below. You can ignore milk yield and components, days since calving and 
days in calf as they are not relevant for a steer. You may also adjust the activity level of the steer 
with the distance walked slider and choose if you have a flat, undulating or steeply hilly farm. 
Leave the dry matter intake (DMI) estimation method set to 'Young stock' for the time being. 
 

To quickly overwrite a value in the entry box, double-click on it. The current value will be 
selected and then type in the new value to replace it. 

 
The Beef animal tab. 

 
 

Now click on the ‘Diet’ tab to the right of the ‘Dairy’ tab to view how well our diet will feed the 
cow. It doesn’t show anything as we have not added any ingredients to the diet yet. 
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The Diet tab. 
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ENTER A DIET 
Fifteen ingredients can be added to a diet using the drop-down lists on the left of the window. 
Click on ingredient 1 and select ‘Barley grain’ as our first feed in the diet. To quickly jump down 
the list quickly type the first letter of the ingredient you wish to find. 
 
Selecting a feed in the first diet component menu. 

 
 
Select ‘Barley straw’ for ingredient 2 and the diet should now look like the figure below. 
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Two ingredients in the diet. 

 
 
Now let’s feed our steer. Enter the amount of each ingredient fed to the cow using the ‘DM’ entry 
box to the right of their name. Enter 5 kilograms of barley grain and 2 kilograms of barley straw. 
Click on the 'Diet' tab and the window should now look like the figure below. Notice that while you 
have entered the amount fed as kilograms of dry matter Rumen8 automatically shows you the 
amount as fed (including water) in the column to the right. You can adjust the amount with either 
dry or as fed quantities. 
 
Feeding our cow. 
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EVALUATE A DIET 
The ‘Diet’ tab shows eleven of the parameters you need to consider when formulating a diet for 
dairy cows. For this example, we will consider the first three. With the current diet, we can see 
there is insufficient metabolisable energy (ME 89%) and plenty of protein (MP 119%) for the steer 
we described earlier. However, the steers’ dry matter intake progress shows it is only 74% of its 
potential so this means it can physically eat more food if it is presented. 
Increase the amount of barley straw to 4.3 kg. Now you will see the ME is at 100% of the steers' 
requirement and intake potential is still below 100% so this amount of feed can be eaten. Your 
screen should look like the figure below. 
 

A diet balanced for energy with excess protein. 

 
 

This brings us to a very important point that is true of all nutrition models. The application tells us 
we have a diet that meets the ME, MP and intake requirements of our steer, but a nutritionist is 
unlikely to recommend this diet. The starch content is quite high and we are wasting protein as it 
is being feed in excess of what the steer needs. This is before we consider the cost of this diet. 
 

Rumen8 is a tool that will assist someone with nutritional knowledge to better and more 
cost effectively feed their animals, but in the hands of someone without that knowledge it 
can create diets that appear balanced on paper but may decrease animal performance or 
adversely affect their health. 
We recommend Rumen8 is used with your nutritionist. Depending on your level of 
knowledge it can be used to adjust diets between visits by them. 

 

This diet is now balanced for energy and the steer should be able to physically eat the feed when 
it is presented. This demonstrates the start of the process when designing a diet for your animals, 
and you can now further refine the diet by looking at other important parameters such as starch, 
fibre (NDF ) and minerals. Additional information about the current diet is presented in the ‘Diet 
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detail’ tab to the right. 
The remaining tabs allow you to change sale income (‘Price’ tab) and the cost of the feeds in the 
current diet (‘Feed cost’ tab). With feed costs and expected income Rumen8 can show you diet 
costs and margins to better compare alternatives. Use the ‘Compare’ tab to save and compare 
related diets before choosing the best one. The ‘Notes’ tab allows you to keep a description of the 
diet for reference in the future. How to use these functions is detailed in ‘Using Rumen8’ section 
of this guide. 

DIET MARGIN 
Click on the Feed cost tab. This tab allows you to enter the feed costs for each ingredient of the 
diet. Enter the prices for the barley grain and straw on a dry matter basis as $200 and $110 
respectively so your values should be the same as in the figure below. You will see the feed costs 
on an as fed basis are calculated based on the dry matter content of the feed. You will see the 
Feed costs section in the bottom left of the window show several different ways to evaluate the 
cost of this diet. 
 

Feed costs can be entered on the tab called Feed cost. 

 
 

Now click on the tab called Price. Here you can enter the price you are expecting to be paid for the 
steer at sale. Leave the Payment by option to Live weight, but if you changed it to ‘Carcase weight’ 
you could enter a price based on the carcase weight based on the dressing percentage on the 
'Beef' animal tab. Set the top sale price (1) to $3.50 per kilogram of live weight. The sale weight 
has been copied over from the value entered on the Beef tab, but you can adjust it here if 
necessary.  
The additional 4 sale prices are linked to the live weight calculator (2). You can read more about 
that in the 'Using Rumen8 for Beef' section of the guide that covers the Beef tab. For now just 
ignore it, so your screen should look like the one below. 
 
The price received for animals at sale are entered on the Price tab. 
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Once Rumen8 has a cost for the feeds and a live weight it can calculate a margin in the bottom left 
Summary section. In this example the steer is eating $1.47 of feed each day (3) and gaining a 
potential $2.45 (4) worth of live weight giving a margin of $0.98 per day (5). This provides a simple 
way to compare the financial performance of different diets even when they influence live weight 
gain. 
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THE PROBLEM OF MEASURING PASTURE INTAKE 
It all sounds simple, choose the ingredients your animals are being fed, enter the quantities you 
provide and balance the diet. Easy, but what about grazed pasture? Accurately measuring how 
much grazed pasture an animal eats is very expensive and time consuming so may not be done on 
farm. To solve this problem, we ‘back calculate’ how much pasture the animals are predicted to 
eat by subtraction of all the feed ingredients you do know. It is easier than it sounds. 

1. Enter the values that describe the average animal in your herd on the ‘Beef’ tab. Rumen8 
will calculate the metabolisable energy needed for the animal and this is displayed on the 
‘Diet’ and ‘Diet detail’ tabs. 

2. Add all the supplementary feed provided to the animal using the ingredients drop-down 
lists. This includes grain fed in the shed or PMR/TMRs and forages in the paddock. 
Everything except grazed pasture. 

3. Rumen8 now calculates the metabolisable energy provided by the supplements and the 
difference between this and the animal’s requirement must be supplied by grazed 
pasture. This is shown on the ‘Diet detail’ tab as the ‘Balance’ under the ‘Metabolisable 
energy’ section and the remaining percentage of the metabolisable energy bar on the 
‘Diet’ tab. 

4. Select a suitable pasture for your farm and time of year as the next diet ingredient. 
Increase the quantity of this until the metabolisable energy provided by the diet is the 
same as the requirement of the animal. 

You now have the diet that reflects the current situation with an estimate of the amount of 
pasture each animal is eating. With this information you can explore alternative diets that include 
pasture assuming you maintain the amount of pasture on offer for the herd in the future. 
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RUMEN8 WARNINGS 
Rumen8 will sometimes display a red exclamation mark to draw your attention to something that 
may be wrong with a diet or parameter value you have entered. For example, if the days since 
calving and days in calf values result in the cow getting back in calf within 40 days after calving a 
red exclamation mark appears next to the entry boxes for these parameters suggesting you should 
double check the values. 
In the previous examples you can see a red exclamation mark alongside the ingredient barley 
grain. This means the quantity of barley in the diet exceeds the recommended maximum. If you 
hover your mouse over the exclamation mark a tool tip will appear giving you more details about 
the issue. 
 

! When you see a red exclamation mark mouse over it and the tool tip will tell you what is 

wrong. 
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MENU COMMANDS FOR BEEF 
The menu is along the top of the main window and has five choices, File, Edit, Animal, View and 
Help. 
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File menu 

The File menu. 
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New 

Start a new diet. The current diet will be cleared, the animal will revert to the 
default, diets stored in the Compare tab will be cleared, split herds cleared and 
any notes erased. If the current diet has not be saved you will be prompted to 
do this before the diet is cleared. 

Open 

Allows you to load a previously saved diet. A warning will appear if the milk 
price or dry matter intake parameters have changed since the diet was saved. 
These warnings can be disabled in the Preferences. You can also import diet 
files from version 2 of Rumen8 by selecting the file type ‘Rumen8 v2 files (*.csv) 
in the Open dialog box. 

Open Recent 

The sub-menu shows a list of the previous 5 diet files to be opened. To re-open 
one of these select it from the list. To remove all the previous diet files from the 
list select the Clear option at the bottom of the sub-menu. 

Save 
Save the current diet. This is only available if the diet has been previously 
named and saved using the ‘Save As’ menu. 

Save As 
Name and then save the current diet. If changes to the current diet have not 
been saved an * will appear next to the diet name in the title bar. 

Reload feeds 

This updates all the feed data from the feed library. This is useful if you have 
multiple instances of Rumen8 running and have made a change to a feed in one 
of them and wish to quickly update the others. 

Reports 
Opens the report designer that creates diet reports for printing or to be saved 
as a PDF document. 

Preferences 
Opens the Preferences allowing you to change Rumen8 settings. A more 
detailed explanation is given in the Preferences section. 

Standard Mode When ticked all of Rumen8’s functions are available. 

Compact Mode 
When ticked the Rumen8 window is reduced to the essentials required to 
balance a diet based on energy, protein, fibre and starch. 

Dairy When ticked Rumen8 is in dairy mode. Select to switch to dairy mode. 

Beef When ticked Rumen8 is in beef mode. Select to switch to beef mode. 

Exit Close Rumen8. You will be prompted to save an unsaved diet. 
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EDIT MENU 
The Edit menu. 
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Edit Feeds 

Opens the Feed Editor to change feeds and mixes and the ingredients 
available in the ingredient drop-down lists. A more detailed explanation is 
given in the Feed Editor section. 

Copy Diet 
Copy the current diet to the clipboard for later pasting into Excel or Word 
for example. 

Copy All Diets Copy the current diet and the three stored diets to the clipboard. 

Clear Current Diet Removes all the ingredients from the diet. 

Create Mix From Diet 

Opens a window that allows a new mix to be created from the current diet 
feeds (not mixes). Each ingredient can be removed from the mix by 
unticking the box to the left of the feed name. Each feed displays the 
quantity in the new mix on a dry matter and as fed basis, and the 
percentage of the mix it makes up. 
To the right of the ingredient list you can select if the mix percentages are 
based on dry or as fed quantities and check the total mix dry matter content 
and number of ingredients. 
Below are the normal mix parameters like those in the Feed Editor mix tab. 
The mix must have a unique name among existing feeds and mixes. The 
heading ‘Name’ will turn red if this is not the case and you will be unable to 
click on the ‘Okay’ button to create the mix. 
Once you are happy with the mix definition, have given it a unique name 
and provided as many of the optional parameters as you wish, click on the 
‘Okay’ button to save it to the current feed library. 

Feed Library 
If multiple feed libraries have been created in the Feed Editor they can be 
selected by name using this sub-menu. 

Preferences Library 

If multiple Preferences libraries have been created in the Preferences they 
can be selected by name using this sub-menu. This option is not available in 
Compact mode. 

Prices Library 

If multiple Prices libraries have been created on the Price tab they can be 
selected by name using this sub-menu. This option is not available in 
Compact mode. 

All Libraries 

If a feed, preferences and prices library are given the same name they are 
referred to as a library set and will appear in this sub-menu. Selecting one of 
these library sets will change all three libraries at once. This option is not 
available in Compact mode. 
This is useful if you are using Rumen8 in different countries. For example, if 
you are based in Kenya but also consult in Uganda you can create feed, 
preferences and prices libraries specific to Kenya and give them all the same 
name, such as 'Kenya'. Also create three additional libraries specific to 
Uganda and make sure they are all called 'Uganda'. Now under the 'All 
Libraries' sub-menu you can select Kenya or Uganda and quickly switch 
between library sets. 
Library sets must contain all three library types and have exactly the same 
name before they will appear in the 'All Libraries' menu. 
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The mix creation tool available from the Edit menu. 
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ANIMAL MENU 
The Animal menu. 

 
 

Save current animal as 
the default 

Save the current animal as the default that will be loaded each time 
Rumen8 starts. 

Reload default animal Replace the current animal with the default animal. 
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VIEW MENU 
The View menu. 

 
 

Energy detail 
Displays the details of the metabolisable energy demand calculated for the 
animal. 

Protein detail 
Displays the details of the metabolisable protein supply and demand 
calculated for the animal. 

Minerals detail 
Displays the details of the calcium, phosphorus and magnesium demand and 
supply. 

Ingredient detail 
Displays the attributes of a of diet ingredient. The sub-menu allows you to 
choose from ingredient 1 to 15. 
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HELP MENU 
The Help menu. 

 
 

Help Opens a context sensitive version of this document. 

Introduction 
to Rumen8 

Starts an introductory tutorial that explains the basics of creating a diet in 
Rumen8. 

FAQ Opens the default browser and displays the FAQ page on the Rumen8 website. 

About 

Display information about Rumen8 such as the version number, website address 
and email for support. You can also access the Acknowledgements, End user 
license agreement and a list of references of publications used to create Rumen8. 

Registration Enter your registration number and name here to unlock all the diet ingredients. 

What’s new Lists all the changes to each version of Rumen8. 

Check for 
updates 

Check to see if a newer version of Rumen8 is available. This can only be done if 
your computer is connected to the Internet. 
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USING RUMEN8 FOR BEEF 
This section will describe the main parts of the Rumen8 window and how you use them. 
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DIET INGREDIENTS 
The left section of the main window is where you add ingredients to your diet and specify the 
quantity fed each day. In the figure below it is highlighted within a blue rectangle. 
 
The diet ingredients section of the main window shown within the blue rectangle. 

 
 

Clicking on the down arrowhead on the right side of the drop-down lists allows you to choose any 
of the feeds available from the feed library. 
 

If you want an ingredient further down the list type the first letter of its name on the 
keyboard to jump to the first ingredient starting with that letter. 

 
Once a feed has been selected the ‘DM’ and ‘As-fed’ entry boxes become active and you can 
either type the kilograms to be fed in directly or click on the up and down buttons to vary the 
existing amount. 
You can enter the value on a dry matter basis in the ‘DM’ column and the amount will be 
displayed on an as-fed basis in the ‘As-fed’ entry box. If you prefer to enter the amount as-fed the 
reverse works in the same manner. Internally Rumen8 always uses the value on a dry matter basis. 
Up to fifteen feeds or mixes can be added to a diet. To see the details of a selected ingredient, 
right-click on the ingredient number and the detail window will open. Alternatively hover the 
mouse over ingredient name and a tool tip will appear showing the feed or mix attributes. 
The total diet weight on a dry matter basis and as fed are displayed at the bottom of each of the 
columns. To the left the dry matter content of the diet is displayed. 
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The diet ingredient tool tip window displays the parameters for that fed or mix. 

 
 

 

The diet ingredient detail window displays all the parameters for an ingredient. The window can 
remain open while the diet is created and you can quickly switch between ingredients using the 
drop down menu displaying the feed names at the top (1) or the ingredient numbers at the 
bottom (4). The Other names button at the top right (2) opens a window where you can see the 
other names for a feed. One of the feed parameters is a comment that can be entered by the 
user. If this comment contains a internet web address it will appear blue (3). It can be clicked on to 
open the default browser and display the page at that address. In the example below the link will 
open the Feedipedia page for the feed providing more information that may be useful for the 
user. As the external links are beyond the control of RUmen8, ensure they are for a safe website 
address before clicking on them. 
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The diet ingredient detail window. 

 
 

 

As feeds are added or quantities are adjusted Rumen8 recalculates energy, protein and nutrient 
supply relative to demand showing how well your diet is meeting production requirements. 
 

To quickly remove an ingredient from the diet, hold down the Shift key on the keyboard and 
right click on the ingredient number. To clear all the ingredients from the diet, select ‘Clear 
current diet’ from the Edit menu. 
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Moving ingredients in the diet 

Ingredients can be dragged and dropped between the 15 feed locations to swap their positions. 
Amount fed is also swapped with the ingredients. To move ingredient 3 to position 8 left click and 
hold on the number 3 to the left of the ingredient name. The mouse pointer will change to show a 
small rectangle below the pointer. Still holding down the mouse button down move the pointer 
over the ingredient 8’s name or number and release. The ingredients and their amounts fed will 
now be swapped. You can only drop an ingredient over the ingredient name or number, anywhere 
else will display a no entry symbol. 
 
Step 1: Starting to drag Barley grain in position 1 to position 8. 
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Step 2: Drop the Barley grain over the ingredient position you want it to occupy by releasing the 
mouse click. 

 
 
Step 3: After the drag and drop the Barley grain and Ryegrass have swapped ingredient positions. 
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ANIMAL 
The Beef animal tab is the first of the tabbed section of the main window and is used to describe 
the beef cow, or the cow that represents the herd average, for the diet that we are creating. 
 

The Beef animal tab highlighted within the red rectangle. 

 
 

Using the sliders adjust live weight, growth rate, milk yield and components, days pregnant and 
days in milk. The value can be changed quickly by moving the slider left and right or adjusted 1 
unit at a time by clicking on the – and + symbols at either end. To quickly overwrite a value in the 
entry box double click on it. The current value will be selected and then type in the new value to 
replace it. 
Days in calf and days since calving can also be set by specifying the date of conception or calving 

by clicking on the calendar icon  . 
Additional parameters let you adjust the activity level of your animals if you have a large or hilly 
farm. Note that a grazing animal will typically walk 4-5 km over a day in the paddock. 

Animal type 

Select the animal type in the drop-down menu at the top left of the tab. The choices are unmated 
heifer, mated heifer, steer, beef cow, dual purpose cow and bull. Dual purpose cows are a 
crossbred cow of a dairy breed x beef breed where milk is harvested for human consumption. 
Dual purpose cows are typically managed less intensively than lactating dairy cows and are lower-
yielding. Often a calf is suckled in addition to mechanical/hand milking. A milk price on the Price 
tab can be entered and milk income values are shown in the economics and efficiencies values at 
the bottom of the main window. The milk income along with growth rate can contribute towards 
the margin calculation. 
If the dual purpose cow is only being used for milk sale and will not be sold at the end of the 
lactation on the Prices tab set the sale price per kilogram to zero so her growth rate does not 
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contribute to income. 
Dairy breeds are included so beef dairy crosses can be used. If the breeds are set to only dairy 
Rumen8 will warn the user dairy mode is more suitable for the animal. Also use Dairy mode when 
a dual purpose cow such as Sahiwal or Simmental is managed as a dairy cow. 
The first time an animal type is selected the parameters on the Beef tab will be set to standard 
values. After you modify these values to suit your herd and farm, if you switch to another animal 
type and then return, your modified values will be retained. 

Breed 

Select the breed from the drop-down list. Up to three breeds can be specified to define a cross 
breed animal. To add a second or third breed click on the + button to the right of the breed menu. 
To remove the second or third breed click on the - button. 
To define a cross breed animal you must enter the percentage of each breed in the entry box to 
the right of the breed name. Right click on the entry box to use a menu to quickly enter commonly 
used fractions. Select 'Remainder' from the menu to set the current breed percentage to the 
amount required to bring the breed total to 100% and complete the breed definition for the 
animal. 
If you hover over the 'Breed' heading the standard birth and reference weights of the animal is 
shown in a tool tip. Hovering over each pure breed type in the drop-down menus displays their 
standard birth and reference weights in a tool tip. 
Some dairy breeds are included to allow dairy x beef crosses (dual purpose cows). If you wish to 
create a diet for a pure dairy breed or dairy x dairy cross switch to Rumen8 dairy mode in the File 
menu as in this mode the animal model is specific to dairy animals. 
 
Right click on the input box to use the breed percentage menu to quickly define a cross breed 
animal. 
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The Breed tool tip displaying the standard birth and reference weight for the animal. 

 
 

Live weight 

Mean live weight (kg) of the herd at the time of interest. Cows that are weighed on farm are the 
best guide, but if cow live weight is unknown, use the standard reference weight as a guide. Hover 
your mouse over the 'Breed' heading to see the standard reference weight of the animal in the 
tool tip. 
 

Live weight change 

This is the estimate of the amount of live weight that is being lost or gained across the herd 
(kg/cow/day).  
 

Clicking on the calculate button  alongside the live weight change value will open a window that 
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assists in estimating the rate of live weight change for your animal. 
 

The live weight change calculator. 

 
 
To estimate live weight change for the current animal, first provide a known or estimated weight. 
In the figure above the steer was weighed on the 1st of January and was 300 kg (1). You can 
quickly set the date to today's date by clicking on the 'Today' button. The 'Current' button will set 
the live weight to the value previously entered on the animal tab. 
Now you can enter four possible sale dates in the bottom half of the calculator. Once a target sale 
weight is entered the calculator will show the number of days from the weigh date until the sale 
date and the rate of live weight change required to meet the target sale weight. Select the sale 
date number that results in the LWC value you think is most likely to be achieved and click the 
'Okay' button to return to the main window. The LWC value will be updated on the animal tab. 
Click the 'Cancel' button to return to the main window without changing the LWC value. 
If you know what rate of LWC you can achieve change the 'Calculate' button at the top of the 
calculator to 'Sale date' (3). Now you can enter values for LWC and target weight and the sale date 
will be calculated. 

Days in calf 

Affects nutritional requirements, which becomes significant from day 140 onwards. Days in calf 
should be the weighted average of the herd (see below example of Days since calving). The 
number of days since conception can be entered directly with the slider or click on the calendar 
icon to select the date of conception. 

Days since calving 

Days since calving is required to estimate milk yield if 'Milk' is set to automatic. 
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Days in calf must be calculated as a weighted average for the herd. For example 

100 cows @ 100 DSC 10,000 cow days 

200 cows @ 280 DSC 56,000 cow days 

30 cows @ 350 DSC 10,500 cow days 

330 cows 76,500 cow days 

Weighted herd average = 76,500 cow days / 330 cows = ~230 DSC 
The number of days since calving can be entered directly with the slider or click on the calendar 
icon to select the (mean) calving date. 
Alternatively, separate diets can be calculated in Rumen8 for each calving group in the above 
example. 

Number of cows in the herd 

This is used only to calculate the herd margin (daily milk income minus daily feed costs in 
$/herd/day) and can be left set to 1 if you are more interested in daily milk income minus daily 
feed costs per cow/day. 

Milk 

Milk yield for cows can be set to Automatic, Entered or None. 
Automatic provides an estimated milk yield based on a standard lactation for a beef cow (NRC 
2016). The yield is based on days since calving and live weight of the cow relative to the standard 
reference weight of the breed. This provides the yield, fat and protein values shown below the 
selection buttons. 
Entered allows the user to provide litres or kilograms/cow/day – the last 5-10 days average milk 
yield per cow. Milk yield should include all milk produced per cow, including milk that is being fed 
to calves, milk sold for dual use cows, and any disposed of. You must also enter the fat and protein 
content of the milk. Ensure you set the correct unit in the Rumen8 Preferences. In Australia this is 
almost always mv% (mass/volume, grams per litre), while in New Zealand it is mm% (mass/mass, 
grams per kilogram). Protein% as used in Rumen8 is true protein (in some countries milk protein is 
analysed as crude protein which is about 6% higher than true protein). If you know the yield but 
not the components, set them to 4% fat and 3% protein. 
None sets the milk yield to 0 for cows that have been dried off. 

Age 

Provide an age estimate for the animal in years. This is used in calculating energy and protein 
demand and selection of the dry matter intake estimation methods. 

Carcase dressing 

Enter the expected dressing percentage of the animal when sold for meat. The dressing 
percentage is carcase weight / live weight at sale x 100. This value is used to calculate income at 
sale if you are paid on carcase weight. 

Live weight at sale 

Enter the expected live weight of the animal at sale. This is used on the Price tab to calculate 
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income. 

Penned 

Leave this un-ticked if the animal has access to grazing. If the animal is restricted within a pen and 
is fed tick this box. This is used as part of the dry matter intake estimation. Selecting Penned will 
also reduce the distance the animal walks ina day to 500m. You can still adjust this value manually 
if needed. 

Hormone growth promotant 

Leave this un-ticked if the animal does not have a HGP implant. If ticked the presence of a HGP will 
affect dry matter intake estimation. 

Dry matter intake estimation method 

Here you can set how to estimate the maximum dry matter intake for the cow. Six methods are 
provided as no one option is robust enough to cover all beef animals and conditions. 
As explained in NRC (2016): “… there are no reasons to pick a favoured equation. Users are 
encouraged to assess the various equations in their own production settings to determine which 
equation(s) might provide a consistently superior fit to observed intake data”. 
Young stock is used for growing/finishing yearlings and is based on equation 10.1 from the NRC 
2016 feeding standard. 
General NRC is a general equation suitable for all beef cattle and is based on equation 10.2 from 
the NRC 2016 feeding standard. 
Feedlot is suitable for steers or heifers under feedlot conditions (penned) with a diet ME content 
>= 12.5 MJ/kg DM. It is based on equation 10.4 from the NRC 2016 feeding standard 
Cow is suitable for all beef cows and dual purpose cows and is based on equation 10.5 from the 
NRC 2016 feeding standard. 
General AFRC is a general equation suitable for all beef animals and is based on equation 164 and 
165 from the AFRC 1993 feeding standard. 
NDF intake estimates the animal's predicted intake based on the amount of NDF eaten as a 
percentage of the it's live weight. The percentage of live weight for cows and young stock or bulls 
can be changed in the Preferences. An additional allowance for milk yield is added to the NDF 
estimate for lactating cows and is based on the NRC 2016 feeding standard. 
NOTE: The NDF intake method was developed for lactating dairy cows fed lucerne+maize based 
diets, covering a limited range of dietary fibre (30-40% NDF; 20-30% peNDF). 
The method has not been evaluated for predicting feed intake by beef cows (NRC 2016) nor any 
other class of beef cattle, especially not for low-NDF feedlot diets or high-NDF roughages. 
We urge caution when using this method and encourage you to observe your animals 
performance carefully to evaluate the intake prediction method for yourself under the conditions 
on your farm. 

Farm terrain 

This influences the amount of energy required for maintenance. Note that walking 1 ‘vertical 
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meter’ requires the same energy as walking 10 ‘horizontal meters’. 

Distance walked 

This influences the amount of energy required for maintenance. For example 

• Cows grazing a large farm (300 ha) can walk while grazing ~5 km. 

• Cows grazing a medium sized farm (150 Ha) can walk while grazing ~4 km. 

• Cows grazing a smaller sized farm (75 Ha) can walk while grazing ~3 km. 

• Cows kept in feedlots will on average walk only a few hundred meters a day. 
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DIET 
The diet tab provides an overview of the current diet performance. It is highlighted within a blue 
rectangle in the figure below. 
 

The Diet tab highlighted within the blue rectangle. 

 
 

The Diet tab has six horizontal bars representing the dry matter intake, metabolisable energy, 
metabolisable protein, calcium, phosphorus and magnesium in the diet. Additionally, the minerals 
sodium, sulphur and potassium are shown as g/kg DMI along with neutral detergent fibre and the 
starch percentage of the diet. 
Metabolisable energy, protein and minerals are expressed as a percentage of the cow’s 
requirement so a balanced diet should have these parameters around 100%. When the cow’s 
requirement is not being met the progress-bar will be red. When the diet meets the cow’s 
requirement the bar will be green. If there is an excess of ME, MP or minerals in the diet the 
corresponding bar will be yellow. 
The intake bar shows the percentage of the animal’s maximum intake the current diet represents. 
When the cow is eating close to potential the bar will be green. If the diet contains too much feed 
for the cow to eat the bar will turn yellow and if the cow is being underfed the bar will be red. 
How close to 100% the progress bars must be to turn green is adjusted in the Preferences. 
The smaller progress bars show how well the animal's calcium, phosphorus and magnesium 
requirements are being met by the current diet. 
The NDF and starch values show the percentage of the diet made up of these components. If 
‘Recommended Levels’ are set for NDF or starch a traffic light will appear and show whether the 
current value is under, within or above the recommended range. See the Preferences section for 
how to set ‘Recommended Levels’. 
For further information about each parameter, hover your mouse over the progress bar and a tool 
tip will appear showing the actual values. For example, the tool tip for the dry matter intake bar in 
the figure above displays ‘Supply 8.6 kg. Maximum intake 8.8kg. Balance -0.2kg’. 



Rumen8 User Guide 

142 / 247 

In the bottom right of the tab a red exclamation mark will appear if a monitored diet parameter 
not shown on this tab is outside the recommended level set in Preferences. See the section on 
Recommended Levels in the Preferences for how to set suitable ranges for important diet 
parameters. 
Warning red exclamation marks may also appear if minimum or maximum levels of a parameter 
are exceeded. For example, in the figure above a sodium warning is show. Hovering the mouse 
pointer over the exclamation mark provides information about the warning in the tool tip. 
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DIET DETAIL 
The ‘Diet Detail’ tab is used in a similar way to the ‘Diet’ tab but contains much more information 
about the diet performance. 
 
The Diet Detail tab shown within the red rectangle. 

 
 

The diet detail tab is divided into several sections covering metabolisable energy, metabolisable 
protein, dry matter intake, fibre, rumen protein, starch, fat, enteric methane production and 
minerals. In addition, the active set of Recommended Levels can be changed in the bottom left 
corner of the tab. 
Alongside the values for sodium a red exclamation mark is visible in the figure above (1). If you 
hover your mouse over these a tool tip will appear giving more information on why these values 
may be an issue. 

Metabolisable energy  

This section shows the total ME supplied by the diet, demand from the animal and the consequent 
balance. Below is the energy density of the diet. 
The ‘traffic light’ to the right is red when ME from the diet is insufficient, green when it meets 
demand and yellow when it exceeds the animal’s needs. Clicking on the title ‘Metabolisable 
Energy’ (or the menu option View, Energy detail) will bring up the detail window that provides 
more information about how ME demand is calculated. The detail window can remain open while 
the diet and animal is adjusted so the influence on components of the total ME demand can be 
seen. 
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The metabolisable energy detail window. 

 
 

Metabolisable protein  

This section shows the total MP supplied by the diet, demand by the cow and the subsequent 
balance. Below is the diet’s crude protein content. Crude protein content of the total diet is only 
provided for reference. The ‘traffic light’ to the right is red when MP from the diet is insufficient, 
green when it meets the requirement and yellow when it exceeds the animal’s needs. Clicking on 
the title ‘Metabolisable protein’ (or the menu option View, Protein detail) will bring up the MP 
supply and demand detail window that provides more information about how metabolisable 
protein supply and demand are calculated by Rumen8. The detail window can remain open while 
the diet and animal is adjusted so the influence on components of the total MP supply and 
demand can be investigated. 
As with the rest of the Rumen8 application, hovering the mouse over each parameter will provide 
additional explanatory information. If you hover over the text ‘MP system flowchart’ on the detail 
window a chart will appear that shows the path protein takes through the animal that 
corresponds to the values Rumen8 calculates when estimating MP supply. 
 

The metabolisable protein detail window. 
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Intake  

The ‘DM intake estimate’ section shows the percentage of maximum predicted intake the current 
intake represents for the six methods of calculating potential available on the animal tab.  
The ‘traffic light’ is red when the diet constitutes less than the animal can eat, green when the 
animal is eating as much as she can, and yellow when the diet exceeds the animal’s ability to eat 
it. The current intake estimate method linked to the traffic light is shown in black text and the 
inactive methods are shown in grey. The sensitivity of the traffic light and parameters used to 
adjust intake estimation can be adjusted in the Preferences. 
Dry matter intake as a percentage of live weight is also provided as an alternative method to 
evaluate the animal’s current intake potential. 

Fibre, rumen protein, starch and fat 

The sections in the top middle and right of the diet detail tab reports a range of diet parameters 
for the current diet. These cover things like NDF, starch and sugar through to rumen degradable 
protein and forage concentrate ratio. If you are unsure what one of the abbreviations means 
hover your mouse over the text and a tool tip will appear with a more detailed explanation. 
If there is too much protein in the diet a warning will appear in the RDP/UDP section. There is a 
metabolic cost to remove excess protein that will reduce live weight gain (2). 
If Recommended Levels have been set for some of these diet parameters a small traffic light 
appears next to the value and shows if it is below, within or above the recommended range. In the 
figure above a small green traffic light can be seen next to the NDF % value showing the NDF 
content of the diet is within the previously set recommended levels in the Rumen8 preferences 
(3). 

Methane 

The amount of methane produced by the animal from the intestines is shown as a total and as 
how much per unit of live weight gain (intensity). Methane (CH4) is a greenhouse gas emitted 
from livestock mainly through enteric fermentation and manure decomposition. Methane 
produced in the intestine (enteric) is a natural by-product of microbial fermentation of nutrients in 
the digestive tract of animals. 

Minerals 

The minerals section on the middle right of the tab shows the amount of sodium, sulphur and 
potassium in the diet. If these are too low or high a warning exclamation mark will appear next to 
them with details in its tool tip. In the figure above you can see a warning for low sodium in the 
diet. 
The bottom right section of the diet detail tab displays supply and demand for the diet’s calcium, 
phosphorus and magnesium levels. A traffic light for each show if the current level is below (red), 
equal to (green) or above (yellow) the animal’s requirement.  
Clicking on any of the titles ‘Calcium’, ‘Phosphorus’ or ‘Magnesium’ (or the menu option View, 
Minerals detail) will bring up the Minerals supply and demand detail window that provides more 
information about the animal demand and diet supply of each of the minerals. The detail window 
can remain open while the diet and cow is adjusted so the influence on mineral supply and 
demand can be investigated by adjusting cow or dietary parameters. 
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The minerals detail window. 

 
 

Discovering why a diet parameter is not displayed 

The feeds that are provided as part of the Rumen8 default feed library have complete information 
so there are no missing parameters. This may not be the case for feeds you create as some 
laboratory analyses may not cover all aspects of the feed. For example, a feed analysis may not 
provide ADF percent and this will prevent Rumen8 from calculating the ADF content of the diet as 
shown in the figure below (1). To find out which diet ingredient is missing the ADF information, 
hover your mouse pointer over the missing value and the tool tip will list the feeds without that 
value. 
 
Discovering which feed is preventing the diet ADF content being calculated (1). 

 
 

Recommended levels 

The section in the bottom middle of the diet detail tab shows which set of Recommended Levels 
has been selected, if any, and allows the user to change between sets (4). In the figure at the start 
of this section set one of the Recommended Levels has been selected and the small traffic light 
adjacent to NDF (%DM) is linked to this (3). See the Preferences section for how to turn on and off 
and adjust the Recommended Levels. Rumen8 can also automatically switch between sets of 
Recommended levels based on the animal’s days since calving and days in calf. 
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PRICE 
The price paid per kilogram of live or carcase weight is used to calculate income and margins of 
income over feed costs. Use the ‘Payment by’ box to select if you wish to enter your prices by live 
or carcase weight. 
You can enter 5 different sale weights and the related prices and switch between them using the 
round buttons down the left of the tab. The first option at the top uses the sale weight from the 
beef animal tab. If payment by carcase weight is selected the total price per head is calculated 
using the dressing percentage for the animal on the beef animal tab. 
The bottom four sale scenarios are numbered 1 to 4 and are linked to the 4 scenarios in the live 
weight change calculator on the beef animal tab that is used to determine the target live weight 
change. When using one of these scenarios ensure the current animals LWC still matches the one 
estimated by the calculator. 
 

The price tab with payment by live weight selected shown within the red rectangle. 

 
 



Rumen8 User Guide 

148 / 247 

The price tab with payment by carcase weight selected. 

 
 

If the animal is a dual purpose cow you will also be able to enter up to four milk prices at the 
bottom left of the tab (1). The income from milk sold (2) is added to the income from live weight 
gain and is used in the margin calculation. If the cow is not to be sold at the end of her lactation 
set the price per kg of live or carcase weight to $0 so only the milk income is used. 
 
The price tab for a dual purpose cow also allows entry of milk prices. 
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Prices libraries 

Multiple libraries of milk prices can be defined and given a name in Rumen8 using the controls in 
the bottom-right side the tab. This allows you to maintain a price library for different properties, 
clients or regions for example. The current price library is named Default in the figure above. 
Switch between price libraries using the drop-down menu. Multiple price libraries are only 
available in Standard mode. 

Add Copy Create a copy of the current library. You will be prompted for the library name. 
Names must be unique. This option is not available in Compact mode. 

Rename Rename the current library. Names must be unique. This option is not available in 
Compact mode. 

Delete Delete the current library. You cannot delete the last library. This option is not 
available in Compact mode. 

Import Import as a new library from a Prices file that has previously been exported or 
created by Rumen8 version 3. This option is not available in Compact mode. 

Export Export the current prices as a library file. This option is not available in Compact 
mode. 
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FEED COST 
The feed cost tab allows you to quickly adjust feed prices and losses for feeds in the current diet 
without returning to the feed library. This is useful for comparing groups of feed sources at 
different prices without having to create a new feed for each. 
 

The feed costs tab shown within the red rectangle. 

 
 

For each of the current diet ingredients you may change the cost on a dry or as-fed basis and the 
losses that occur before the animal eats it. The final cost is expressed on a dry matter basis, and 
then after losses for both dry and as-fed weights. The last two columns show the feed costs per 
MJ of metabolisable energy and per kilogram of crude protein. These parameters are useful for 
identifying the cheapest ingredients to fill an energy or protein deficit in the diet. 
The  values are changed in the feed library so if you are investigating the influence of feed price 
changes don’t forget to put the actual feed cost back when you have finished. 
 

Losses are not applied to the amount of feed eaten by the animal but represent the amount 
of feed lost between when it was costed (usually at delivery or harvest) and when it is eaten. 
This means the losses only influence the feed cost, not the feed amounts. For example, if 
the barley grain costs $250/t DM delivered to the farm and losses are set to 2%, it means 
the loss occurs after the grain was delivered to the silo and before the cow eats it. The actual 
cost per kg of barley grain consumed is now $255 /t DM.  The cow still eats 6.6 kg/day of 
barley grain. The diet ingredient amounts are always the amount the animal eats, regardless 
of losses. 
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COMPARE 
The ‘Compare’ tab allows you to build a diet and then save it for comparison with other diets. 
Think of it as six slots where you can store a diet while you experiment with other feeds in the 
main window and then compare them before recalling the best one.  
 

The compare tab shown within the red rectangle. 

 
 

There is room for six diets numbered 1 to 6 from left to right. To store the current diet, click the ‘S’ 
button (store) for one of the diet slots. The 15 ingredients that make up the diet will appear in the 
slot along with important parameters below. You can make changes to the current diet, store an 
additional five versions, decide which offers the best solution and then recall that one to the main 
window by clicking the ‘R’ button (recall) for that slot. Clicking the ‘C’ button (clear) will clear the 
slot. 
When a diet is recalled, you have the option to also restore the animal parameters to the values 
when the diet was stored. 
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NOTES 
The notes tab allows you to write anything about the current diet you may wish to remember 
when looking at it later. This is often useful if you save diets by date and then refer to them in 
later years for guidance. The notes can also be used to communicate with your nutritionist if you 
save the diet file and email it to them for comment or adjustment. 
 

The notes tab shown within the blue rectangle. 
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OPTIMISE (ADVANCED) 
The Optimise function within Rumen8 is difficult to setup unless you have a good knowledge 
of Microsoft Windows and Excel. It requires Microsoft Excel and the Solver add-in to be 
installed (versions 2010, 2013, 2016 or 2019 or Office365) and configured for use with 
Rumen8. See the Optimiser Installation section for step-by-step instructions. If you use the 
Optimiser regularly it is recommended to use a later version of Excel as the Solver add-in 
optimises diets more successfully than earlier versions. 

 
The Optimise tab and button will only be available if it is enabled in the Rumen8 Preferences. 
Optimising allows you to fine tune a diet to minimise cost. The Optimiser will vary the amount fed 
of each ingredient to find the cheapest diet that meets the constraints you have chosen. Using the 
Optimiser requires all feeds have costs entered in the feed library or the feed costs tab. 
You should first add your feeds to the diet in the approximate quantities required. These amounts 
are used to 'seed' the optimiser and help it find a better diet. For the first run of the Optimiser 
enable the ME and MP constraints to ensure it is possible to calculate a diet from the feeds 
selected that meets the animal's requirements. Once a feasible diet has been found progressively 
add additional constraints in decreasing order of importance starting with your preferred intake 
estimate until you have a diet that meets your needs, or the Optimiser cannot find a feasible 
solution. This step-by-step approach is far more likely to result in an optimised diet than simply 
turning on all the constraints immediately. This is because if a feasible diet cannot be found you 
know it was the last constraint that is the issue, and you can then either exclude that or relax 
constraints until a feasible diet can be found. With many ingredients it may take a few minutes for 
the optimiser to search for a solution. If after 3 minutes no solution has been found Excel will ask 
you if you wish to continue. 
 

Remember, the Optimiser simply treats the diet as a mathematical problem to solve and has 
no nutritional awareness. It can find a feasible diet that minimises cost and meets the 
constraints but that may harm your cows. Evaluate each feasible diet carefully based on your 
knowledge of the animal and the diet. If in doubt consult with a qualified nutritionist!  
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The Optimise tab shown within the red rectangle. 

 
 

You can add constraints to control the diet content of NDF, peNDF, NDF supplied by forage, crude 
protein, forage concentrate ratio, kilograms of concentrate, starch, sugar and fat. For each of 
these constraints you must specify the minimum and maximum levels that are acceptable using 
the left and right sliders. The actual values will be displayed to the left of the slider. The more 
constraints are activated, the more expensive the diet is likely to become.  Also, the narrower the 
range the less likely it is that a feasible diet can be found. To make the constraint active click the 
box to the left of the constraint name to put a tick in it. 
To the left of the constraint ranges are the current diet value for each parameter. If the constraint 
is active (ticked) and the diet value is outside the constraint range it will turn red. A parameter 
such as ME or MP may be close enough to the animal demand to have a green traffic light on the 
Diet detail tab and still be displayed in red on the Optimiser tab. This is due to a wider margin for 
the traffic lights (set in the preferences, default is 2%) and rounding differences between Rumen8 
and the spreadsheet calculations. 
The last four ingredient constraints refer to diet ingredients 1 to 15. Using these you can restrict 
the amount of each of four feeds in the diet. The drop-down list allows you to select the 
ingredient you wish to constrain, and the two entry boxes specify the range of kg DM fed that is 
acceptable. The ‘Current value’ button lets you to quickly fix an ingredient at the amount currently 
entered. This is useful when the amount of pasture available has been previously determined and 
needs to be fixed at a certain level. Then the remainder of the diet ingredients will be changed to 
optimise the diet. 
The light on the right of each of the ingredient constraint will turn green when that constraint is 
active. To be active it must be ticked, specify an ingredient number that has a feed or mix and 
have a valid range of DM fed. 
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The Optimiser has been unable to find a feasible diet. 

 
 

When a feasible diet cannot be found check the diet values to see how close the Optimiser was to 
the specified level. You can see in the figure above the sugar constraint is highlighted red and is 
outside the desired range, preventing the optimiser finding a diet that meets all constraints. Try 
relaxing the constraint until a feasible diet can be found or add additional feeds. In this example by 
allowing a greater sugar content in the diet resulted in a feasible diet as shown in the figure 
below. 
The number shown in brackets at the end of the message from the Optimiser (under the 
‘Optimise’ button in the figure above) is the return code from the Solver add-in in Excel. You can 
find more information about these return codes in the Solver documentation provided with Excel. 
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Successful optimisation after relaxing the sugar constraint. 

 
 

The figure above shows a successful optimisation with a feasible diet found. 
The constraint ranges on the Optimiser tab can be quickly set to the recommended levels (set in 
preferences) by clicking on the ‘RL’ button which opens the ‘Apply recommended levels to the 
optimiser’ window. Up to 5 sets of recommended levels for a range of diet parameters can be set 
in the preferences providing quick feedback on the suitability of a diet on the Diet tabs. 
 

Apply previously set recommended levels to the optimiser. 

 
 

To set the optimiser constraint range to the same as the recommended range first select which 
set to use at the top of the window. In the figure above set one has values for early lactation cows 
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and three of the parameters are active and available to be used in the optimiser. Initially all the 
ranges are from the Optimiser tab so all the ranges under the ‘Current Optimiser’ column are in 
bold. To change ranges simply click on them. For example, to use the NDF% range from the 
recommended levels set one click on the ’28 to 30’ text and it will turn bold signifying it is now 
active. 
 

Diet parameter ranges from recommended level set one have been selected for NDF and sugar. 

 
 

Click ‘Okay’ to return to the Optimiser tab and the constraint ranges for NDF and sugar will be 
updated. 
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COSTS, INCOME, EFFICIENCIES, AND MARGINS 
The bottom of the Rumen8 window displays a range of parameters that allow you to evaluate the 
financial performance of the current diet. All feeds in the diet must have a feed cost entered and 
income from sale or milk. 
 

The costs, income, efficiency and margin measures shown within the red rectangle. 

 
 

These parameters are divided into four groups. From left to right they are feed costs, milk income 
(only for dual purpose cows), feed efficiencies and margins. The first feed efficiency measure and 
the feed as a percent of income measure may also have a recommended level set in Preferences 
to quickly show if they are within the recommended range via a small traffic light. 
The current live weight change can also be adjusted in the bottom right of the window allowing 
the animal performance to be fine-tuned while the animal tab is not visible. 
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PREFERENCES FOR BEEF 
The preferences allow you to change some Rumen8 settings to suit your business and location. 
Access to the Preferences window is via the Preferences option in the File menu of the main 
Rumen8 window. The settings you can adjust in Rumen8 are divided into General and Advanced. 
Additionally, you can adjust Recommended levels on the rightmost tab. 
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GENERAL PREFERENCES 
The general preferences tab contains setting most users will want to adjust. The settings shown in 
bold such as 'Milk yield units' and 'Currency' are common with the dairy mode. This means 
changing the value while in beef mode as shown in the figure below also changes it when creating 
a diet for a dairy animal. Settings that do not have their title in bold are specific to beef. 
 
The General preferences tab. 
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Milk yield units Milk yield can be entered and reported in litres or kilograms. 

Milk component 
units 

The fat, protein and lactose percentage of milk can be entered and reported 
in mass/volume (i.e., per litre) or mass/mass (i.e., per kg) units (mm% or 
mv%). 

Feed 
concentration 
units 

The units for concentration in feeds used by Rumen8 can be set to g/kg or 
percentage. 

Feed proportion 
units 

The units for parameters such as aN, bN or cN can entered and displayed as 
a proportion (0 to 1) or a percentage. 

Tool tips detail 
This allows you to set the level of information provided by the tool tips. 
Standard displays a one-line explanation and Extended provides more 
detailed explanations with diagrams. 

Dry matter intake 
estimate 

The animal’s feed intake potential can be estimated using the ‘NDF as a 
percentage of live weight’ method and is selected on the animal tab. If the 
NDF DMI method is selected for an animal, for each of the cow classes 
above, a predicted NDF intake amount as a percentage of live weight can be 
specified by the user. 

Currency – System 

Check to use the currency symbol set in Windows on your computer. 
Uncheck to manually set the currency symbol from the drop-down list. 
Choose ‘Custom’ at the end of the drop-down list to enter you own currency 
symbol. 

Currency – Do not 
display cents 

When checked all prices and costs will not show cents. 

Currency – Divisor 

For currencies with very large values select a divisor from the drop-down 
list. For example, If the currency divisor is set to 1000 all feed costs and milk 
prices should be entered into Rumen8 already divided by 1000. For example, 
100,000 Rp/t would be entered as 100 Rp. The currency divisor will be 
displayed on reports if it is greater than 1 and a flag appears on the main 
Rumen8 window below the tabbed section. 

Show the Diet tab 
The Diet tab can be turned off by un-ticking this box. Useful if you only use 
the Diet detail tab. 

Load warning for 
intake estimate 
change 

When checked a warning will be given if a file is opened with a different 
intake estimation method to the current. See below for more details. 

Change Rumen8 
home directory after 
restart 

If you want to change where Rumen8 stores its files (usually 
~\Documents\Rumen8) then clicking the ‘Change home’ button will cause 
Rumen8 to ask you where to place the Rumen8 directory next time it is 
started. If this is a new directory the default feed library and Preferences 
files will be copied across. If you wish to retain your existing library files you 
should copy them into the new location using Windows Explorer. 
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Restore all the 
Preferences to 
their defaults 

This will set all the preference settings back to their default values. 

Show Optimiser 
tab 

The Optimiser tab will be available in the main window if this box is ticked. 
This also makes available the Optimiser Preferences below it. See the 
Optimiser section of this document for more information on using the 
Optimiser as it requires Microsoft Excel and the Solver add-in along with 
careful setup. It will not work if you just enable it here! 

Excel visible during 
optimisation 

Tick this to see Excel load and optimise the diet. Usually left unticked. 

Excel saves diet 
after optimisation 

Tick this to make Excel save the Optimiser spreadsheet after optimising the 
diet. This is useful for debugging and is usually left un-ticked. 

 

Dry matter intake estimate changes result in a warning 

The method and parameters to estimate the animal’s dry matter intake are saved with the current 
diet in the save file (.rm8) and if they have changed when the file is reopened the user will be 
warned and given the option to revert to the value when the diet was saved. 
For example, a lactating cow has the DMI estimation method set to NDF on the animal tab and in 
Preferences this is 1.2% of live weight. A diet is created, saved and the user moves on to other 
scenarios, during which the cow value for NDF is changed to 1.3% of live weight in Preferences 
after talking to a colleague. A few months later when opening the save file it reloads the cow 
parameters, setting DMI method to NDF, and then prompts the user that the Preferences value 
for cows NDF intake has changed from 1.2% when saved to the current 1.3% of live weight. The 
user can ignore this and continue with the 1.3% value or choose to set it back to 1.2%. If the 
Preferences are set back to 1.2% this will apply to all cows with DMI set to NDF method. 
Whether Rumen8 warns the user about changes to DMI parameters in the Preferences can be 
turned off in the General Preferences. 
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ADVANCED PREFERENCES 
The advanced section of the Preferences contains those settings that are unlikely to need 
adjustment and may have a significant impact on the animal nutrition model if they are changed. 
Please change them only in consultation with an experienced nutritionist. 
 

The Advanced preferences tab. 
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Preferences 
library in use 

Select the Preferences library you would like to use from the drop-down 
menu. A preferences library contains the settings for both beef and dairy 
modes. This option is not available in Compact mode. 

Add Copy 
Create a copy of the current library. You will be prompted for the library 
name. Names must be unique. This option is not available in Compact mode. 

Rename 
Rename the current library. Names must be unique. This option is not 
available in Compact mode. 

Delete 
Delete the current library. You cannot delete the last library. This option is not 
available in Compact mode. 

Import 

Import as a new library from a Preferences file that has previously been 
exported or created by Rumen8 version 3. This option is not available in 
Compact mode. 

Export 
Export the current preferences as a library file. This option is not available in 
Compact mode. 

Acidosis (low 
rumen pH) 
warning 

Turning this on displays an estimate of rumen8 pH on the Diet Detail tab. The 
two pH levels control when warnings will appear for sub-clinical and acute 
acidosis. The rumen pH value is the daily average and assumes TMR feeding 
of grain so many other factors may result in actual rumen8 pH being lower 
than the prediction. See the tool tip on the Diet Detail tab for further 
information. 
This calculation is experimental so use it with caution. 

MP demand 
correction factor 

The animal’s total protein requirement will be multiplied by this value. 

Cow time 
standing 

The number of hours per day the animal is standing. Leave at 14 hours unless 
you have access to a better estimate. 

Cow position 
changes 

The number of times an animal gets up or down during the day. Leave at 10 
unless you have access to a better estimate. 

Gross energy in 1 
kg of dry matter 

Enter the gross energy contained in 1 kilogram of dry matter in mega joules. 
Used as part of the animal energy requirement calculation. Set by default to 
18.8 for a diet containing significant quantities of silage. May be set to 18.5 
for diets not containing silage. 

Fixed addition to 
ME requirement 

Rumen8 will add this value to the animal’s energy requirement. 

Milk true protein 
content 

The percentage of crude protein in milk that is true protein. 

Milk lactose The lactose content (%) of the milk for your cows. 

Weight of a litre 
of milk 

The weight of one litre of milk in kilograms. 
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Standard 
reference weights 

This section allows the user to change the standard reference weights for 
each breed of beef animal. There is a standard weight at birth, and then 
mature weight for females, steers and bulls. These weights are used to 
calculate the energy and protein demand for the animal. To return the 
weights to their defaults click on the Reset button below the breed drop 
down menu. Note, the reset button will only change the weights for the 
current breed back to the default values. The default values for each breed 
are shown below. 

Traffic light and 
progress bar 
accuracy 

These parameters set the sensitivity of the ‘traffic lights’ for the cow’s energy, 
protein, intake and minerals on the Diet detail tab and the progress bars in 
the Diet tab. The lights will show green if the diet provides an amount of 
energy, protein, dry matter intake or mineral that is within this percentage of 
the cow demand. The exception is the DMI acceptable range, which is 
asymmetric, with the ‘green’ values below the maximum intake x10 the value 
entered. For the default 2% this gives a ‘green’ range of 80-102%. 

 
 

Standard reference and birth weights 

Breed Species Type Birth 
weight (kg) 

Female 
reference weight (kg) 

Male 
reference weight (kg) 

Angus Bos taurus A 31 550 660 
Ankole Bos indicus A 22 450 540 
Arsi Bos indicus A 20 225 275 
Australian Milking Zebu Hybrid A 33 450 540 
Ayrshire Bos taurus A 33 450 540 
Beef Shorthorn Bos taurus A 33 550 600 
Begait Bos indicus A 22 250 300 
Belgium Blue Bos taurus B 50 850 1000 
Blonde d Aquitane Bos taurus B 35 550 660 
Boran Bos indicus A 27 400 550 
Braford Hybrid A 36 550 660 
Brahman Bos indicus A 35 550 660 
Brangus Hybrid A 33 550 660 
Braunvieh Bos taurus B 39 650 780 
Brown Swiss Bos taurus A 39 600 720 
Charolais Bos taurus B 41 650 780 
Chianina Bos taurus B 41 700 840 
Criollo Bos taurus A 33 500 600 
Dairy Shorthorn Bos taurus A 35 550 600 
Devon Bos taurus A 33 500 650 
East African Zebu Bos indicus A 25 350 450 
Fleckvieh Bos taurus B 41 650 780 
Fogera Bos indicus A 22 250 300 
Friesian Bos taurus A 38 550 660 
Galloway Bos taurus A 36 550 600 
Gelbvieh Bos taurus B 38 700 840 
Generic B.indicus Bos indicus A 26 425 520 
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Breed Species Type Birth 
weight (kg) 

Female 
reference weight (kg) 

Male 
reference weight (kg) 

Generic B.taurus British Bos taurus A 34 530 630 
Generic B.taurus European Bos taurus B 40 640 765 
Gir Bos indicus A 22 400 475 
Girolando Hybrid A 32 500 600 
Guernsey Bos taurus A 33 450 540 
Hereford Bos taurus A 36 550 700 
Holstein Bos taurus AB 41 650 750 
Horro Bos indicus A 20 250 300 
Jersey Bos taurus A 28 400 480 
Limousin Bos taurus B 38 550 660 
Lincoln Red Bos taurus A 36 550 660 
MaineAnjou Bos taurus B 41 650 780 
Montbeliarde Bos taurus B 38 700 840 
Murray Grey Bos taurus A 31 550 660 
Nelore Bos indicus A 32 450 540 
Nguni Bos indicus A 23 350 450 
Piedmontese Bos taurus B 40 600 720 
Pinzgauer Bos taurus B 37 650 780 
Polled Hereford Bos taurus A 36 550 660 
Red Poll Bos taurus A 36 500 600 
Sahiwal Bos indicus A 38 450 540 
Salers Bos taurus B 38 700 840 
Santa Gertrudis Hybrid A 33 650 780 
Shorthorn Bos taurus A 36 550 660 
Simmental Bos taurus B 41 650 780 
South Devon Bos taurus A 38 550 660 
Tarentaise Bos taurus A 36 500 600 
Texas Longhorn Bos taurus A 30 550 660 
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RECOMMENDED LEVELS 
Rumen8 allows the user to set a recommended level range for several important diet parameters. 
These provide quick feedback on the suitability of the current level of a diet measure on the Diet 
and Diet detail tabs with a traffic light. Five sets of Recommended Levels can be defined and 
quickly switched between on the Diet detail tab. These could be used for early, mid, late lactation 
cows or finishing steer diets for example. 
 

The Recommended levels tab in Preferences showing example ranges for early lactation cow. 

 
 
Select the current Recommended Levels set by clicking on one of the buttons across the top of the 
tab. Describe the use of the set with a short description below. 
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For each of the 13 diet measures you can set an acceptable range by moving the minimum and 
maximum sliders left or right. The actual values are displayed to the left of the slider. So, if you 
wish to target NDF levels of 28-50% in early lactation activate the NDF recommended level by 
clicking on the checkbox to the left and then move the sliders until that range is displayed. Now a 
traffic light will appear on the Diet and Diet detail tabs that will show you if the diet NDF level is 
below (red), within (green) or above (yellow) your recommended NDF level. Repeat this process 
for each of the diet measures for you wish to display a Recommended Level traffic light. 
 

Linking Recommended Levels sets to cow day of lactation 

Each recommended level set has an additional two auto parameters called ‘Days since calving’ and 
‘Days in calf’. These can be set to a range of days and turned on or off. For example, the early 
lactation set might have the days since calving parameter set to days 1 to 60 as shown in the 
figure above. 
If the ‘Days since calving’ parameter is checked and ‘Recommended Levels set switching’ is set to 
automatic, when the current cow is between 1 to 60 days in milk, the first set of Recommended 
Levels will be activated. When the cow is outside the range 1 to 60 days the Recommended Levels 
will be turned off. 
 
The Diet Detail tab with the Recommended Levels selection control highlighted in blue.  

 
 

In the figure above the Active recommended level is set to set one and Rumen8 will switch 
between sets automatically as the button in the bottom right corner is displaying an ‘A’ for 
automatic. The mode can be toggled between automatic and manual by clicking on the button. It 
will display a ‘M’ when in manual mode. The user can also switch to manual mode by simply 
selecting one of the Recommended Levels sets directly by clicking on its round button. 
If no ‘Recommended Levels sets’ in the Preferences have the days since calving or days in calf 
parameter turned on (checked) then the button will not appear in the active Recommended 
Levels section of the animal tab as automatic mode is not available. 
An example of automatic switching between Recommended Levels sets: 
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1. Define recommended sets for early, mid and late lactation cows as well as dry and 

transition/close-up cows in Preferences.  
2. Set the days since calving range when each of the sets should be active and ensure each is 

turned on. You might choose early 1-60, mid 61-150, late 151-500 and 0 days since calving 
for dry and transition/close-up cows. To match the 0 days of lactation condition the milk 
yield must also be 0 as the cow must be dry. 

3. Set the days in calf range off for sets one to three (early, mid and late lactation) and on for 
dry and transition/close-up sets. You might choose days 222- 256 for the dry cows and 
transition cows 257-285 days. 

4. Close the Preferences are return to the Diet Detail tab. Click on the button in the bottom 
right of the Active Recommended Levels section until it shows (A)utomatic mode. 

5. Now as the Animal days since calving and days in calf parameters are changed the relevant 
recommended levels will automatically become active through the cow's lactation and dry 
period. 
 

Note, if none of the sets cover a particular day of lactation then the Recommended Levels set will 
be turned off. 
Recommended level sets can have overlapping day of lactation ranges. In this instance Rumen8 
switches to the set with the lowest number. For example, if set 2 is day of lactation 80 - 120 and 
set 3 is days 100 – 180, for an animal that is at day 110 of lactation set 2 will be selected. 
If both day or lactation and days pregnant ranges are active for a set, the current animal must 
match both to automatically switch the set. 
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THE REPORT DESIGNER 
The report designer can be accessed via the File menu. In it you can create several reports based 
on the current diet and customised for your business. 
 

Note that reports require additional software to be installed. See the Getting Started section 
of the User Guide for details. 

 
When the report designer window first opens it will have no entries for the farm name, diet name 
and who prepared the diet. This information will be printed at the top of the report, so it is useful 
to include it for your business. It only needs to be entered once and Rumen8 will remember it for 
future reports. 
The report type is selected in the top drop-down menu. 
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THE DIET REPORT 
The diet report presents all the information about a completed diet including the animal details, 
ingredients list, animal performance, diet performance, efficiencies and margins. 
 

The Report Designer window highlighting the ingredients list (1) and the mixes list (2). 

 
 

Once the farm name, diet name, prepared by, contact details, notes and disclaimer have been 
completed you may also include a business logo on the top right of the report. Click on the ‘Select’ 
button in the Logo section of the Report Designer (top right) and choose an image file. The image 
file can be either jpeg, tiff, png or bmp format and will look best if it is between 600 x 300 and 300 
x 300 pixels in size (W x H). If the logo is very wide (aspect ratio > 2) it may cover some of the farm 
detail text. 
The order the ingredients are listed on the report is determined in the ‘Ingredients listed in order’ 
box. It is labelled with a 1 in the figure above. The numbers alongside each ingredient are their 
ingredient number in the main Rumen8 window so will not change as you change the list order 
with the arrow buttons alongside them or by dragging and dropping with the mouse. 
You can also control if mixes are listed as a single ingredient (their mix name) or broken down to 
their constituent ingredients. Mixes checked in the ‘Mixes to list as their ingredients’ box labelled 
2 in the figure above will be shown as their ingredients. The figure below shows the report created 
with mixes listed by name, not ingredients. 
Below the mixes ingredients box you can choose if common ingredients from mixes that are being 
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listed as their ingredients should be combined with the same ingredient already in the diet. For 
example, Mix Demo above contains barley grain, lupins grain and wheat grain. If it was checked in 
box 2 to list as it’s ingredients and common ingredients ‘Keep separate’ was selected the final 
report would list barley and lupins grain twice, once as an ingredient added by the user and once 
as part of the Mix Demo ingredient. the figure below shows the report created with these settings. 
If Common ingredients ‘Combine’ was selected only a single entry for barley and lupins grain 
would be included on the report and they would be the combined amount from the user added 
ingredients and the barley and lupins in the mix. See the figure below to see the report created 
with mix ingredients combined. 
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The Report Preview window showing a diet report with the Mix Demo ingredient listed as a mix. 
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The Report Preview window showing a diet report with the Mix Demo ingredient listed as its 
ingredients and common ingredients kept separate. 
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The Report Preview window showing a diet report with the Mix Demo ingredient listed as it’s 
ingredients and common ingredients combined. 
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THE DAILY FEEDING SHEET REPORT 
This report allows you to create a PMR/TMR sheet from the current diet for the number of cows 
to be fed. For this report you must provide additional information beyond that for the Diet 
Summary report. In the figure below you can see there are 150 cows to be fed (1) and the target 
dry matter content of the PMR/TMR mix is 52% (2). You must also specify where the ingredients 
will be fed. When the Report Designer opens all the feeds are listed in the left most TMR/PMR 
box. You should drag and drop (or use the arrow buttons) the ingredients to be fed in the dairy (3) 
and elsewhere (4). This is usually the paddock and includes grazed forages. The ‘Mixes to list as 
their ingredients’ works in the same manner as in the Diet report described in the section above. 
You can see in the figure below the Mix Demo ingredient is being fed in the dairy (3) and the 
Ryegrass is listed as fed elsewhere (4) as it is grazed in the paddock. 
If the dry matter content of the TMR/PMR is higher than the target (2) then the report will show 
the quantity of water to add to the TMR/PMR to reduce it. If the dry matter content is already 
below the target water will not be added. 
 

The Report Designer window showing a Daily Feed Sheet. In this report you must specify the 
number of cows (1), the target dry matter for the TMR/PMR mix (2) and ingredients fed in the dairy 
(3) and elsewhere (4). 
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The Report Preview window showing a Daily Feeding Sheet report with diet ingredients listed fed in 
a TMR/PMR, in the dairy and fed elsewhere (grazed in the paddock in this case). 
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THE BATCHING SHEET REPORT 
This report allows you to create a batching sheet from the current diet for a batch size in tonnes 
(fresh weight). In this report you can add a mix name below the contact details of the person who 
prepared the diet. 
For this report you must provide additional information beyond that for the Diet Summary report. 
In the figure below can see the batch size will be 2.5 tonnes fresh weight (2) and the target dry 
matter content of the PMR/TMR mix is 52% (1). You must also specify which ingredients will be 
fed in the batch and elsewhere. When the Report Designer opens, all the feeds are listed in the 
left most batch box (3). You should drag and drop (or use the arrow buttons) the ingredients to be 
fed elsewhere (4). This is usually the dairy and paddock and includes grazed forages. The ‘Mixes to 
list as their ingredients’ works in the same manner as in the Diet report described in the section 
above. 
You can see in the figure below the Mix Demo and Ryegrass ingredients are being fed outside of 
the batch (4) and the barley grain, lupins grain and barley hay make up the batch (3). 
As for the Daily Feed Sheet report, if the dry matter content of the batch is higher than the target 
(1) then the report will show the quantity of water to add to reduce it. If the dry matter content is 
already below the target water will not be added. 
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The Report Designer window showing a Batching Sheet report design. In this report you must 
specify the target dry matter for the TMR/PMR mix (1), the weight of the final batch (2) and 
ingredients fed in the batch (3) and elsewhere (4). 
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The Report Preview window showing a Batching Sheet report with diet ingredients listed fed in the 
batch and elsewhere. Water has been added to reduce the target dry matter of the batch down to 
52% while keeping the batch weight within the specified 2.5 tonnes of ingredients. 

 
  



Rumen8 User Guide 

181 / 247 

 

 

THE DIET COMPARISON REPORTS 
This report allows you to print a comparison between three diets that have been stored in the 
Compare tab in slots 1, 2 and 3. Typical use might be an existing diet and then two alternatives 
with improving margins. 
 
The Compare tab showing three stored diets. Diet 1 is the existing diet, diet 2 uses the same 
ingredients but better matches the cow’s requirements and improves the margin. Diet 3 substitutes 
the barley grain with a smaller quantity of slightly more expensive wheat grain to further increase 
the diet margin. 

 
 

Once multiple diets have been stored in the Compare tab the Diet Comparison report shows the 
ingredients in each. Ingredient order can be adjusted using the buttons to the left of the lists or 
they can be dragged and dropped with the mouse. 
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The report designer displaying the three stored diets from the Compare tab when creating a Diet 
Comparison report. 
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The Report Preview window showing a Diet Comparison report with three diets, the current diet, an 
improved version of the current diet with a better margin and an alternative with barley grain 
replaced with wheat grain that improves the margin further. 

 
 

The Diet Comparison report can also be printed with ingredient quantities show on an as fed basis 
if this is more suitable for the recipient. 
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PRINTING REPORTS 
The Report Preview window has a tool bar across the top of the window with icons for 
 

1. exporting the report in PDF, CSV, Word, Excel, RTF or XML formats, 
2. printing the report, 
3. refresh the report, 
4. copying text from the report for pasting into other documents, 
5. changing to another report page number for multi-page reports, 
6. finding text within the report, 
7. and changing the zoom level of the report preview. 

 
The print report button opens a standard Windows print dialog box where you can specify the 
printer, page size and layout. 
To save the report and as a PDF document click on the ‘Save report as PDF’ button at the top of 
the Report Preview window. You will be asked for a name for the PDF file and where you would 
like to save it. 
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THE FEED LIBRARY EDITOR 
The feed library is accessible from the edit menu of the main Rumen8 window. It allows you to 
edit all the parameters for each feed and define commonly used mixes made up of feeds. The feed 
library window is divided into three tabbed sections. The first allows you to manage individual 
feeds, the second manage mixes and the third tab provides control of the feed library and which 
ingredients are visible in the main Rumen8 window. 

MANAGE FEEDS 
The 'Manage feeds' tab lets you edit all the parameters for each of the feeds in the current library. 
The currently highlighted feed has its parameters displayed in edit section of the window. 
 
The feeds editor in the feed editor. 
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Edit Edit the parameters of the currently selected feed. 

Add 
Copy 

Add a new feed to the library that is a copy of the currently selected feed. 

Delete 

You can add a blank new feed by holding down the Shift key and the ‘Add Copy’ button 
will change to ‘Add New’. Adding a feed this way is not recommended, always add a 
copy of the closest related feed and modify the parameters with the new values. 
Remove the currently selected feed from the library. 

Search 
Opens the search window allowing all feed libraries to be searched for a name or partial 
name. See below for more details. 

Unlock 
All 

Unlocks all the feeds in the current library. 

Lock All Locks all the feeds in the current library. 

 
To edit an individual feed highlight it in the feed list and click the ‘Edit’ button or double click on it. 
The entry boxes in the Edit section of the window will become active and allow you to change any 
of the feed parameters. 
As a minimum, eleven parameters are required for a feed to be accepted as valid and their names 
are in bold in the edit section. These are a unique name, management category, protein type, 
particle size classification, ME, CP, DM, Fat, aN, bN and cN. Until valid values for these parameters 
are entered you will be unable to save the feed. 
If you are unsure what the parameters refer to, hover your mouse over the name and a tool tip 
will appear with the full name and an explanation. Abbreviations are also listed at the end of this 
document. 
If you enter an invalid value into the entry box for any of the parameters, the parameter name will 
turn red. Once you have entered all the feed parameters you have, or have edited an existing 
feed, click onv the ‘Okay’ button to save your changes and return to feed selection.  
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Entering parameters for an individual feed. 

 
 

Given the importance of the correct management category, protein type and particle size 
classification of a feed, and the difficulty in obtaining aN, bN and cN values for feeds, we 
strongly suggest you ALWAYS create a new feed in your feed library by adding a copy of a 
closely matching existing feed from the original Rumen8 feed library, which can then be 
modified for DM, ME, CP, fat and other feed values. For this reason, we also suggest you 
never edit feeds in the original Rumen8 feed library, but add copies of these feeds instead 
which can then be modified to reflect your feeds. 

 
Although Rumen8 can function with just these eleven required parameters, to make full use of the 
features of the program, all feed values should be entered if possible. Entering feed costs and 
keeping these up to date is also important if you wish to compare diets to determine the lowest 
cost option. 
As the aN, bN, cN and ADIN values are not easily obtained, a generic list is provided here that 
indicates typical values for different feed classes (AFRC 1993). 

Typical protein degradability (aN, bN and cN) and ADIN (g/kg DM) values for different feed classes  
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Feed Locking 

To reduce accidental changes to feed parameters, they can be locked preventing change of all the 
parameters except cost and losses. When the feed is locked the padlock in the top right of the Edit 
section will be closed. To unlock the feed click on the padlock and it will open. It is recommended 
all feeds are locked when not being edited. 
 
The feed editor showing a locked feed where only the cost and losses can be edited (1). Click on the 
padlock to unlock the feed. 

 
 
Feeds can be permanently locked by the library creator. In this case the symbol will be a key with a 
diagonal line through it instead of an open or closed padlock. Permanently locked feeds cannot be 
unlocked by the user so if a feed parameter needs to be changed a copy of the feed should be 
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made first. It is recommended the feeds supplied with Rumen8 are locked and only copies are 
altered. 
 
The feed editor showing a permanently locked feed signified by the no-key symbol (1). These feeds 
must be copied before parameters can be changed. 

 
 
 

Searching for a feed by name 

Open the Feed Search window by clicking on the Search button. At the top left you can enter all or 
part of a feed's name (1). Click the Search button (2) to search through the current feed library for 
feeds that contain the entered text in their name, species name or other names. The number of 
feeds found is displayed at the top right of the window (3) and the feeds below in the main part of 
the search window (4). 
By default only the selected feeds in the current feed library are displayed. To widen the search 

you can also include unselected feeds (5) and other feed libraries (6). 
 
The feed search window available from the Edit menu. 
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The feed parameters used in the Feed Editor 

Name 
The feed name. This must be unique in the feed library (feeds and mixes). This 
can be search for in the Search window. 

Species The species name of the plant. This can be search for in the Search window. 

Other name 

Any alternative names for the feed. An editing window will open when the button 
is clicked allowing entry of other names for the feed. These can be search for in 
the Search window. 

Padlock 

Allows the feed to be edited when unlocked (open padlock symbol), only cost and 
losses changed when locked (locked padlock symbol). If the symbol is a key with a 
diagonal line through it the feed cannot be unlocked and must be copied to 
change parameters. 

Feed 
management 
category 

This is used to sort feeds into similar groups for easier access. It is not used by the 
nutrition model to determine nutrient supply (grazed pasture, grazed other, hay, 
silage, concentrate, additive, by-product). 

Feed protein 
type 

This is used by the AFRC nutrition model to calculate the diet’s fermentable 
energy content and hence influences the metabolisable protein supply (grass 
silage, other silage, other non-forage, other forage, distillery by-product). 

Feed particle 
size 
classification 

This is used to classify feeds as forage or concentrate 'like' in terms of behaviour 
in the rumen. This is expressed as the ‘forage concentrate ratio’ and ‘NDF from 
forage’ measures on the diet detail tab. It is also used to determine the 
absorption coefficient for calcium, phosphorus and magnesium (concentrate, 
forage, other). 

DM 
Dry matter content of feed in g/kg or % (depending on your choice in 
Preferences). 

ME Metabolisable energy content of feed in MJ/kg DM. 

CP Crude protein content of feed in g/kg DM or % in DM. 

Fat Fat content of feed in g/kg DM or % in DM. 

Ca Calcium content of feed in g/kg DM or % in DM. 

P Phosphorus content of feed in g/kg DM or % in DM. 

Mg Magnesium content of feed in g/kg DM or % in DM. 

K Potassium content of feed in g/kg DM or % in DM. 

Na Sodium content of feed in g/kg DM or % in DM. 

Cl Chlorine content of feed in g/kg DM or % in DM. 

S Sulphur content of feed in g/kg DM or % in DM. 

DCAD 

Dietary cation anion difference of feed in milli-equivalents per kg DM. 
Can only be calculated by clicking on the calculator button if the K, N, Cl and S 
content of the feed are provided. 
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aN Proportion of water-soluble nitrogen (N) in the total N of the feed. 

bN 
Proportion of potentially degradable N, other than water soluble N, in the total N 
of a feed. 

cN Fractional rumen degradation rate per hour of the b fraction of feed N. 

ADIN Acid detergent insoluble nitrogen content of feed in g/kg DM or % in DM. 

Ca abs 

Calcium absorption coefficient for feed (% of total calcium content). 
Rumen8 adopts the NRC 2001 approach with constant coefficients of 60% and 
30% for concentrates and forages respectively. 

P abs 

Phosphorus absorption coefficient for feed (% of total phosphorus content). 
Rumen8 adopts the NRC 2001 approach with constant coefficients of 70% and 
64% for concentrates and forages respectively. 

Mg abs 

Magnesium absorption coefficient for feed (% of total magnesium content). 
Rumen8 adopts the NRC 2001 approach with constant coefficients of 16% for 
both concentrates and forages. 

Max feeding 
rate 

Maximum feeding rate of a feed as a proportion of the total dry matter intake. 
This is optional and needs to be set by the user. 

Wet density 
The wet density of a feed as fed. 
This is not used by Rumen8 but by associated programs. 

NDF Neutral detergent fibre content of feed in g/kg DM or % in DM. 

peNDF The physically effective NDF in the total feed dry matter. 

ADF Acid detergent fibre content of feed in g/kg DM or % in DM. 

Starch Starch content of feed in g/kg DM or % in DM. 

Sugar Sugar content of feed in g/kg DM or % in DM. 

Ash Ash (inorganic matter) content of feed in g/kg DM or % in DM. 

Cost $/t DM The cost of the feed expressed in $/t dry matter. 

Cost $/t fed The cost of the feed expressed in $/t as fed. 

Losses 
The proportion of dry matter lost from a feed after purchase.  
This in effect increases the cost of feed consumed by the animal. 

Source A place for the user to record the source of information for a feed. 

Comment 

A place for the recording of any other useful information for a feed. Click on the 
magnifying glass to the left of the comment box to open a larger editing window 
for more detailed comments. 

DCAD calculator 

If the feed being edited has values for the minerals potassium (K), sodium (Na), chloride (Cl) and 
sulphur (S) the DCAD value can be calculated by clicking on the calculator button to the left of the 
DCAD value box. If a different value than the one calculated is already entered for DCAD, you will 
be prompted to confirm you wish to overwrite it. 
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peNDF calculator 

When changing a feed's NDF content, you can elect to adjust the feed peNDF content by a similar 
amount at the same time. To do this click on the calculator button next to the NDF entry box. The 
peNDF calculator will open and you can enter the new value for the feed NDF. Below that the new 
value for peNDF will be displayed. If you wish to accept the changes click on the Okay button and 
the NDF and peNDF values for the feed will be updated. Cancel to exit the calculator without any 
changes. 
 

Water as an ingredient 

Water is listed as a feed and can be added to diets like any other ingredient. However, it is 
handled by Rumen8 as a special case in that 

• the quantity must be entered on an as-fed basis, 

• it is the only ingredient that can have a no cost and not prevent the diet's cost from being 
calculated, 

• it cannot be added to a mix, 

• in the feed editor it has all parameters set to 0. 
 
Water can also be added to a diet in the Batch report when adding it is required to meet a dry 
matter content target for the mix. 
  



Rumen8 User Guide 

194 / 247 

 

 

MANAGE MIXES 
The 'Mange mixes' tab lets you define commonly used mixes of feeds that can be selected as a 
single ingredient in a diet. 
 
The mixes editor in the feed editor. 

 
 

The left part of the window shows all the mixes in the feed library and the Edit section shows the 
details of the currently selected mix. You can use the buttons above the mix list to create, change, 
and delete mixes or double click on a mix to edit it. 
 

Edit Edit the parameters of the currently selected mix. 

Add 
Copy 

Add a new mix to the library that is a copy of the currently selected 
mix. 

Add 
New 

Add a new blank mix to the library. 

Delete Remove the currently selected mix from the library. 

Unlock 
All 

Unlocks all the mixes in the current library. 

Lock All Locks all the mixes in the current library. 

 
The Edit section becomes active when a mix is being created or changed. The feed list on the right 
shows all the feeds in the current feed library that are not in the mix. They can be added to the 
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mix table singly or in groups by selecting them and clicking on the add (<) button. Multiple feeds 
can be selected by choosing the first one and then holding down the control key while clicking on 
subsequent ones. Groups of feeds can be moved into the mix by selecting the first feed and then 
holding down the shift key when selecting the last one. Alternatively, you can double click on a 
single feed to move it straight into the mix. 
To remove a feed from the mix, click on the row header in the mix table to highlight the row and 
press the remove (>) button. 
Once all the feeds have been moved into the mix table you then enter the percentage for each 
one by clicking in the cell under the ‘Percent’ column. Feed percentages can be entered on a dry 
weight or as fed (wet weight) basis. Ensure the ‘Mix percentage by’ setting above the feed table is 
set correctly for your feed percentages. 
You cannot save the mix unless all the feed percentages add up to 100. The total at the bottom of 
the mix table shows the current percentage and will be red if it isn’t 100%. If the percentage is 
under or over 100 the difference is shown in brackets. Change each feed percent by double 
clicking on the value in the table. 
Below the mix table are the remaining parameters needed to define a mix. The mix name must be 
unique among both feeds and mixes and will turn red if this is not the case. You will be unable to 
save the mix until it has a unique name. If you are unsure what the parameters are, hover your 
mouse over the name and a tool tip will appear with the full name. Abbreviations are also listed at 
the end of this document. 
If you enter an invalid value into the entry box for any of the parameters, the parameter name will 
turn red. 

Mix Locking 

To reduce accidental changes to mix parameters, they can be locked preventing change of all the 
parameters except cost and losses. When the mix is locked the padlock in the top right of the Edit 
section will be closed. To unlock the feed click on the padlock and it will open. It is recommended 
all feeds are locked when not being edited. If the padlock symbol is a key with a diagonal line 
through it the mix has been permanently locked by the library creator and cannot be unlocked by 
the user. In this case you must make a copy of the mix to alter it's parameters. 
 
The feed editor showing a locked mix where only the cost and losses can be edited. Click on the 
padlock to unlock the feed (1). 
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The feed parameters used in the Feed Editor 

Name The mix name must be unique in the feed library (feeds and mixes). 

Padlock 

Allows the mix to be edited when unlocked (open padlock symbol), only cost and 
losses changed when locked (locked padlock symbol). If the symbol is a key with a 
diagonal line through it the mix cannot be unlocked and must be copied to change 
parameters. 

Max feeding 
rate 

The maximum feeding rate of the mix as a proportion of the total dry matter 
intake. If this rate is exceeded a warning (!) will appear to the right of the 
ingredient name on the main Rumen8 window. Expressed as g/kg or %. 

Wet density The mass of the mix as fed including liquids (kg/m3). 

Mix cost 
The cost of the mix entered per tonne dry matter or as fed. This should be the cost 
of the ingredient feeds and additional costs incurred such as milling or mixing. 

Losses 
The proportion of dry matter lost from a feed after purchase. This in effect 
increases the cost of feed consumed by the animal. 

Source A space for the user to record the source of information for a feed. 

Comment 

A space for the recording of any other useful information for a feed. Click on the 
magnifying glass to the left of the comment box to open a larger editing window 
for more detailed comments. 

Ingredient's 
cost 

This shows the value per tonne of the mix ingredients on a dry matter and as fed 
basis. If any of the ingredient feed costs are missing the value will not be 
calculated. The tool tip for the value shows the individual feed costs. 
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MANAGE LIBRARIES AND INGREDIENT VISIBILITY 
The library management and selection tab of the feed editor. 

 
 

The list of feeds in the left of the feed library window shows all the feeds and mixes available in 
the current library (1). Feeds with a tick in the box to the left of their name will be visible in the 
diet ingredient drop-down lists of the main Rumen8 window. This allows you to have a large feed 
library but only make a smaller more manageable number of feeds and mixes visible when 
creating diets.  
To the right of the feed list the total number of feeds and the number currently visible (selected) 
in the diet ingredient drop-down lists are displayed (2). Below that the current feed library is 
shown. 

Select feeds (3) 

The Select buttons allow you to select all, none, or invert the current selection of the feeds and 
mixes with a single click. Beneath those you can select all or none of just the feeds, or just the 
mixes. 

Sort feeds (4) 

The sort buttons allow you to change the order of the feeds and mixes, so they are listed in 
ascending or descending (reverse) order by name, category, selection (ticked) or by library if a 
shared library is in use. Sorting can also be changed by clicking on the column heading row in the 
feed list. 

Print report (5) 

Generate a report that includes all or a subset of the feeds and mixes in the library and then print 
or save it to a file. 
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Click on the ‘Print’ button and a window will appear that allows you to select all the feeds and 
mixes you wish to add to the report. Individual feeds can be selected by clicking on the first one 
and then holding down the Control key when clicking on subsequent feeds. A block of feeds can 
be selected by clicking on the first one, holding down the Shift key and clicking on the last feed of 
the group. 
To include all the feeds in selected mixes, click on the ‘Mix feeds’ button. When all the feeds and 
mixes you wish to add to the report have been selected, click the ‘Create’ button. A report 
preview will appear and from here you can export to a variety of formats or print it. 

Library (6) 

You may have multiple feed libraries and switch between them using the drop-down list 'Feed 
library in use'. Rumen8 comes with a single default feed library, but you can add additional 
libraries. These are often useful for different farms or countries. 
You manage multiple feed libraries with the library buttons. 

Add Copy Create a copy of the current library. You will be prompted for the library name. 
Names must be unique. 

Rename Rename the current library. Names must be unique. 

Delete Delete the current library. You cannot delete the last library. 

Import Import as a new library from a feed library file that has previously been exported or 
created by Rumen8 version 3. 

Export Export the current feed library as a library file. 

 

Shared feed libraries (7) 

A shared feed library can be opened in addition to the current feed library. Shared feed libraries 
are intended to be used by consultancy teams or several managers on a multiple farm business 
where it is useful to have access to common feeds and mixes. A shared feed library cannot be 
edited by users and is maintained by a central manager. 
A shared feed library can be opened and closed from the Select tab of the feed editor using the 
‘Open’ and ‘Close’ buttons at the bottom of the window under the ‘Shared feed library’ heading. 
Feeds and mixes from the shared library are shown throughout Rumen8 in a lighter grey colour. 
The feeds and mixes from the usual libraries that can be edited are shown in the normal black text 
by default. 
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A shared feed library is in use as shown by the ‘Shared’ flag displayed under the number of feeds 
and mixes. The feeds and mixes from the shared library are visible in the feed list to the left in a 
lighter grey colour. 

 
 

If you mouse over the ‘Shared’ flag to the right of 'Diet ingredients available’ number details of the 
library can be seen in the tool tip. Back in the main Rumen8 window an ‘SFL’ flag will appear below 
the tab section of the window to remind you a shared library is open. 
On the ‘Manage libraries and Ingredient visibility’ tab, the visibility of shared feeds and mixes 
cannot be changed as this has been set by the library manager. 
Shared mixes cannot be edited or deleted on the ‘Manage mixes’ tab of the feed editor. When a 
shared mix is selected in the mix list the ‘Edit’ and ‘Delete’ buttons are not enabled. Shared mixes 
can be copied into the default/user library using the ‘Add Copy’ button and then the copy altered. 
When a mix is copied all the constituent feeds are copied with it unless they are already in the 
default/user library. If a feed of the same name with different parameters is already present, the 
shared feed will have the mix name appended to it. 
In the same manner, shared feeds cannot be deleted from or edited in the shared library, so those 
buttons are not enabled when one of the light grey feeds are selected in the feed list. They can be 
copied into the default/user library using the ‘Add Copy’ button and then edited. 
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A shared feed library is in use as shown by the ‘SFL’ flag displayed under the tab section of the main 
window. The feeds and mixes from the shared library are visible in the ingredient list in a lighter 
grey colour. Feed and mixes in the default library are shown in the normal black text colour. 

 

Managing a shared feed library 

Shared feed libraries are managed by a single user and distributed to the other users in the group. 
This can be done via email if the group is small and changes are infrequent. For larger groups it 
may be better to use a cloud drive service with sharing capability, such as Dropbox, OneDrive or 
Google Drive. 
Using Dropbox as an example, the manager can create a new folder in their Dropbox folder and 
share it so other Dropbox users can access it. When setting up the shared folder, access can be set 
to ‘Can view’ to prevent editing by the users. Sharing also allows you to list the emails of group 
members you wish to use the shared library and modify them in the future by adding and 
removing members. Users must have Dropbox installed on their computer but there is a free tier 
that is suitable. 
The manager should keep the master shared feed library in a folder other than the shared 
Dropbox folder. It can then be opened as a user library to prepare it or make changes. Once it is 
ready for distribution close the user library and the feed library can be copied, and renamed if 
needed, to the shared Dropbox folder using Windows File Explorer. 
 

The shared library should not be directly edited in the Dropbox folder as partial changes may 
be distributed to users while the library is being modified. 

Sharing feeds and mixes (8) 

At the bottom of the tab the import and export buttons allow you to share feeds with other 
Rumen8 users. 
The ‘Export’ button allows you to copy selected feeds and mixes from the current library to a small 
feed library file to transfer them between computers running Rumen8. 
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The export window of the feed editor. Three feeds and a mix have been selected for export. 

 
 
Click on the export button and the window shown in the figure above will appear. Select all the 
feeds and mixes you wish to copy into an export feed library. Individual feeds can be selected by 
clicking on the first one and then holding down the Control key when clicking on subsequent 
feeds. A block of feeds can be selected by clicking on the first one, holding down the Shift key and 
clicking on the last feed of the group. 
All the feeds in selected mixes will be exported automatically when you click on the ‘Export’ 
button. If you wish to see which feeds make up the selected mixes click on the ‘Mix feeds’ button 
and they will be selected in the Feeds list. 
When you have selected all the feeds and mixes you wish to copy click on the export button, 
select the location and file name and click on the ‘Save’ button. It is recommended exported feed 
libraries always have the .db3 file name extension but you can change the rest of the file name to 
whatever you prefer. 
 

Importing feeds and mixes 

The ‘Import’ button allows you to bring into the current feed library 

• an older Rumen8 feed library held in a feed.csv file 

• a group of feeds previously exported from Rumen8 

• import complete data for feeds from a comma delimited .csv text file. 
To import an older feed library click on the ‘Import’ button and select the feed.csv file to import 
and then the window shown in the figure below will appear. 
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The import window of the feed editor. Barley grain is already present in the feed library. 

 
 

Rumen8 version 3 and 4 require two additional categories for each feed, management category 
and particle size classification. You can step through each feed to be imported and provide these. 
If they can be determined from other feed information the importer will select them for you.  
Each feed must have a unique name so if the import feed name already exists the Name label will 
turn red and you must provide an alternative. 
Once the import feed has a unique name and all three categories the ‘Add’ button will become 
active so you can add it to the feed library. At any stage, you can click on the Skip button to ignore 
the current import feed and move to the next. Pressing ‘Cancel’ will finish the feed importing. 
Feeds already added will remain in the feed library. 
 
To import a previously exported group of feeds and mixes click on the ‘Import’ button and select 
an export feed library file with a .db3 extension. A window like the one shown in the figure below 
will appear listing all the feeds and mixes available in the file. In Rumen8 all feeds and mixes must 
have a unique name and you can see in the figure below Wheat grain is highlighted red. This 
means a feed already exists in the current feed library with that name. 
You select the feeds to import in the same manner as you selected feeds to export in the section 
above. If you select a feed or mix that has the same name as an existing feed by default it will be 
renamed with (imported) appended to the name. In this case ‘Wheat grain’ will be renamed 
‘Wheat grain (imported)’ when copied into the current feed library. 
You can change the text appended to feeds that already exist in the bottom right of the window in 
the ‘Name suffix’ section. You can also choose to append text to all the feeds being imported by 
selecting the ‘All imported feeds/mixes’ option. This might be useful if you want to keep track of 
feed information from a colleague or your nutritionist for example. 
If ‘Use existing feeds’ is ticked Rumen8 will check each feed to be imported to see if it is identical 
to any existing feed in the library (other than the name). If an identical feed is found that will be 
used instead of importing the feed. If ‘Use existing feeds’ is unticked all feeds selected will be 
imported regardless, and potentially renamed as described above. 
Once you have selected the feeds and mixes to import, click on the ‘Import’ button and they are 
copied into the current feed library. 
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The import window of the feed editor. Three feeds are available to import but Wheat grain already 
exists in the current feed library. 

 
 

To add feeds to the Rumen8 feed library from a comma separated text file an import file must be 
created in the correct format. The first line is a header and can be used for comments as it will be 
ignored. Subsequent lines must consist of 42 values separated by commas in the order specified. 
The text fields do not require quotes and cannot contain a comma. An example is shown in the 
Appendix along with the definitions of the values required for the category fields such as 
management category, protein type and forage or concentrate. 
When the csv file is selected Rumen8 will attempt to import the feeds into the current library. A 
report will be displayed showing the number of feeds successfully imported and a list of any 
errors. These can include missing values, invalid values or insufficient data for each feed. 

COPY FEEDS BETWEEN LIBRARIES 
If you have multiple feed libraries you can quickly copy feeds between libraries on this tab. 
 
The feed copy tab allows you to easily move feeds between a source library (1) to a target library 
(2) using the move and copy buttons (3) or simply dragging and dropping feeds. 
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To copy a feed or feeds between libraries first select the source library in one of the drop down 
menus at the top of the window (1 or 2). In the other drop down menu select the target library. 
You should now see all the feeds for each library in the list below the library names. You can either 
move or copy feeds in either direction by using the buttons between the libraries (3). 
Multiple feeds can be moved at once by selecting them with the mouse with the Shift or Control 
keys on the keyboard held down. You may also just drag and drop feeds between the libraries. 
  

USING THIRD PARTY FEED LIBRARIES 
Organisations can build customised feed libraries for their staff, or in the case of industry 
development agencies, for general industry use. An example is a SNV Kenya project which put 
together a feed library for East African users of Rumen8 that is useful in many other regions 
(https://cowsoko.com/rumen8). Third party feed libraries can be used in two different ways. 

Imported as an additional feed library 

After downloading the feed library file to your Downloads folder, start Rumen8 and open the Feed 
Editor from the Edit menu. Click on the 'Manage libraries and Ingredient visibility' tab and then 
click on the 'Import' button within the library group. In the window that opens navigate to the 
Downloads folder and select the feed library file you previously downloaded. If the creator of the 
library has allowed importing the library it will be added to your list of libraries in the 'Feed library 
in use' drop down list. If the library was created in an older version of Rumen8 it will prompt you 
to give it a name before importing. If the creator does not allow importing you will get a message 
telling you this, so it can only be opened as a read-only shared feed library (see below). 

Import selected feeds into the current library 

If you only wish to import selected feeds and mixes from the downloaded library, click on the 

https://cowsoko.com/programs/kmdp
https://cowsoko.com/rumen8
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'Import' button in the Share group on the 'Manage libraries and Ingredient visibility' tab within the 
Feed Editor. This will open a file selection window where you can navigate to the Downloads 
folder and select the feed library you just downloaded. If the creator of the library has allowed 
importing feeds and mixes from the library, you will be presented with a list of all the feeds and 
mixes in the library and you can select the ones you wish to copy into your current library. See the 
'Importing feeds and mixes' section in the previous topic for more details. If the creator does not 
allow importing from the library you will get a message telling you this, so it can only be opened as 
a read-only shared feed library (see below). 

Opened as a shared feed library 

If the library is a shared feed library, it cannot be edited and is usually distributed via a cloud-
based drive service such as OneDrive or Dropbox for a business team. To use and manage a shared 
feed library see the 'Shared feed libraries' section in the previous topic. 
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KEEPING RUMEN8 UPDATED 
Rumen8 can check for updates if your computer is connected to the Internet. Select ‘Check for 
updates’ under the Help menu and if an update is available a small blue information icon will 
appear above the Margin section of the main window. 
 

The information icon that means an update is available (1). 

 
 

Clicking on the blue information icon will roll out a menu telling you the update will be installed 
the next time Rumen8 starts. If you click on this text a drop-down menu gives you the choice to 
install the update now or view the changes in the new version. 
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Installing an update or viewing changes. 

 
 

When Rumen8 is restarted, it will download the files required, update your installation of Rumen8 
and then start the new version. The blue information icon will be replaced by a green tick which 
when clicked will confirm you have updated to the latest version. 
If you check for updates and there is not one available a green tick will appear above the Margin 
section of the main window and if you click on it, it will confirm you already have the latest version 
of Rumen8. 
 
You have the latest version of Rumen8 is shown with the green tick (1). 
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Rumen8 will check for updates once a day automatically if your computer has a connection to the 
Internet. The update system has been optimised for slow connections so it only downloads the file 
changes that are necessary, not the entire Rumen8 installation each time. 
If your computer is offline, you can download the latest version of Rumen8 from the website and 
then install the new version manually. Your library and diet files will not be changed when you do 
this. 
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UNINSTALLING RUMEN8 
Completely removing Rumen8 from your computer will take three steps. 
1. Remove your registration information from the computer. 

Go to the Registration option under the Help menu and click the ‘Deregister’ button. Your 
details will be removed from the computer and Rumen8 will revert to trial mode. 
 

Remove the registration information from Rumen8 by clicking the Deregister button (1). 

 
 

2. Uninstall the Rumen8 software. 
In Windows 10 go to the Windows Setup by clicking on the Start button in the bottom left of 
the Desktop and then click on the cog icon above it. In the ‘Windows Settings’ window that 
appears click on 'Apps'. Scroll down the list of apps installed on the computer until you find 
Rumen8 or type 'Rumen8 4' in the Search box as shown in the figure below. Select the 
Rumen8 4 app found and click the ‘Uninstall’ button below it. Follow the prompts and Rumen8 
will be removed from your computer. 
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Uninstalling Rumen8 from within the Windows 10 Apps Settings. 

 
 
 

To uninstall Rumen8 from a Windows 11 computer go to the Setttings, Apps (1), Apps & 
features (2) and entering 'Rumen8 4' in the App list box (3). To remove Rumen8 click on the 3 
vertical dots to the right and select Uninstall from the menu that drops down (4). 

 
Uninstalling Rumen8 from a Windows 11 computer. 
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3. Delete the Rumen8 folder from your Documents folder. 

If you do this you will lose your feed library, preference settings, prices and any saved diet 
files. 

 

4. (Optional) Delete the ‘Rumen8_Nutrition_Pty_Ltd’ folder containing the settings files from the 
AppData\Local folder from within your user folder. This folder is normally hidden so this step is 
for advanced users only. These files only take up a tiny amount of disk space so this isn’t 
important. 
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OPTIMISER INSTALLATION (ADVANCED) 
The Optimiser function in Rumen8 requires using advanced features of Microsoft Excel. 
Specifically, the Optimiser requires communication with specific versions of Excel and 
configuration can be cumbersome. However, if you have a good knowledge of Excel and Windows 
and would like to try, the steps for Excel 2016 are listed below. The process is very similar for Excel 
2010, 2013, 2016 and 2019. 

Rumen8 only supports Microsoft Excel 2010, (version 14), 2013 (version 15), 2016/2019 (version 
16) and Office365 and it needs the free and included Solver add-in to be installed. At the time of 
writing this guide, Excel version 16 was part of the Office365 subscription from Microsoft. The 
animal model used by Rumen8 requires non-linear optimisation to estimate the lowest cost diet 
from the chosen ingredients and Solver provides this for no additional cost if you already own 
Excel. 

Rumen8 copies the current diet into the industry specific Optimiser4.xlsm spreadsheet, configures 
Solver with the required constraints, runs it and then copies the results back into Rumen8. To 
allow this you must make three setting changes in Excel and one in the Optimiser4Dairy.xlsm and 
Optimser4Beef spreadsheets located in the Rumen8 libraries folder. The steps below show you 
how to do each of these. 

1. Change the Excel security settings allowing Rumen8 to run the macros in the 
spreadsheet. 
Once this setting is changed the Optimiser spreadsheets should be able to complete 
steps 2 and 3 automatically. 
 
Note, this setting allows programmatic access to Visual Basic for Applications from a 
macro script. Rumen8 uses this to install the Solver add-on and make changes to allow 
Rumen8 to optimise diets. However, this may also allow malicious code to run on your 
computer from other spreadsheets. If you prefer to leave this setting on to maintain 
the security level, you will have to manually complete the optimiser set up process as 
described in steps 2 and 3 below. 
 
If the optimiser spreadsheet is unable to automatically finish the set up process, you will 
need to complete steps 2 and 3 below manually for each of the two optimiser 
spreadsheets. 

2. Install the Solver add-in in Excel. This is the optimiser used by Rumen8 and it is run by a 
macro in the Optimiser4Dairy and Optimiser4Beef.xlsm spreadsheets. 

3. In the Visual Basic for Applications (VBA) editor allow the macro access to the Solver 
add-in. 
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INSTALLATION INSTRUCTIONS FOR EXCEL 2016 
1. Open either the Optimise4Dairy.xlsm or Optimiser4Beef.xlsm spreadsheet in the 

~\Documents\Rumen8\libraries folder in Excel. If you have installed Rumen8 to the default 
location the Rumen8 folder will be in your Windows Documents folder and the complete path 
for the spreadsheet will be 

2. C:\Users\<logon name>\Documents\Rumen8\Libraries\Optimise4Dairy.xlsm for example. 
After completing the setup for the Optimise4Dairy.xlsm spreadsheet you then must repeat the 
process for the Optimise4Beef.xlsm spreadsheet. 

Open the Optimise.xlsm spreadsheet. 

 
 

3. If the security level is still set to the default you will be prompted under the ribbon menu with 
a Security warning that macros have been disabled. Click on ‘Enable content’ in the message 
that appears. If the security level is set too high, it will automatically and silently disable 
macros which will prevent Rumen8 from optimising diets.  
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Enable macros in the optimiser spread sheet. 

 
 

Set Excel security levels 

4. To ensure the macros settings are correct we must go into the File menu. It is the left most 
menu on the ribbon (1).  
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Click on the File ribbon menu to access Excel options. 

 
 

5. Click on the ‘Options’ button at the bottom of the menu.  
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Accessing Excel Options from the menu. 

 
 
6. On the left side of the window click on the ‘Trust Center’ and then the ‘Trust Center Settings’ 

button to enter the Trust Center. 
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Enter the Trust Centre in Excel. 

 
 

7. Select ‘Macro Settings’ on the left side of the window and then check that Macro Settings are 
set to ‘Disable all macros with notification’. If the macro security level is set higher than this 
Rumen8 will not be able to run the Optimiser. 
Also ensure there is a tick in the box alongside the setting ‘Trust access to the VBA project 
model’. 
Click on ‘Okay’ to exit the Trust Centre once you have finished. 
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Set the macro security settings in Excel. 

 
 

If the previous setting was ‘Disable all macros without notification’, changing it will result in Excel 
prompting you when it opens any spreadsheet containing macros instead of simply blocking them 
silently in the background. Macros can be used load malware under some circumstances so only 
allow spreadsheets access to them when you are sure they are from a reputable source. 
In this case, the Rumen8 application copies the cow and diet information into the Optimiser 
spreadsheet and then uses a macro to run Solver to calculate the lowest cost diet. If access to 
macros is blocked the optimiser function of Rumen8 cannot be used. 
 
Excel setup for use with Rumen8 optimisation is now complete so exit from Excel saving changes if 
you are prompted to do so. 
 
Rumen8 defaults to not allow access to the optimiser so the final step is to tell it you have 
configured Excel correctly. In the Rumen8 Preferences General tab enable the Optimiser tab by 
clicking on the down arrow to the left of ‘Optimiser disabled’ at the bottom of the window. The 
Optimiser settings box will open and the title will change to ‘Optimiser enabled’. Both settings in 
the box should be left off for normal use.  
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Setup the Rumen8 preferences to use the optimiser. 

 
 

Now when you return to the main Rumen8 window a new tab called ‘Optimiser’ will be available. 
 
There are two additional Excel setting changes needed to set up the optimiser, but Rumen8 
should be able to do them automatically when the optimiser is run for the first time. If you get an 
error this means it was unable to complete the setup itself and you will have to do it manually. 
Instructions to do so are below. 
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MANUAL INSTALLATION INSTRUCTIONS FOR EXCEL 2016  
If the automatic optimiser setup has failed, you must complete the last two steps yourself. These 
are 
 

1. Install the Solver add-in in Excel. This is the optimiser used by Rumen8 and it is run by a 
macro in the Optimiser4.xlsm spreadsheet. 

2. In the Visual Basic for Applications (VBA) editor allow the macro access to the Solver 
add-in. 

 

Install the Solver add-in 

8. While remaining in the Trust Centre, click on the ‘Add-Ins’ option on the left of the window 
and then set the Manage drop-down list at the bottom of the window to ‘Excel Add-Ins’ and 
click the ‘Go’ button. 
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Enter the Add-ins manager. 

 
 
9. A list of possible Add-Ins appears in the new window. Click on the checkbox alongside ‘Solver 

Add-In’ to install it if it is not already selected. Click ‘Okay’ to install Solver and exit Options 
back to the spreadsheet. 
If it is not available or doesn’t install correctly you may need to uninstall and re-install your 
copy of Excel or Office to remedy this. 
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Install the Solver Add-In. 

 
 

10. Confirm Solver is correctly installed by ensuring ‘Solver’ is visible at the end of the ‘Data’ 
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ribbon. 
 

Solver is visible at the end of the Data menu in the Ribbon. 

 
 

Add the reference to Solver in the Visual Basic for Applications editor 

The macros included in the Optimiser spreadsheet also must also be able to access the Solver add-
in. To enable this you must go into the macro editor and then tell it where the solver file is 
located. 
 

11. Click on the ‘View’ menu of the ribbon. The last option is called ‘Macro’, click on the drop-
down menu and select ‘View macros’ from it. 



Rumen8 User Guide 

224 / 247 

 
The Macro menu in the View ribbon. 

 
 

12. In the Macro window that opens select the macro ‘Sheet1.Solve’ and then click the ‘Edit’ 
button. 

 
Start the Visual Basic for Applications editor. 
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A new window will open. This is the Visual Basic for Applications editor which lets you create 
macros that can be executed as part of a spreadsheet. Rumen8 calls the Solve macro to optimise 
the diet previously copied into the spreadsheet. 
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13. In the Visual Basic Editor select ‘References’ from the ‘Tools’ menu. 
 
Open the Visual Basic for Applications References editor. 

 
 

14. Visual Basic for Applications needs to know where to find the Solver add-in. You may need to 
search down the list to find the Solver entry. When you first open the editor, it may be listed 
as missing. Even if it does not say MISSING continue with the steps below. 
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The Solver reference is missing in the Visual Basic for Applications References editor. 

 
 
15. Click on the ‘MISSING: SOLVER.XLAM’ line and then the Browse button. At the bottom of the 

dialog box change the “Files of type” drop-down to show all files. 
Now navigate to the directory in which Microsoft Office has installed the solver files.  
 
For the 64-bit version of Office365 Excel 2016 this is usually the folder  
“C:\Program Files\Microsoft Office\Root\Office 16\Library\SOLVER\”. 
 
For the 32-bit version of Office365 Excel 2016 this is usually the folder  
“C:\Program Files (x86)\Microsoft Office\Root\Office 16\Library\SOLVER\”.  
 
If you are using an earlier version of Office the number 16 in the path will be lower, 15 for 
Office 2013 for example. Standalone installations may not include the ‘Root’ folder part of the 
path. It is important to find the SOLVER.XLAM file used by the default version of Excel on your 
computer. 
 
If you cannot find the SOLVER.XLAM file manually an alternative is searching for it using the 
Windows File Explorer. 
Go back to the Windows Desktop and open the File Explorer and select ‘Local Disk (C:)’ in the 
folder view on the left (1). In the search box in the top right type in ‘solver.xlam’ and hit the 
Enter key (2). The search may take some time, but it will list all files on your C drive called 
Solver.xlam. When the search has finished, the entry you are looking for has ‘Type: Microsoft 
Excel Application’ alongside it. Note down the full location (path) of the file and then return to 
the VBA References file browser and go to that location. 
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Using the Windows File Explorer to find the Solver.xlam file. 

 
 
 
The SOLVER folder for Office 365 Excel 2016. 

 
 

16. With ‘All Files’ selected SOLVER.XLAM should now be visible. Select it and click on “Open”. 
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The SOLVER folder for Office 365 Excel 2016. 
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17. The Solver reference should no longer be listed as missing. Ensure it has a tick against it and 
click the ‘Okay’ button to exit the window. 

 
Solver is installed correctly for Visual Basic for Applications. 

 
 

18. Save the Optimiser3.xlsm file buy selecting ‘Save Optimise3.xlsm’ from the File menu. 
 

Save the optimiser spreadsheet. 
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19. Exit back to the spreadsheet using the ‘File’ menu and the ‘Close and Return to Microsoft 
Excel’ option. 

20. Excel setup for use with Rumen8 optimisation is now complete so exit from Excel saving 
changes if you are prompted to do so. 

21. Rumen8 defaults to not allow access to the optimiser so the final step is to tell it you have 
configured Excel correctly. In the Rumen8 Preferences General tab enable the Optimiser tab 
by clicking on the down arrow to the left of ‘Optimiser disabled’ at the bottom of the window. 
The Optimiser settings box will open and the title will change to ‘Optimiser enabled’. Both 
settings in the box should be left off for normal use.  
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Setup the Rumen8 preferences to use the optimiser. 

 
 

Now when you return to the main Rumen8 window a new tab called ‘Optimiser’ will be available. 
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AFTER AN OPTIMISER UPDATE 
Occasionally updates to Rumen8 require changes to the Optimise4Beef.xlsm and 
Optimise4Dairy.xlsm spreadsheets in the ~\Documents\Libraries folder. If this occurs and you have 
the Optimiser turned on in the Preferences, you will be warned when starting the new version of 
Rumen8 that the Optimiser has also been updated and you may need to repeat part of the 
Optimiser setup. 

Firstly, attempt to optimise a diet and if everything goes well you do not need to do anything. If 
you get an error message or Excel appears showing the VBA window like the figure in the 
Optimiser troubleshooting section below you will need to tell Excel where the Solver.xlam file is 
again. 

The first two sections of the optimiser setup in the previous section will not need to be repeated 
as they are specific to your installation of Excel and have not been changed. These are  

• Set Excel security levels, 

• Install the Solver add-in. 

 

Unfortunately, the last part of the optimiser setup process where you add the reference to Solver 
in the Visual Basic for Applications editor may need to be repeated. This is because the new 
Optimiser spreadsheets provided in the update are set up for the most common Excel 
configuration, a 64bit Office365 subscription with the latest version of Excel. If the location of the 
Solver.xlam file is different on your computer due to being an earlier version of Excel or different 
installation process it will need to be located again. 

If you are already in the Visual Basic for Applications Editor when the error occurred, you can start 
at step 12 of the Optimiser setup instructions. 

If you got an error message in Rumen8 you will need to open the Optimise4Beef.xlsm or 
Optimise4Dairy.xlsm spreadsheet in the ~\Documents\Rumen8\libraries folder in Excel. If you 
have installed Rumen8 to the default location the Rumen8 folder will be in your Windows 
Documents folder and the complete path for the spreadsheet will be C:\Users\<logon 
name>\Documents\Rumen8\Libraries\Optimise4Beef.xlsm for example. This is the same as step 1 
and 2 of the Optimiser setup instructions. Once there you can skip forward to step 10 to set the 
location of the Solver.xlam file. 

Unfortunately, when setting up the Reference for the Solver.xlam file after an Optimiser update 
Excel may incorrectly think it knows where the add-in is located and even shows the correct path 
as shown in the figure below. 

The References window incorrectly shows the Solver is correctly setup after a Optimiser 
spreadsheet update (1). The path to the Solver.xlam file must be selected again using the Browse 
button on the right of the window. The location shown at 2 will still be the location of the 
Solver.xlam file. 
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Ignore this and as for the initial setup of the Solver, use the Browse button to specify the location 
of the Solver.xlam file. It will probably be found at the location at the bottom of the References 
window - Shown with the number 2 in the figure above. 
Once the Reference has been updated you can click the ‘Okay’ button and then ‘Close and Return 
to Microsoft Excel’ via the File menu to get out of the VBA editor window. Then exit Excel saving 
the Optimiser spreadsheet as you go. The updated Optimiser spreadsheet should now make the 
Solver available to Rumen8 for optimising. 
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OPTIMISER TROUBLESHOOTING  
If you have followed the setup instructions for the Optimiser and it fails when you try to optimise, 
the most likely problem is the Visual Basic for Applications (VBA) reference to the SOLVER.XLAM 
file. If this happens you will see the VBA editor appear with an error message telling you it cannot 
compile because it cannot find a project or library (the SOLVER.XLAM file). 
 
Trying to optimise causes the VBA editor to appear with a compile error message. 

 
 

Close the error message by clicking on the ‘Okay’ button and then reset the macro by clicking on 
the Reset button in the toolbar. It is a square stop button in the style of VCR play, pause and stop 
buttons as shown in the figure below. 
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Figure 11.22. Reset the macro execution with the stop button in the toolbar. 

  
 
Now you can update the reference to the SOLVER.XLAM file as you did in the third part of the 
optimiser setup instructions starting with the References editor in the ‘Tools’ menu. 
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Accessing the References editor in the VBA editor. 

 
 

From this point follow the instructions as you did when you originally set up the optimiser from 
step 12. The only difference is when you return to Rumen8 after saving your changes it will have 
an error message telling you it couldn’t start the Solver. Click ‘Okay’ and then try optimising again. 
 
The Rumen8 error message saying it could not start the Solver in Excel. 
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ABBREVIATIONS 
 
Abbreviation Units Description 
A MJ/d activity allowance 
Abs  Absorption 
ADIN g/kg DM acid detergent insoluble nitrogen 
aN  proportion of water-soluble N in the total N of the feed 
Ash g/kg DM ash content of feed (after heating to 600 C for 10 hours) 
Balance (MJ) MJ the difference between metabolisable energy requirements and 

supply 
BCS  Body condition score. 
bN  proportion of degradable N, other than water soluble N, in the feed 
Ca  Calcium 
Calcium g/kg or g/kg DM concentration of calcium in the diet  
Cl MJ/d plane of nutrition correction factor in calculating ME requirements 
cN  fractional rumen degradation rate per hour of the b fraction of the 

feed N with time 
Comp. 1 kg the amount of component 1 must fall within specified minimum and 

maximum values 
Comp. 2 kg the amount of component 2 must fall within specified minimum and 

maximum values 
Comp. 3 kg the amount of component 3 must fall within specified minimum and 

maximum values 
Con+By (kg) kg amount of concentrate and by-product in the diet 
Conc. + ByPr. g the total amount of concentrate + by-product in the diet must fall 

within specified minimum and maximum values 
Conc. + ByPr. g/kg the concentration of concentrate + by-product in the diet must fall 

within specified minimum and maximum values 
Cost $/cow and c/MJ diet cost ($/cow and c/MJ) and margin ($/cow) 
Cost $/tonne cost to produce or buy 1 tonne of feed (nominate if wet or dry) 
Cost ($/t) $/tonne diet cost per tonne 
Cost (c/MJ) c/MJ diet cost on a metabolisable energy basis 
Cost A.L. DM $/tonne DM cost after losses on a dry matter basis 
Cost A.L. wet $/tonne wet cost after losses on a wet or fresh basis 
CP g/kg the concentration of CP in the diet must fall within specified minimum 

and maximum values 
CP g/kg DM crude protein (N * 6.25) 
Days in milk d number of days the cow has been lactating 
Days pregnant d number of days the cow has been pregnant 
DCAD  Dairy cation anion exchange 
DIM  Days in milk 
Distance 
walked 

m/d distance walked each day by the cow 

DM g/kg dry matter 
DMI kg and % dry matter intake (kg) and % of maximum intake (NDF/NRC methods) 
DMTP g digestible microbial true protein 
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Abbreviation Units Description 
DUP g digestible undegraded protein 
Ec MJ/d net energy retained in concept (foetus and placenta etc.) 
El MJ/d net energy secreted as milk 
Em MJ/d net energy for maintenance 
peNDF g/kg or % the proportion of NDF that is deemed ‘physically effective’ i.e., that 

leads to rumination 
ERDP  g effective rumen degradable dietary protein 
ERDP CP % percentage of the CP that is effective rumen degradable dietary 

protein 
   

Excess MP g MP in excess of requirements which will take ME to remove from the 
body  

Excess MP cost $?? the metabolic cost to remove excess metabolisable protein expressed 
as forgone weight change or milk production 

F MJ/d fasting metabolism 
fat g/kg the concentration of fat in the diet must fall within specified minimum 

and maximum values 
Fat g/kg DM Fat 
Feed ($/cow) $/cow/day feed cost 
FME MJ fermentable ME of the diet 
Height walked m/d height change whilst walking each day 
Intake (kg) kg the maximum DMI cannot exceed 100% as determined by live weight, 

milk yield and week of lactation 
Intake (max. 
NDF) 

g the maximum DMI cannot exceed 100% as determined by NDF intake 
and live weight 

Kc  efficiency of utilisation of ME for growth of the concepta 
Kg  efficiency of utilisation of ME for weight change when lactating 
Kl  efficiency of utilisation of ME for lactation 
Km  efficiency of utilisation of ME for maintenance 
Kt  efficiency of utilisation of mobilised tissue for lactation 
L MJ/d level of feeding as a multiple of MJ of ME for maintenance 
Limited by  factor limiting MP supply 
Live weight kg the cow’s live weight 
Live weight 
change 

kg/d cow’s daily live weight change 

Losses % dry matter loss from feed after costing 
Magnesium g/kg or g/kg DM concentration of magnesium in the diet 
Mg  Magnesium 
Margin ($/cow) $/cow/day margin (milk income - feed costs) 
Max DM Intake 
% 

% percentage of predicted maximum intake currently provided by the 
diet based on live weight, milk yield and stage of lactation 

Max MP cost MJ Maximum ME cost to remove excess MP 
Max NDF DMI 
% 

% percentage of predicted maximum intake currently provided by the 
diet based on NDF intake and live weight 

Mc  MJ/d ME requirement for growth of concepta 
MCP G microbial crude protein 
ME MJ metabolisable energy supplied and required 
ME MJ/kg DM metabolisable energy 
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Abbreviation Units Description 
ME 
requirement 

MJ the diet must provide the ME required for maintenance and 
production 

Mg MJ/d ME requirement for live weight change when lactating 
Milk ($/cow) $/cow/day milk income 
Milk fat % m/v percentage of milk that is fat 
Milk lactose % m/v percentage of milk that is lactose 
Milk protein % m/v percentage of milk that is true protein 
Milk yield L daily milk production 
Min MP cost MJ Minimum ME cost to remove excess MP 
Ml MJ/d ME requirement for milk production 
Mm MJ/d ME requirement for maintenance 
Mmp MJ/d ME requirement for maintenance and production 
MP g metabolisable protein 
MP balance g metabolisable protein balance 
MP min. 
requirement 

g the diet must provide an MP supply at least that required for 
maintenance and production 

MP required g the amount of metabolisable protein required for the production level 
MPb g/d basal endogenous nitrogen requirement 
MPc g/d MP requirement for the growth of the concepta 
MPd g/d dermal loss as scurf and hair 
MPg g/d MP requirement for live weight gain when lactating 
MPI g/d MP requirement for milk production 
MPm g/d MP requirement for maintenance 
MPmp g/d MP requirement for maintenance and production 
MTP g microbial true protein 
NDF g/kg the concentration of NDF in the diet must fall within specified 

minimum and maximum values 
NDF g/kg DM neutral detergent fibre 
NDF (%) %DMI neutral detergent fibre in the diet 
NDF (kg) kg total NDF in the diet 
NDF forage g/kg the concentration of NDF from forage in the diet must fall within 

specified minimum and maximum values 
NDF frg (%) %DMI NDF in the diet supplied from forages  
NFC (%) %DMI non fibrous carbohydrate in the diet 
Phosphorus g/kg or g/kg DM concentration of phosphorus in the diet 
P  Phosphorus 
Position 
changes 

no./d number of body position changes per day (lying down / standing up) 

Protein g and % metabolisable protein supplied and required and crude protein % 
QDP g quickly degradable protein 
Qm  metabolisability of GE at maintenance 
r(fraction/hr)  rumen digesta fractional outflow rate per hour 
RDP g rumen degradable protein 
Required (MJ) MJ metabolisable energy supply required from the diet for specified 

production 
SDP g slowly degradable protein 
Source source of 

information 
FIM (feed information manual) / TFD (top fodder data) / VMF (Vasse 
Milk Farmlets) / MvHS (M Staines data) / Protein Plus project etc. 
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Abbreviation Units Description 
starch g/kg or g/kg DM the concentration of starch in the diet must fall within specified 

minimum and maximum values 
   

Starch (%) %DMI starch in the diet 
sugar g/kg or g/kg DM the concentration of sugar in the diet must fall within specified 

minimum and maximum values 
   

Sugar (%) %DMI sugar in the diet 
Time standing hr/d time cow spends standing each day 
Total (kg) kg total dry matter in the diet 
Total (MJ) MJ  total metabolisable energy supplied from the diet 
Total MP (g) g total metabolisable protein in the diet 
Type name other forage / grass silage / other silage / distillery product / other 

non-forage 
UDP g undegradable dietary protein 
y g potential microbial protein yield in the rumen from FME 
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FEED IMPORT FORMAT 
Feeds can be imported from a text file of comma separated values (csv). These can be exported 
from a Microsoft Excel spreadsheet, so it is straightforward to change the order and format of 
feed data from a laboratory analysis. 
The first line can be a comment as it will be ignored. 
The data lines must have 42 values separated by commas and contain a single feed definition. Text 
fields do not require quotes and cannot contain a comma. 
 
Field order and format use to import feeds from a csv file into the feed library. 

Field Name Units Type Additional Information 

Feed name  Text Must be unique across existing feed and mix names 

Category  Integer 0=not used, 1=grazed pasture, 2=grazed forage, 
3=conserved as hay, 4=conserved as silage, 
5=concentrate/grain, 6=by-product, 7=minerals 

Protein type  Integer 0=other forage, 1=grass silage, 2=other silage, 3=distillery 
by-product, 4=other non-forage 

Forage or 
concentrate 

 Integer 0=forage, 1=concentrate 

Cost Dollars Decimal  

Cost DM or as 
fed 

 Integer 0=cost entered on DM basis, 1=cost entered on as fed 
basis 

Max feeding rate g/kg DM Decimal  

Wet density kg/tonne Decimal  

Losses % Decimal  

Dry matter g/kg Decimal  

Metabolisable 
energy 

MJ/kg DM Decimal  

Crude protein g/kg DM Decimal  

Neutral 
detergent fibre 

g/kg DM Decimal  

Physically 
effective neutral 
detergent fibre 

g/kg DM Decimal  

Starch g/kg DM Decimal  

Sugar g/kg DM Decimal  

Fat g/kg DM Decimal  

Ash g/kg DM Decimal  

aN  Decimal 0.00 to 1.00 

bN  Decimal 0.00 to 1.00 

cN  Decimal 0.00 to 1.00 

ADIN g/kg DM Decimal  

Lysine g/kg DM Decimal Not used so can be left empty 

Threonine g/kg DM Decimal Not used so can be left empty 

Methionine g/kg DM Decimal Not used so can be left empty 
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Cysteine g/kg DM Decimal Not used so can be left empty 

Histidine g/kg DM Decimal Not used so can be left empty 

Calcium g/kg DM Decimal  

Calcium 
absorption 

 Decimal 0.0 to 1.0 

Phosphorus g/kg DM Decimal  

Phosphorus 
absorption 

 Decimal 0.0 to 1.0 

Magnesium g/kg DM Decimal  

Magnesium 
absorption 

 Decimal 0.0 to 1.0 

Sodium g/kg DM Decimal  

Potassium g/kg DM Decimal  

Chloride g/kg DM Decimal  

Sulphur g/kg DM Decimal  

DCAD  Decimal  

DCAD calculated  Integer  

Source  Text  

Comment  Text  

Selected  Integer 0=not visible in ingredient lists, 1=visible in ingredient lists 

 

File example 
#Name, Category, Type, ForageConcentrate, Cost, CostWet, MaxFeedingRate, WetDensity, 

Losses, DM, ME, CP, NDF, peNDF, Starch, Sugar, Fat, Ash, aN, bN, cN, ADIN, LYS, THR, 

MET, CYS, HIS, Calcium, CalciumAbsorption, Phosphorus, PhosphorusAbsorption, Magnesium, 

MagnesiumAbsorption, Sodium, Potassium, Chloride, Sulphur, DCAD, DCADCalculated, 

Source, Comment, Visible 
Barley 

Grain,5,4,1,185,0,500,100,2,911,12.5,110,166,77,567,35,28,29,0.24,0.71,0.35,0.4,4.02,3.

64,1.8,2.28,2.46,1,0.3,4,0.4,2,0.5,0.5,1.5,2.5,3.5,100,0,Prot+ FIM,,1 
Barley Hay - 

DemoDairy,5,0,0,150,1,500,200,12,850,9.5,90,600,550,80,150,16,82,0.22,0.6,0.08,1.2,5.5,

5.22,1.52,1.13,2.12,3,0.3,2,0.4,2,0.5,0.5,1.5,2.5,3.5,100,0,FIM  VMF,,1 
Brewers Grain 

(Wet),6,3,1,1450,0,500,300,10,230,11,227,500,250,72,0,70,39,0.32,0.62,0.03,1,3.85,3.8,1

.95,2.05,2.05,2,0.3,6,0.4,2,0.5,0.5,1.5,2.5,3.5,100,0,Prot+ FIM,,1 
Broll,5,4,1,180,1,500,400,5,900,11,160,250,75,670,27,19,21,0.35,0.6,0.2,0.5,3.04,3.06,1

.7,2.22,2.52,1,0.3,4,0.4,2,0.5,0.5,1.5,2.5,3.5,100,0,Prot+ FIM,,1 
Minerals,7,4,2,7000,1,500,500,2,1000,8,0,0,0,0,0,0,995,0.24,0,0.9,0,0,0,0,0,0,46,0.3,0,

0.4,5,0.5,0.5,1.5,2.5,3.5,100,0,FIM,,1 
Calf Meal 

18%,5,0,1,270,1,500,600,2,881,12.5,203,236,,311,83,68,53,0.19,0.64,0.05,1,,,,,,16,0.3,8

,0.4,3,0.5,0.5,1.5,2.5,3.5,100,0,,Based on Meadow 18% Calf Pellets,1 
Canola Hay - 

DemoDairy,3,0,0,270,1,500,800,10,850,9.5,165,330,300,0,150,16,82,0.22,0.6,0.08,1.2,5.5,

5.22,1.52,1.13,2.12,9,0.3,3,0.4,2,0.5,0.5,1.5,2.5,3.5,100,0,FIM  VMF,,1 
Canola 

Meal,5,4,1,430,0,500,700,2,973,12.1,375,280,125,40,105,130,57,0.22,0.7,0.16,3.6,5.77,4.

8,2.33,2.71,2.86,6,0.3,10,0.4,5,0.5,0.5,1.5,2.5,3.5,100,0,Prot+ FIM,,1 
Canola Whole Seed 

Crushed,5,4,1,350,0,500,600,2,900,23.1,215,396,198,4,35,485,50,0.25,0.7,0.06,1.5,6.47,4

.63,2.31,2.44,3.07,4,0.3,8,0.4,3,0.5,0.5,1.5,2.5,3.5,100,0,FIM TFD,,1 


